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I remember when I was studying for my Mathematics A Levels. It was unusual 
enough for boards to be white, let alone interactive. Cutting edge technology 
was a watch with an inbuilt calculator, and a dynamic geometry lesson would 
be one in which the teacher suddenly switched from white chalk to red in the 
process of drawing a wonky circle. The late 1990s were a dark time indeed.

However, the technological revolution that has swept the world over the course 
of the last few decades has also landed in our classrooms. Overhead projectors 
have gone digital, scientific calculators are now graphical, static whiteboards 
have given way to their interactive cousins, computers are faster, mountains 
of dedicated mathematical software are widely available, and the internet has 
opened up possibilities far beyond what Pythagorus, Euler and the greatest 
minds in the history of the world could ever have imagined.

Alas, in many instances, this technology is not being used to its full potential. 
It either sits rotting away in storeroom cupboards or on the digital dumping 
ground of a computer’s desktop screen, or it is used in an extremely limited 
and ineffective way, which can often cause frustration on the part of both the 
teacher and the students, thus causing more harm than good.

This sorry state of affairs could be, as many have argued, because a large pro-
portion of teachers are reluctant to change; unwilling to try new things and 
break the habits and traditions that have served them perfectly well over the 
course of their long and distinguished careers. But I disagree. The teachers that 
I have talked to are ready to embrace this influx of technology, they are ready 
to welcome it with open arms into their classrooms, but they are just a little 
scared to do so. 

Now, this fear stems from many different sources, and much of it is well 
founded. It may be fear that their pupils will know far more about each piece of 
technology than they ever will, thus making the teacher feel vulnerable, ex-
posed and uncomfortable, no longer the all-knowing figure of confidence and 
authority that they feel they should be. Or it could be because teachers fear that 
by the time they have got to grips with a certain piece of technology, the world 
will have once more moved on, making their newly discovered knowledge both 
redundant and useless. 

Or – and this I feel is the most prevalent reason – it is because teachers fear 
that they simply do not have enough time. With curriculums changing every 
couple of years, new strategies and initiatives bounding in from every direc-
tion, lessons to plan, books to mark, students to teach, and (in the precious few 
seconds of each day that remain) lives to be led, where is the time to sign up to 
a course, or read a book, or sit at a computer hoping the ability to use whatever 
technology it may be might just seep through the pixels on the screen to the 
pores on the skin?

And so what often happens is this: through no fault of their own, eager teach-
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ers try the new technology without having adequately planned for its use, and 
disaster inevitably follows. During computer-based lessons, students sneak 
onto other internet sites, to play games, check email, or poke friends. Whilst 
the teacher is happily clicking through their immensely detailed, perfectly 
animated PowerPoint presentation, students appear bored, lack focus and seem 
unmotivated. Using Autograph to draw the line y = 3x + 4 does not magically 
make the students understand straight line graphs any better than had the 
teacher simply drawn it by hand, and now the teacher cannot remember how to 
return to the interactive whiteboard’s inbuilt flip-chart. The Excel spreadsheet 
that worked like a dream at home is now threatening to blow up the school’s 
computer system because of the existence of a mysterious thing called a macro. 
The ideal lesson is suddenly scuppered by the fact that the school network is 
down, or YouTube videos are blocked, or some delightful little devil has sto-
len the batteries from the mouse. Having spent four times as long to plan than 
normal, the lesson is declared a failure by all, and the teacher vows to never use 
that stupid piece of technology again.

It’s a dark place where everyone has been one time or another, and where no-
one wants to return.

For a while now I have been a firm believer in what I like to call the effective use 
of technology. Simply turning on an interactive white board does not automati-
cally make the lesson interactive, neither does clicking through a PowerPoint 
presentation, nor simply using a software package such as Autograph to draw 
a series of straight lines. The technology should be the facilitator in the lesson, 
not the driving force. Effective use of technology is when that piece of technol-
ogy, whatever it may be, genuinely enhances the learning experience of the 
students and, just as importantly, improves the teacher’s experience and enjoy-
ment of the lesson.

What I hope to show both in this book, and in its sister publication Autograph 
Activities: Student Investigations, is how to use one such piece of technology, 
Autograph, effectively. In my experience Autograph is one of the most under-
used pieces of software in schools. Many have used Autograph to do things 
like draw lines, curves and circles, but few seem to have fully exploited its true 
potential, and that is a great pity.

Once more I feel the major reason behind this is the time factor. However, what 
I hope to show in this book is that Autograph is incredibly simple and logical to 
use. Once you have spent about one hour having a go at the included interac-
tive Autograph Tutorial, you will be in a position to take on any of the fifteen 
Teacher Demonstrations. Better still, it will not take long before you start using 
the software to develop your own activities based on your own ideas. Once 
again, technology is effective only when it is the facilitator of teaching and 
learning.

The Teacher Demonstrations will allow you to dynamically introduce, review, 
extend or illustrate important topics or concepts in ways not previously pos-
sible. They are intended for use on an Interactive Whiteboard or by means of a 
digital projector. There is countless opportunity for student interaction, ask-

ing and answering probing questions, testing hypotheses and predictions. The 
topics covered include: introducing the natural logarithm function; deriving 
trigonometric identities; understanding the binomial approximation; introduc-
ing the concept of differentiation; and using Autograph’s unique 3D interface to 
examine volumes of revolution.

What I hope this book will achieve is to offer ways of effectively using a fan-
tastic piece of software without you having to put in hours and hours of your 
precious time. I hope it will encourage both you and your students to use the 
software to plan activities and investigate concepts not covered in this book. I 
hope it will further strengthen your students’ enjoyment of learning mathemat-
ics, exciting them, enriching their learning experience, further opening their 
eyes to what a wonderful and fascinating subject mathematics is. Most impor-
tantly of all, I hope the book will further help you enjoy teaching mathematics, 
inspiring your students, embracing technology, and using it in the way it was 
intended – as a facilitator of excellent teaching and learning, and an incredibly 
effective one at that.

Also available in this series:

Autograph Activities: Student Investigations

The Student Investigations provide the perfect vehicle for independent, dy-
namic learning. Autograph is an excellent tool for investigation, and math-
ematics is at its strongest and most appealing when students can embark upon 
such journeys of self-discovery. Students use Autograph and the accompanying 
worksheet to discover and examine concepts that would not be viable in the 
normal classroom setting. They are encouraged to derive things for themselves, 
to predict, to observe, to trial out hypotheses to enrich their learning experience 
and deepen their levels of understanding. Topics covered include: examining the 
transformation of functions; understanding vectors in two and three dimen-
sions; and looking at numerical methods to solve equations.
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About the Teacher
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The aim of this book is to help fully utilise Autograph’s potential as a tool for 
interactive demonstration. Below are details about the Teacher Demonstrations 
contained in this book, including advice regarding timings, set-up and delivery.

Note: Before attempting the Teacher Demonstrations, it is strongly advised 
that teachers work through the Autograph Tutorials on page 12 of this text-
book. The first interactive tutorial should help familiarise the teacher with the 
controls of Autograph, which will help boost confidence and allow far greater 
progress throughout the demonstrations. The second tutorial has been specifi-
cally designed for unlocking the full potential of Autograph on the interactive 
whiteboard, a graphics tablet or by means of a digital overhead projector.

T h e  T e a c h e r  D e m o n s t r at i o n s
These demonstrations are designed for use in the classroom, either to dynami-
cally introduce, review, extend or illustrate an important concept or topic. They 
are designed to be both interactive and engaging. Usually the demonstrations 
will last between five and twenty minutes, although you may be tempted to 
spend longer on them if they spark a lively discussion.

Each activity comprises of:

Teacher Notes – these contain: 

Learning Objectives •	

Required Prior Knowledge•	

Details of any Pre-Activity Set-Ups that must be carried out before the •	
lesson starts

Step-by-Step Instructions, together with suggested questions, ideal re-•	
sponses, and opportunities for class interaction.

Ideas for Further Work to build upon the knowledge gained during the •	
demonstration.

Viewing the Demonstrations	

Obviously it is crucial that all students can see the demonstration.  For that 
reason it is recommended that you use either an Interactive Whiteboard, or a 
digital projector hooked up to a computer which has the Autograph software 
installed upon it. All the activities have opportunities for class participation 
and interaction, and whilst an Interactive Whiteboard naturally lends itself bet-
ter to this (especially using Autograph’s impressive on-screen keyboard), work-
ing with a projector will also be fine. 

The Role of the Teacher	

The teacher is far more prominent and visible than in the Student Investiga-
tions. It is crucially important that they have tried the activities out themselves 
prior to the lesson.  Again, this will enable the teacher to feel more confident 
delivering the activity and enable them to decide how far into the activity to go 
depending on the needs and ability of the group.

Saving the Activities	

Again, whilst it is not strictly necessary to save the activities once the demon-
stration is over, it might be wise to do so. These activities can be quickly called 
upon to illustrate a specific concept, or to answer a previously unforeseen prob-
lem, and once again they would make excellent revision aids.

Whiteboard Mode	

All of the Teacher Demonstrations have been designed in Whiteboard Mode, 
whereas all the Student Investigations in the book Autograph Activities: Student 
Investigations take place in non-Whiteboard Mode. The major difference be-
tween the two is the way multiple objects are selected, with Whiteboard Mode 
being far more user-friendly in this regard when Autograph is used with an In-
teractive Whiteboard, a graphics tablet or a digital projector . You are encour-
aged to read the teacher notes accompanying the Autograph Tutorial, and then 
to have a go at the Autograph Additional Teacher Tutorial specifically designed 
to address this issue.

The On-Screen Keyboard	

Autograph has a handy in-built facility for displaying an on-screen keyboard, 
meaning that any text, equations, or use of the Shift and Ctrl buttons can be 
entered with the mouse/pen on the Interactive Whiteboard or graphics tablet. 
Details about making the most of this valuable tool can also be found in the 
Autograph Additional Teacher Tutorial. As some teachers still prefer to use the 
traditional keyboard in unison with their interactive whiteboard, no specific 
reference has been made to the on-screen keyboard during the set of Teacher 
Demonstrations. However, whenever there is mention of using the normal key-
board, just be aware that the on-screen keyboard can be used to the exact same 
effect.
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Overview	

The aim of this tutorial is to enable both teachers and students to become 
familiar with how Autograph works. The tutorial gives an overview of some of 
Autograph’s major 2D graphing features†. It is very much hands-on, challenging 
and interactive, allowing the user to really get to grips with how the software 
works and what it can do. This should increase the user’s confidence with the 
software, hopefully allowing teachers to come up with activities of their own, 
and students to use the software to aid them with their studies.

Please Note: A series of 10 interactive student investigations are available in 
the book Autograph Activities: Student Investigations.

Note: There is a separate Autograph Additional Teacher Tutorial,  specifi-
cally designed to help teachers make the most of Autograph on an Interactive 
Whiteboard or a Graphic’s Tablet. The tutorial should only take around ten 
minutes to complete, and it highlights the two of Autograph’s best features:

1.	 Whiteboard Mode 
All the Teacher Demonstrations in this book are written in Whiteboard 
Mode, whereas all of the Student Investigations, and this tutorial itself are 
written in non-Whiteboard Mode. There are a few subtle differences to 
make Autograph smoother and easier to operate with an interactive white-
board or a graphics tablet. Therefore, it might be a good idea to have a 
quick run through this additional tutorial before embarking upon any of the 
Teacher Demonstrations.

2.	 The On Screen Keyboard 
Autograph comes complete with its own onscreen keyboard, which means 
you don’t have to be tied to the keyboard attached to your classroom’s com-
puter. The onscreen keyboard makes Autograph fully functional using the 
pen of an interactive whiteboard, or frees you up to walk around the class-
room using a graphics tablet. The onscreen keyboard is even more useful 
as it can be used with any other application, not just Autograph, and the 
maths symbols in the Extra panel will also work in other applications.  Only 
a couple of characters are exclusive to Autograph font.

Timing	

The tutorial is designed to last between forty-five minutes to an hour, based on 
someone who has never used the software before. This will of course differ de-
pending on the user’s past experience and overall computer competency. Once 
again, the most important elements are covered earlier on in the tutorial, so if 
not all students reach the end, they will still be in a strong position to tackle the 

rest of the activities in the book.

Location	

For students, this tutorial should ideally take place in a computer suite with one 
student allocated to each workstation. Paired work is also acceptable, but it is 
important that each student has the same hands-on experience. If your school 
has access to Autograph at home, either because your school has an Extended 
Site Licence, or your students have individual Student Licences, then this tuto-
rial might make a nice homework assignment.

Required Pre Knowledge	

Whilst the tutorial touches on concepts such as differentiation, integration and 
radians, specific knowledge of these is not required. This tutorial is designed 
for a student about to embark upon a post-16 maths course, and hopefully the 
little taster they will get of these concepts will whet their appetite for what is to 
come later.

Pre-Activity Set-Up	

None required.

† As this textbook is aimed at Post-16 students, I have avoided including elements such as the 
transformations of shapes and basic data handling work to the tutorial. In addition, the 3D 
work is covered in the activities themselves, and hence is also omitted from the tutorial. If these 
are areas which you are interested in learning more about, or if you want to review any of the 
features covered in this tutorial, then I recommend accessing the Autograph Video Tutori-
als contained within the Help menu of Autograph, or visiting the Autograph Website (www.
autograph-math.com).

Tutorials

T e a c h e r  N o t e s
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Activity 1	

	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

Make sure you are not in Whiteboard Mode.

Enter the equation: y = x² + 4x – 3 
Note: To enter x², either use the little  button, press “alt 2” together, or type in 
“xx”.

What will this curve look like? Where will it cross the axes? Which direction 
will it slope?

Predict

Click OK.

As you will see, not all of the curve fits on the page, so we need to edit our axes. 
Edit the axes as follows:

x:	 Minimum:	 −6	 Maximum:	 4	 Numbers:	 1	 Pips:	 0.2
y:	 Minimum:	 −8	 Maximum:	 6	 Numbers:	 1	 Pips:	 0.5

Autograph Buttons covered:

	 Enter equations

	 Edit axes

 	 Zooming in and out

	 Dragging

	 Select Mode

	 Text boxes

	 Point Mode

	 Undo

Other Autograph Functions covered:

Solve f(x) = 0

Solve f’(x) = 0

Solve f(x) = g(x)

Change the line/curve appearance

Adjust the degree of accuracy

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

Note: Before you attempt to re-scale the axes yourself, often pressing the De-
fault Scales button will do a good job of sorting the scales out for you.

Now we have our curve on the page, let’s see what Autograph can help us find 
out about it.

1. Where does the curve cross the x-axis?

Use the Zoom In function to take a closer look at the first crossing point which 
is close to −5.

Notice how the scale automatically adjusts the closer in you get.

Use the Drag function to move across the screen to find the other point where 
the curve crosses the x-axis.

Zoom back out so we are looking at the original graph again.

Note: Pressing Undo several times is often a quicker way of getting back to 
your original view.

Now, there is a way to find where the curve crosses the x-axis much more ac-
curately:

Make sure you are in Select Mode. 
Left-click on the curve (it should turn black). 
Right-click to bring up a menu. 
Select Solve f(x) = 0. 

This will mark on the two points where the curve crosses the x axis, and give 
you their values to four significant figures in the Status Bar at the bottom of the 
page.

Left-click to select one of the crossing points (it should turn black).
Note: Because these two points are related, they will both be selected.

Click on Text Box.
In the text field, delete “Equation solver”, and instead write “x-axis crossing 
points”. 
Click OK. 
This displays the results in a moveable text box on the page.

Your page should look something like this:

Tutorials

S t u d e n t  W o r k s h e e t
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crossing points are marked, and the results are displayed in the status bar.

If you want to improve the accuracy of the calculations:
Go to Page > Edit Settings.
Adjust the level of accuracy to 8 significant figures.

Another quite nice way to achieve all this is to have a moveable co-ordinate on 
the curve.

Select Point Mode and place a point somewhere on the left-hand side of the 
curve.
Note: When the cursor hovers over a section of the curve, it should turn from a 
cross into a black arrow.

Click on Text Box.
In the text field, delete “Point”, and instead write “A”.
Click OK. 
This will keep a record of the current co-ordinates of point A.

Ensure you are in Select Mode and point A is selected (it should have a square 
around it).
Use the left and right arrow buttons on the keyboard to move the point along 
the curve.
Use the up and down arrow buttons on the keyboard to switch between the 
curve and the line.
Place the point somewhere on the curve.

Left-click twice on the point, and type in the x-value −5.

Your screen should look something like this:

2. Where does the curve cross another line?

Enter another equation: y = –x – 4
Still on the enter Equation screen, click on Draw Options:

Change the colour of the line to purple.•	
Choose a •	 dashed line style.
Set the line thickness to 3 pts•	 .

What will this line look like? Where will it cross the axes? Which direction 
will it slope?

Predict

Click OK twice.

You can see that it crosses our curve at two points. Again, we can zoom in to 
take a closer look at the points of intersection, but we can also use a similar 
technique to find out their co-ordinates more accurately: 

After zooming in, press Undo until you return to the original view of the graph.

Ensure you are in Select Mode.

Hold down the Shift button to select more than one object:

Left-click on both the curve and the straight line (they should both turn black).
Note: The use of the Shift button to select more than one object is very impor-
tant!

Right-click, select Solve f(x) = g(x), and once again the co-ordinates of the 
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Open up a New 2D Graph Page

Edit the axes as follows:
x:	 Minimum:	 −4	 Maximum:	 4	 Numbers:	 1	 Pips:	 0.5
y:	 Minimum:	 −10	 Maximum:	 15	 Numbers:	 2	 Pips:	 1

Remove all of the green ticks underneath Auto 

Click on Slow Plot

Enter the equation: y = x³ + 2x² − 5x − 3
Note: To enter x³, either use the little 3 button, press “alt 3” together, or type in 
“xxx”

What will this curve look like? Where will it cross the axes? Which direction 
will it slope?

Predict

Click OK.

Autograph will begin to plot the graph from left to right.

Pressing Pause Plotting at anytime stops and starts the plotting and enables 
you to focus on the key features of the graph.
Note: Pressing the spacebar on your keyboard does the same.

Pressing Fast-Forward Plotting immediately speeds to the end of the plotting.

When the curve has finished plotting, click on the Replot button.
You now have the option to adjust the plot settings, which means you can ad-
just both the x-step and the specific section of the graph you want to plot.

Left-click to select the curve (it should turn black).
Right-click and select Table of Values from the menu.
Change the x-step to 1 and leave the x-min and the x-max as they are.

This will now give you the corresponding y values for each integer x value on 
your graph in a Results Box at the side of the page.

Note:  To view the Results Box at any stage, just click Results Box.
The Results Box can also be copied and pasted into another application should 
you wish.

Your screen should look something like this:

With the point still selected, if you right-click you also have the following op-
tions:

Move to next f(x) = 0•	  which will move you to the next crossing of the x 
axis
Move to next f ’(x) = 0•	  which will move you to the next stationary point 
on the curve.

Activity 2	

ww
Autograph Buttons covered:

	 Slow Plot

  	Re-plot, Pause, Fast For-
warding

	 Animate Object

	 Gradient Function

	 Area Under a Curve

	 Enter Co-ordinates

Other Autograph Functions covered:

Table of Values

Results Box

Delete Objects

Move to Next Intersection
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Try these settings on Automatic - Repeat:
Animation speed as far to the left as it will go•	
Start: •	 −3        Finish: 2       Step: 0.05

Click the Play button.

Your screen should look something like this:

When you are ready:

Close the Adjust Position box by clicking the red cross in the corner.

Left-click to select the tangent (it should turn black).
Either right-click and select Delete Objects from the menu, or just press De-
lete on your keyboard.
Note: Don’t worry about the warning. This is just to remind you that the Text 
Box is linked to the tangent, and so will be deleted as well.

You should now be only left with the curve.

What would the Gradient Function of this curve look like?Predict

Make sure you are still in Slow Plot mode (there should be a small blue square 
around the button).

Left-click to select the curve (it should turn black).

Click on Gradient Function.
This will automatically calculate the gradient of the tangent along the curve, 

What would a tangent to this curve look like? What direction would it 
slope?

Predict

 Select Point Mode and place a point somewhere on the curve
Right-click and select Tangent from the menu.

Left-click to select the tangent (it should turn black).

Select Text Box and click OK.
The equation of the tangent should now be displayed.

Left-click to select the point on the curve (it should have a square around it). 
Use the left and right arrow keys on the keyboard to move the point along the 
curve. Notice how the equation of the tangent adjusts.

There is a better way of moving points along a curve then using the left and 
right buttons.

Make sure the point is selected.

Select the Animate Object button, which brings up the Adjust Position box.
You now have the option of selecting the exact starting location for the point, 
and the size of the step which it increases in.
Select a position of −2, and a step of 0.1.
Use the left-right buttons to move your point along the curve.

Still in the Adjust Position box, click on Animate.
Here you can set up Autograph to adjust the step automatically.
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Make sure Slow Plot is turned off.

Enter the equation: y = 5 − x²

What will this curve look like? Where will it cross the axes? Which direction 
will it slope?

Predict

Click OK.

Left-click on the curve (it should turn black).

Add a point on the curve with an x value of 0.

Add another point on the curve with an x value of 1.

Left-click on an unoccupied part of the graph area to de-select everything.

Hold down the Shift button to select more than one object: 
Left-click on both these points (they should both have a square around them).

Right-click and select Find Area from the menu.
Use the following settings:

Trapezium Rule•	
Divisions: •	 5

What will this look like?Predict

Click OK.

Left-click on the marked area under the curve.

Select Text Box from the menu and click OK.
This will display a numeric estimation for the area under the curve.

Left-click on one of the points.
Use the left and right arrow buttons on the keyboard to move the point along 
the curve and observe how the area changes.

What effect will increasing the number of divisions have on the estimate for 
area?

Predict

Left-click to select the area under the curve.

Click on Animate Object.
You can now adjust the number of divisions and observe the effect it has on the 
estimate for area. 

Your screen should look something like this:

and plot these values as it goes.

The gradient function is set-up to pause at important points, such as each 
maximum and minimum point, and each point of inflexion.

Press Pause Plotting (or the spacebar) to resume the plot.

What would the gradient function of the gradient function look like?Predict

Left-click to select this new curve – the gradient function (it should turn 
black).

Again, click on Gradient Function.
This will automatically plot the gradient function of the gradient function, oth-
erwise known as the second gradient function of the original graph.

Note: These lines and curves can then be analysed like any other, whether it be 
finding points of intersection with the other curves, crossing points with the 
x-axis, or anything else.

Your screen should look something like this:

Open up a New 2D Graph Page.

Edit the axes as follows:
x:	 Minimum:	 −4	 Maximum:	 4
y:	 Minimum:	 −6	 Maximum:	 6

Leave all of the green ticks underneath Auto.
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Left-click to select the area under the curve, and Delete.

Enter the equation: y = −x

What will this line look like?Predict

Click OK.

Place a point on the left hand section of the curve which is below the line.

What do you think the feature Move to Next Intersection will do?Predict

Make sure you are in Select Mode.

Use the Shift button to select the point and the line.
Right-click and select Move to next Intersection from the menu.

Place a point on the middle section of the line which is below the curve.

Make sure you are in Select Mode.

Use the Shift button to select the new point and the curve.

Right-click and select Move to Next Intersection from the menu.

Make sure you are in Select Mode.

Left-click on an unoccupied part of the graph area to de-select everything.

Use the Shift button to select both points.

Right-click and choose Find Area.
Use the following settings:

Trapezium Rule•	
Divisions: 50•	

The area between the two curves should now be marked.
You can now use the Animate Object function to experiment with different 
divisions as before.

Your page should look something like this:

Activity 3	

Autograph Buttons covered:

	 Enter equations (complicated ones!)

	 Default Scale

 	 Degrees and Radians

	 Zoom In Box

 	 Reset Axes
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Often in mathematics we encounter some pretty nasty looking equations. Au-
tograph can handle all of these, but it important you know how to enter them.

We are going to go through a number of equations and go through step-by-step 
how to enter each of them. Hopefully what you end up with on your screen is 
pretty similar to the graphs on the right.

Equation 1:

y = 4sin(3x)

Open up a New 2D Graph Page.

Ensure you are in Degree mode.

Type the following and then press OK:

y = 4sin(3x)

Click on Default Scales to improve the 
graph.

Edit the axes as follows:
x:	 Minimum:	 −360	 Maximum:	 360
y:	 Minimum:	 −5	 Maximum:	 5

Equation 2:

x = cos(3t + π)

Open up a New 2D Graph Page.

Click on the small black arrow next to 
this button.

Change the axes to x and t.

Ensure you are in Radian mode.

Type the following and then press OK:

x = cos(3t + π)

Note: Either use the  button or press “alt p” together.

Click on Default Scales to improve the graph.

Equation 3:

y = ​ 
(5x+3)³

 ______ 2x  ​

Open up a New 2D Graph Page.

Type the following and then press OK:

y = (5x+3)³/2x

Note: For the cubed, use either the little 3 button or press “alt 3” together.

Edit the axes as follows:
x:	 Minimum:	 −5	 Maximum:	 5
y:	 Minimum:	 0	 Maximum:	 20000

Use the Zoom In Box function to take a closer look at the graph around the 
origin.
Notice how the scale automatically adjusts the closer in you get. 

Use the Drag function to move across the screen. 

Press Undo several times is to get back to your original view of the graph.

Equation 4:

y = ​x​​ 
4
 __ 5 ​​

Open up a New 2D Graph Page.

Click on Slow Plot mode.

Type the following and then press OK:

y = x^(4/5)

Note: To access the power/hat button 
press Shift and the number which the 
symbol is above together (usually 6).

Edit the axes as follows:
x:	 Minimum:	 −6	 Maximum:	 6
y:	 Minimum:	 −2	 Maximum:	 2 

Equation 5: Parametric

x = t² − 1, y = 2t

Open up a New 2D Graph Page.

Ensure Slow Plot mode is on.

Type the following and then press OK:

x = t² − 1, y = 2t

Edit the axes as follows:
x:	 Minimum:	 −2	 Maximum:	 6
y:	 Minimum:	 −6	 Maximum:	 6

Equation 6:

y = |x| ± ​√ 
______

 4 − x² ​
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Click on Equal Aspect Mode.
This alters the x scale so that the axes are square.

Click on Edit Axes
Go to Appearance
Open the drop-down menu underneath Themes
Select Graph Paper
Click OK

On the top toolbar, click on Axes, and then Show Key to hide the key at the 
bottom of the screen.

Place a co-ordinate at (1, 3).

Place another co-ordinate at (4, 1).

What will a line segment between these two points look like? What direction 
will it slope? Will it cross the axes?

Predict

Make sure you are in Select Mode.

Use the Shift button to select both points.

Right-click and select Line Segment from the menu.

What do you think the Gradient function will do?Predict

Again, use the Shift button to select both points.

Right-click and select Gradient from the menu.

Left-click to select the gradient triangle.

Select Text Box from the menu and click OK.
This displays the gradient of the line, as well as the equation.

Your screen should look something like this:

A nice romantic one to finish…

Can you guess what this graph will 
look like?

Predict

Open up a New 2D Graph Page.

Ensure Slow Plot mode is on.

Type the following and then press OK:

y=lxl ± √(4 − x²)

Note: To access the modulus signs, the plus-minus, and the square root, simply 
press the corresponding buttons in the equation editor. 

Note: For more examples of the different types of equations that can be entered 
into Autograph, see the relevant section in the Help menu.

Activity 4	

Open up a New 2D Graph Page.

Autograph Buttons covered:

	 Equal aspect

	 Line segment

	 Gradient

	 Perpendicular Bisector

Other Autograph Functions covered:

Graph paper theme

Hiding the Key

Circles and Tangents

Marquee Select

Use of Shift and Ctrl

Tutorials

A d d i t i o n a l  T e a c h e r  T u t o r i a l

Getting Going 3
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You can now select a point and move it using the left-right arrows on the key-
board to see the effect on the gradient and the equation of the line.

Note: The default in Advanced Mode is that the left-right arrows move points 
1/10th of a grid spacing. If you hold Shift down whilst pressing the arrows, the 
point moves a whole “grid spacing”. If you hold down Ctrl whilst pressing the 
arrows, the point moves by 1/100th of a grid spacing.

What do you think the Perpendicular Bisector function will do?Predict

Again, use the Shift button to select both points.

Right-click and select Perpendicular Bisector from the menu.

Left-click to select the perpendicular bisector.

Select Text Box from the menu and click OK.
This displays the equation of the line.

Place a co-ordinate at (−4, −2).

Place another co-ordinate at (−2, −2).

Drag a rectangle that surrounds both points.
This is known as Marquee Selection, and is a useful way of selecting multiple 
objects in a given area.

What do you think the Circle (2pts) function will do?Predict

Right-click and select Circle (2pts) from the menu.

What will a tangent to this circle look like? Where will it cross the axes?Predict

Place a point somewhere on the circle.

Left-click so just this new point is selected.
Right-click and select Tangent from the menu.

Left-click so just the tangent is selected.

Select Text Box from the menu and click OK.
This displays the equation of the tangent.

You can now use the arrow buttons on the keyboard to move the tangent 
around the circle.

Your screen should look something like this:

Note: With these various shapes and lines on the page, it is also possible to find 
the points of intersection in exactly the same way as described in Activity 1.

Activity 5	

Autograph Buttons covered:

	 Constant Controller

	 Function Definitions

	 Manage List
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Open up a New 2D Graph Page.

Edit the axes as follows:
x:	 Minimum:	 −6	 Maximum:	 6
y:	 Minimum:	 −10	 Maximum:	 10

Leave the green ticks as they are to allow Autograph to select the best grid 
spacings.

Enter the equation: y = ax² + bx + c
Still on the Enter Equation screen, click on Edit Constants, and set the values as 
follows:
	 a = 1	 b = 4	 c = 4

What will this curve look like? Where will it cross the axes? Which direction 
will it slope?

Predict

Click OK twice.

Left-click to select the curve (it should turn black).

Select Text Box.
Tick the box next to Show Detailed Object Text and click OK.
The equation of the curve and the current values of the constants should now 
be displayed in a moveable Text Box.

Click on Constant Controller.
You can now change the values of any of the three constants and observe the 
effect it has on the shape and position of the curve.
The drop-down menu is used to switch between constants.
The up-down buttons alter the value of the constant.
The left-right buttons alter the size of the step.

Experiment by adjusting the values of each constant, trying to predict what ef-
fect it will have on the shape and position of the graph.

Your page should look something like this:

Set the value of each constant to 1.
Select constant c.
Click on Options on the Constant Controller.
Select Family Plot.
Adjust the parameters as follows:

	 Start:	− 5	 Finish:	5	 Step:	 1

What will this look like?Predict

Click OK.

Your screen should look something like this:
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Click on Options again.
This time select Animation.
Keep the Animation Speed and the Start and Finish the same, but adjust the 
Step to 0.1.
Click OK and press the Play button.
This automatically adjusts the value of c for you so you can observe its effects 
on the shape and position of the curve.

Open up a New 2D Graph Page.

Edit the axes as follows: x from −10 to 10 and y from −40 to 40.

Click on Function Definitions:
Define •	 f(x) to be 10√x

Note: to type the √ sign, press “alt r” together.
Define •	 g(x) to be x² – 4

Ensure Slow Plot mode is on.

Enter the equation: y = f(x)

What will this look like?Predict

Click OK.
Enter another equation: y = g(x)

What will this look like?Predict

Click OK.
Enter the equation: y = f(x) + g(x)

What will this look like?Predict

Click OK.
Enter another equation: y = f(x) – g(x)

What will this look like?Predict

Click OK.

Your screen should look something like this:

Click on Manage List.

Select Equation 3: y = f(x) + g(x)
Delete it.

Do the same with Equation 4: y = f(x) – g(x)

Click OK.

You should now be left with the original two curves.

Carefully enter the equation: y = f(g(x))
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What will this look like?Predict

Click OK.

Carefully enter another equation: y = g(f(x))

What will this look like?Predict

Click OK.

Your screen should look something like this:

Use the zoom and Drag functions to have a closer look at the intersections of 
these curves.

Whiteboard Mode and On-Screen Keyboard	

Note: This additional tutorial is designed to help you get the most out of Auto-
graph on the Interactive Whiteboard (IWB) for classroom demonstrations, and 
hence ideally it should take place on an IWB.

New Autograph Buttons covered:

	 Whiteboard Mode

	 Keyboard

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

Select Whiteboard Mode.

Edit the axes as follows:
x:	 Minimum:	 −12	 Maximum:	 12	 Numbers:	 1	 Pips:	 1
y:	 Minimum:	 −6	 Maximum:	 6	 Numbers:	 1	 Pips:	 1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you.

Select Equal Aspect Mode.
This will automatically adjust the x-axis so the axes are square.

In the View menu on the top toolbar, select Keyboard.
The on-screen keyboard should now appear.
Click on the Text button to display a greater range of the keyboard buttons.
Drag the on-screen keyboard to a convenient place on the screen.

Place a point at (3, 3).

The point should still be selected (it should have a square around it), but if not 
simply left-click to select it again. 

Click on Text Box.
Use the on-screen keyboard to change the word “Point” to “A” and click OK.
Drag the Text Box to a convenient space on the screen.

Place a point at (−2, −4).

Label the point “B”.

Place a point at (−4, −3).

Label the point “C”.

Note: At this stage, all three points are selected (they all have little squares 
around them). If you want to work on just one (or two) points, you must first 
de-select everything.
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Very Important: De-Selecting Everything
Whilst in Select Mode, left-click on an unoccupied part of the graph area.
This de-selects everything and is extremely useful in all Autograph activi-
ties in Whiteboard Mode.
If you don’t de-select everything before moving onto another task, you 
might find that Autograph thinks you still want to work with a certain point 
or line, and this could lead to problems!
Note: Pressing the Esc button on the keyboard performs the same function.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click to select Point B (it should have a square around it).

Click on the Text button again to show a more limited range of the keyboard 
buttons.

We are now going to move Point B using the arrow buttons on the on-screen 
keyboard.

The default in Advanced Mode is that the left-right arrows move points 1/10th 
of a gird spacing.
If you hold Shift down whilst pressing the arrows, the point moves a whole 
“grid spacing”.
If you hold down Ctrl whilst pressing the arrows, the point moves by 1/100th of 
a grid spacing.
Note: It is important when using the on-screen keyboard to remember that the 
Shift, Ctrl, Alt and Caps Lock buttons remain pressed down until you click on 
them again.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click to select point A and then point C (they should both have squares 
around them)
Note: In Whiteboard Mode, it is enough to simply click on objects in turn to 
select them.

Right-click and choose Line Segment from the menu.

Click on the Data and Text buttons to show the full range of the on-screen 
keyboard buttons.

Use the on-screen keyboard to enter the equation: y = x² and click OK.
Note: Hitting the Enter/Return button on the keyboard is often a quicker way 

of opening the Add Equation screen.
Note: To enter x², either use the little  button, press “alt 2” together, or type in 
“xx”.

At the top of the screen go to Axes > Show Key.

This should make the key at the bottom of the screen disappear and is extreme-
ly useful when you don’t wish your students to see the equations of lines and 
curves on the screen.

Note: This can also be done by right-clicking on the Key towards the bottom 
of the screen where it says “Equation 1: y = x²”, and from the menu left-click on 
Show Key.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click to select the line segment and the curve (they should both turn 
black).
Right-click and choose Solve f(x)=g(x) from the menu.

The points of intersection of the curve and the line segment should now be 
marked on the graph.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on one of the points of intersection (they should both turn black).

Click on Text Box.
Use the on-screen keyboard to change the words “Equation Solve” to “Intersec-
tion” and click OK.
Drag the Text Box to a convenient space on the screen.

Your screen should look something like this:
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Note: The onscreen keyboard is extremely useful as it can be used with any 
other application, not just Autograph, and the maths symbols in the Extra panel 
will also work in other applications. Only a couple of characters are exclusive to 
Autograph font.

﻿3 Tutorials Additional Teacher Tutorial



35

Handy Hints and TipsGetting Going 4

The more you use Autograph, the more little short-cuts you find to make life 
even easier for yourself. Here is a collection of some of my favourite handy 
hints and tips.

Keyboard Shortcuts	

The following keyboard shortcuts are particularly useful when entering equa-
tions, writing in Text Boxes, or defining functions:

π	 Alt-p			   σ	 Alt-s		  x²	 Alt-2 or xx

√	 Alt-r			   μ	 Alt-m		  xⁿ	 Alt-n

l l	 Alt-l (modulus)	 α	 Alt-a		  x	 Alt-x

θ	 Alt-t			   β	 Alt-b		  ½	 Alt-h		

Spacebar pauses and restarts during Slow Plot mode.

Enter takes you straight from the graph area to the Enter Equation screen.

The Use of Undo	

Undo is not only useful for correcting mistakes, and returning to the original 
view of a graph following several zooms and drags, it can also be used as a 
means of revealing a pre-prepared set of objects.  Simply prepare the page how 
you want, delete the objects you don’t want the class to see, and then whenever 
you are ready for them to see them, just hit Undo! 

Moving Points

If you select a point and use the left-right arrows on the keyboard to move it, 
then by default Autograph will move the point 1/10th of a grid space. But if you 
want to move it more (or less) then try this:

If you hold Shift down whilst pressing the arrows, the point moves a whole grid 
spacing.

If you hold down Ctrl whilst pressing the arrows, the point moves by 1/100th of 
a grid spacing.

Manage Equation List	

If you have two or more lines drawn on top of each other, and you want to be 
sure you have the selected the equation you want, just click on Manage Equa-
tion List, and you will be able to access all equations for editing or deleting 
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from here.  

Note: Double left-clicking on the “top” equation in the graph area should also 
automatically select the one “below” it, but the above method is fail-safe!

The Marque Select Tool	

When in Select Mode, you can drag a rectangular shape across the screen, and 
any objects contained within this rectangle will automatically become selected. 

Selecting All Objects	

If you wish to select the vast majority of objects on a screen, it can often be 
quicker to select all the objects at once, and then de-select a few of those.

In the Edit menu, go to Select All.

Now just left-click on any objects you don’t want to select to de-select them!

Note: If you are NOT in Whiteboard Mode, you must hold down Shift whilst 
de-selecting objects.

Viewing in 3D	

When working in 3D, the Drag function is very handy for having a look around 
your shapes. But this function is even better when combined with a few but-
tons:

+ Ctrl	 Zooms in and out

+ Shift	Shifts the camera left and right

And remember, you can restore the original view of your 3D page with one 
click of a button (x-y-z Orientation).

Putting Hide Objects onto the Toolbar	

Hide Object and Reveal Object are two extremely useful functions in Auto-
graph, and if you follow these steps you can have these options just one click 
away on your toolbar:

Enter the equation y = x

Left-click to select the line (it should turn black).

Right-click in the black space to the right of the top toolbar and a small menu 
should appear.

From this menu, select Customise…

With the Customise window still open, click on the Object menu from the top 
toolbar, and Hide Object should be one of the options.

You should now be able to drag Hide Object to the top toolbar, where it will 
remain as an option.

You can add Reveal Object to the toolbar (or indeed any function) in exactly 
the same way.

The Autograph Keyboard	

Not only is the keyboard incredibly useful to use when running Autograph on 
an interactive whiteboard or via a graphics tablet, it can also be used in other 
applications such as Word, Excel or even when writing an email. So, your days 
of searching for that elusive theta or fractional notation may be over!
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T1
Teacher
Demonstration The Trapezium Rule

Learning Objectives	

To be able to understand how using both rectangles and trapeziums can •	
give an approximation to the area under a curve.

To be able to understand why the Trapezium Rule gives a more accurate •	
approximation of the area under a curve.

To be able to understand under which circumstances the Trapezium Rule •	
gives and over-estimate of the area under a curve, and when it gives an 
under-estimate.

Required Pre-Knowledge	

To be able to calculate the areas of rectangles and trapeziums.•	

To be aware of the concept of integration.•	

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D graph 
page.

Select Whiteboard Mode.

Enter the equation: y = (1 + x³)
Note: To enter the power, either use the little  button, or hold down “alt” and 
press “1”.

Edit the axes as follows:         
x:	 Minimum:	 0	 Maximum:	 2	 Numbers:	 0.5	 Pips:	 0.1
y:	 Minimum:	 0	 Maximum:	 2	 Numbers:	 0.5	 Pips:	 0.1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you.

Using the Scribble Tool, write the equation of the graph in the form y = ​  1
 _____ 1 + x³ ​ 

somewhere above the graph using the Scribble Tool.
Note: If you do not have an interactive whiteboard, then either display this 
equation elsewhere, or simply inform the class that this is the equation of the 
line.

On the top toolbar, click on Axes, and then Show Key to hide the key at the 
bottom of the screen.
Your screen should now look something like this:

Step-by-Step Instructions	

Activity 1: The Problem with Integration	

	 Teacher:	 How would you find the area under this curve between x = 0 and x = 1?
Or: How would you calculate: ​∫0​ 

1​ ​  1
 ____ 1+x³ ​​ dx?

	Ideal Response:	 Integrate!

	 Teacher:	 Okay then, off you go!

Allow the students a few minutes to try and integrate the expression, before 
announcing that for the time being expressions like this are too complicated to 
integrate.

	 Teacher:	 Can anybody think of another way of finding out the area under the curve?

	 Prompt:	 Maybe not the exact area, but at least a pretty good estimation? Could we per-
haps split up the area using a nice simple shape?

	Ideal Response:	 Split up the area under the curve using rectangles! 

Activity 2: The Rectangle Rule

At this point you can invite a student to come to the front to demonstrate ex-
actly how rectangles would help get an approximation of the area.

Use the Erase tool to rub out any mistakes.
If you want to get rid of all scribbles, click on Edit > Select all Scribbles, and 
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press delete on the keyboard (or right-click on the graph itself and select De-
lete Objects from the menu).

When ready, follow these steps:

Left-click on the curve with your mouse (it should turn black).
Right-click and a menu should appear.
Select Find Area.
Select the following:
Rectangle (-), Start Point: 0, End Point: 1, Divisions 5.
Click OK.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on any of the rectangles to select them.

Choose Text Box from the top of the screen, and click OK. 

The approximation to the area under the curve as given by the 5 rectangles 
should now appear.

Your screen should look something like this:

You can now ask any of the following questions:

	 Teacher:	 Is this an over-estimate or an under-estimate of the actual area under the 
curve?

	Ideal Response:	 Over-estimate.

At this point you could left-click on the curve again, right-click to call up the 
menu, select Find Area, and this time choose Rectangle (+) to demonstrate an 
under-estimate:

	 Teacher:	 Still using rectangles, how could we improve the accuracy of our approxima-
tion?

	Ideal Response:	 Use more rectangles.

Left-click on an unoccupied section of the graph area to de-select everything.

Left-click the most recent set of rectangles (the under-estimate), right-click 
and select Delete Object. 
Note: Pressing delete on the keyboard has the same effect once the object is 
selected.

Left-click on the remaining set of rectangles.

Right-click to call up the menu, and select Animate Object.

You now have the ability to dynamically adjust the number of rectangles and 
encourage the class to observe how it improves the estimation of the area:

	 Teacher:	 Can anybody think of a better shape to use when estimating the area?

	 Prompt:	 What is it about the shape of the rectangle that causes it to be inaccurate?

	Ideal Response:	 Use trapeziums!

Activity 3: The Trapezium Rule
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Delete the existing rectangles as described above.
Note: don’t worry about the on-screen warning, this is just to inform you that 
the Text Box will also be deleted as it is linked to the area. 

Repeat the steps above to find the area under the curve, but this time select the 
following: Trapezium Rule, Start Point: 0, End Point: 1, Divisions: 5.

Click OK.

Again, left-click to select the trapeziums.

Select Text Box and click OK.

Your screen should now look something like this:

	 Teacher:	 We can see that this will give is a more accurate approximation. But is this an 
over-estimate of the area, or an under-estimate?

	Ideal Response:	 Under-estimate.

Use the Zoom In function to get a closer look at the top of some of those Tra-
peziums to highlight that it is in fact still an under-estimate of the area. Notice 
how the scale automatically adjusts the closer you get.

Use the Drag mode to move around to different points on the curve.

Your screen should look something like this:

Use the Zoom Out function to the original view of the graph.

Note: Pressing the Undo button several times is often a quicker way of doing 
this.

Again at this point you can use the Animation function to look at the effect of 
increasing the number of divisions has on improving the accuracy of the ap-
proximation.

	 Teacher:	 Will the Trapezium Rule always give us an under-estimation of the area?
Or:

	 Teacher:	 Can anyone think of (or come up and draw) an example of a curve which the 
Trapezium Rule would give us an over-estimation of the area underneath it?

If the students do want to sketch a curve:

Open up a blank 2D Graph Page.

Encourage the students to use the Scribble Tool to sketch their graphs.

Use the Erase tool to rub out any mistakes.

When you are ready:

Open up a blank 2D Graph Page.

Enter the equation: y = x²

Left-click to select the curve (it should turn black).
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Right-click to get the menu, and select Find Area.
Choose the following settings.
Trapezium Rule, Start Point: 0, End Point: 2, Divisions: 4.

Your screen should look something like this:

Again, use the Zoom In and Drag function to get a closer look to illustrate that 
we now have an over-estimation of the area.

Your screen should look something like this:

	 Teacher:	 Can anyone explain why the Trapezium Rule in the first example gave us an 
under-estimate of the true area, and yet in the second example it gave us an 
over-estimate? 

	 Prompt:	 Think about the slope of the graphs, and not just whether they are positive and 
negative. Think about how the graphs “bend”. Can anybody remember the tech-
nical term for the type of “bendiness”?

	Ideal Response:	 It depends on the Concavity of the function!

	 Teacher:	 So, it looks like using Trapeziums can give us a more accurate approximation 
of the area underneath a curve whenever integration lets us down. Now all we 
need to know is how to calculate the area of all these trapeziums, knowing both 
the height and the base. If only we had a nice formula…

Note: A simple Autograph diagram like the ones in this demonstration might 
be ideal to talk though the Trapezium Rule Formula.

Ideas for Further Work	

The students should now be in a position to learn the formula for the •	
Trapezium Rule, and to practise using it to estimate the area underneath 
a curve.

They should also be well prepared for exam-style questions which often •	
like to ask about over and under estimations.

Further investigation into the •	 concavity of functions an the effect on the 
Trapezium Rule using Autograph could be conducted in a similar way as 
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outlined in this demonstration 

A possible extension activity would be to look at the •	 Trapezium Rule as 
being halfway between the two rectangle rules.  Take an always increasing 
function and find the area between two points using all three methods.  
The Trapezium Rule always gives an answer exactly halfway between the 
rectangle rule.  You can look closely at one trapezium and create a trian-
gle near the top, rotate it to show how the trapezium is halfway between 
the two rectangle approximations.

T1 The Trapezium Rule
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T2
Teacher
Demonstration

Things to Watch Out for
when Integratiing

Learning Objectives	

To be able to understand some of the common problems and difficulties sur-
rounding integration, such as:

Not accounting for negative areas•	

Improper Integrals•	

Unbounded Functions•	

Unbounded Intervals •	

Required Pre-Knowledge	

To be able to sketch curves involving both positive and negative powers •	
of x.

To be able to calculate simple, definite and indefinite integrals such as:•	

​∫ 
 

 ​ 

 

 ​ 3x²​ dx 	​ ∫ 
2

 ​ 

4

 ​ x² − 3x + 4​ dx 	​ ∫ 
1

 ​ 

4

 ​ ​ 3 __ x³ ​​ dx

Note: Knowledge of infinite series would be helpful, but is not essential. In-
deed, this topic is a nice way of introducing the idea of an infinite series con-
verging to a finite amount.

Pre-activity Set-up	

None required.

Step-by-Step Instructions	

Activity 1: Negative Areas

	 Teacher:	 Just to warm you up, can you work out the value of this integral: 

​∫ 
0

 ​ 

3

 ​ x² − 4x + 3​ dx

	 Prompt:	 Pupils may need reminding of the techniques of integration learnt in previous 
lessons.

	Ideal Response:	 9 – 18 + 9 = 0

	 Teacher:	 Does that sound right to you? Why would the area under this curve be equal to 
zero?

	 Prompt:	 What type of curve is it? Think of the shape. Where does it cross the x-axis?

T2 Things to Watch Out for when Integratiing
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	Ideal Response:	 Some section of the curve lies above the x-axis, which gives us a positive area, 
but some section of the curve lies below the x-axis, which gives us a negative 
area. These two areas must be cancelling each other out to leave us with zero.

	 Teacher:	 Can anybody come and draw a sketch of the curve and show us why the answer 
is coming out at zero?

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page. 

Select Whiteboard Mode.

Edit the axes as follows:         
x:	 Minimum:	 −2	 Maximum:	 6	 Numbers:	 1	 Pips:	 1
y:	 Minimum:	 −2	 Maximum:	 4	 Numbers:	 1	 Pips:	 1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you.

Using the Scribble Tool, encourage the students to attempt to sketch the curve 
on the grid.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press Delete on the keyboard (or Right-Click on the graph area itself and select 
Delete Objects from the menu).

When the correct curve is drawn and the students have identified that some 
parts of the curve lie above the line and some parts lie below the line, explain 
that we are now going to let the computer draw the curve accurately:

Go to Edit in the top toolbar, then Select All Scribbles, and then press Delete 
on the keyboard. 

Click on Slow Plot mode.

Enter the equation: y = x² – 4x + 3
Note: To enter x², either use the little 2 button or press “xx”.
Click OK.

The curve should begin to appear on the screen.

Press Pause Plotting both to stop the process, or to resume it to focus on the 
key features of the graph.
Note: Pressing the Spacebar on the keyboard has the same effect!

Your screen should look like this:

	 Teacher:	 So, how are we going to work out the area between the curve and the x-axis 
between x = 0 and x = 3?

	Ideal Response:	 Do two separate integrals.

	 Teacher:	 Can anybody tell me what those two separate integrals are?

	Ideal Response:	​ ∫ 
0

 ​ 

1

 ​ x² − 4x + 3​ dx and ​∫ 
1

 ​ 

3

 ​ x² − 4x + 3​ dx 

	 Teacher:	 Okay, see if you can work out the answer.

	Ideal Response:	 The first integral gives us an answer of ​ 4 __ 
3
 ​. The second integral gives us an an-

swer of −​ 4 __ 3 ​. So, ignoring the minus sign, the actual area of the integral is equal 
to ​ 8 __ 

3
 ​ = 2​ 2 __ 3 ​.

	 Teacher:	 Let’s just quickly check that using Autograph.

Left-click to select the curve (it should turn black).

Add a point onto the curve with an x value of 0.

Add two more points, with x values of 1 and 3.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click to select the first two points: (0, 3) and (1, 0).
Note: They should both have little squares around them to show they are both 
selected. 

Right-click and choose Find Area from the menu.
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tive areas to practise.

For Example: 	

​∫ 
−1

​ 

2

 ​ 4x³​ dx		​ ∫ 
0

 ​ 

2

 ​ x(x − 1)(x − 2)​ dx

Activity 2: Improper Integrals	

(a) Unbounded Functions
	 Teacher:	 Have a go at trying to evaluate this integral:

​∫ 
0

 ​ 

2

 ​ ​ 1 __ x² ​​ dx

Give the students a few minutes to attempt this question. It is crucial that they 
discover the difficulties for themselves, and then they are more open and recep-
tive to solutions!

	 Prompt:	 What particular value of x is causing the problem, and why?

	Ideal Response:	 The zero!

	 Teacher:	 As we said before, the key to sorting out any integral is to try and do a sketch 
first. Can anybody come up and sketch this function for positive value of x?

	 Prompt:	 What points do we know definitely lie on the curve? Think about what happens 
to y when x is really big. How about when x is really small?

Open up a New 2D Graph Page.

Edit the axes as follows:         
x:	 Minimum:	 0	 Maximum:	 6	 Numbers:	 1	 Pips:	 1
y:	 Minimum:	 0	 Maximum:	 6	 Numbers:	 1	 Pips:	 1

Remove all of the green ticks underneath Auto.

Allow the students to attempt to sketch the curve on the grid using the Scrib-
ble Tool.

Use the Erase Tool to clear away any mistakes.

When the correct curve is drawn explain that we are now going to let the com-
puter draw the curve more accurately:

Go to Edit in the top toolbar, then Select All Scribbles, and then press Delete 
on the keyboard.

Again, ensure Slow Plot mode is turned on.

Enter the equation: y = 1/x²
Note: you could also enter this equation as: y = x^(−2)

The curve should begin to appear on the screen.

Select Simpson’s Rule.
Alter the number of divisions to 500.
Click OK.

Note: As the curve is a parabola, Simpson’s Rule would of course give the exact 
area under the curve if only one division was used. However, 500 divisions 
gives us a clearer visual representation of the area on the screen, and is impor-
tant for what comes later…

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click to select the coloured in area underneath the curve (it should turn 
black).

Choose Text Box from the menu.
Click OK.
The value of the area under the curve (1.333) should now be displayed.
Note: To adjust the accuracy, go to Page > Edit Settings > Number of signifi-
cant figures.

Repeat these steps but using the points (1, 0) and (3, 0).

When complete, your page should look something like this:

	 Teacher:	 I hope this example highlights how important it is to always do a quick sketch 
of any function before you try to integrate it. That way you can never get 
tripped up with negative areas!

At this point you could give the pupils some similar questions involving nega-
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Press Pause Plotting (or the Spacebar) both to stop the process, or to resume 
it to focus on the key features of the graph.

Your screen should look something like this:

	 Teacher:	 Can anybody explain what is happening as we approach x = 0?

	Ideal Response:	 The curve shoots off towards infinity!

	 Teacher:	 Yes! Let’s take a closer look at that…

Use the Zoom Out y function to have a look at larger values of y.
Notice how the scale automatically adjusts the more you zoom out.

Your screen should look something like this:

Press the Undo button several times to return to the original view of the graph.

	 Teacher:	 As we can see, the problem with this integral is that the function shoots off 
towards infinity as we get closer to x = 0. The technical way of saying this is that 
the function is unbounded, and we call integrals like this Improper Integrals.

	 Teacher:	 Can anybody predict what will happen to the area under the curve as we ap-
proach the value of x = 0?

	Ideal Response:	 The area shoots off towards infinity as well!

	 Teacher:	 Well, let’s have a look…

Left-click to select the curve (it should turn black).

Add a point onto the curve with an x value of 2.

Add another point with an x value of 1.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click to select the two points.

Right-click and choose Find Area from the menu.
Select Simpson’s Rule.
Divisions: 500. 
Click OK.

Left-click on an unoccupied part of the graph area to de-select everything.
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Left-click to select the coloured in area under the curve (it should turn black).

Choose Text Box from the menu and click OK.
The value of the area under the curve (0.5) should now be displayed.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click to select the first point on the curve (1, 1).

Select Animate.
Now, move the point closer to the value of 0 using the left arrow.
When the position reaches 0.1, adjust the step to 0.01 and continue.
Your screen should look something like this:

At this point you can either begin to teach the students how to deal with improper 
integrals with unbounded functions, or explain that you will tackle this matter 
later on.

(b) Unbounded Intervals
	 Teacher:	 Well, if that integral caused us problems, what on earth are we going to do with 

this one?

​∫ 
2

 ​ 

∞

 ​ 1/x²​ dx

	 Prompt:	 Refer them to the graph on the screen. What is happening to the curve as x gets 
bigger and bigger? Would the area under the curve between x = 5 and x = 6 be a 
lot? How about between x = 10 and x = 100?

	 Teacher:	 I wonder, will the curve ever touch or cross the x axis?

	Ideal Response:	 No!

	 Teacher:	 Why not?

	 Prompt:	 Think about the function itself. Try putting some really big numbers into it. 
What do you notice?

	Ideal Response:	 The function can never be negative because of the squared term, so it must 
never cross the x-axis. It just keeps getting closer and closer to it.

	 Teacher:	 Sounds good. Let’s have a look…

Use the hand and zoom functions to investigate what is happening to the curve 
as x is getting bigger. Point out the scale on the y axis so the students are aware 
that the curve is getting so close to the x axis, but still is not touching.

Return to the original view of the graph.

Note: Pressing the Undo button several times is often a quicker way of doing 
this.

	 Teacher:	 Believe it or not, even though one of the limits of our integral is infinite, we can 
still work out the exact value of the area under the curve. Watch what happens 
to the value of the area as we increase the upper limit.

Left-click twice on the area under the curve.
Adjust the number of divisions to 1,000.
Click OK.

Still using the Animate function, change the position of the first point to 2, and 
the step to 0.1.
Now keep pressing the right button so the upper limit increases.
Your screen should now look like this:
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Continue doing this, perhaps adjusting the step, first to 1, and then to 10.
Adjust the accuracy (Page > Edit Settings > Number of significant figures) to 
make the point even clearer.

Emphasise the fact that even though the size of the steps is increasing, the 
change in the area is actually falling.

	 Teacher:	 What value does the area seem to be converging to/tending towards?

	Ideal Response:	 0.5

Note: As Simpson’s Rule is still only a numerical approximation, and as a 
maximum of 1,000 divisions are permitted, be careful not to go above x values 
of 1,000 as it appears that the area actually goes above 0.5!

	 Teacher:	 So, even though one of the limits of our integral did not have a finite value, we 
were still able to calculate the size of the area underneath the curve. The tech-
nical way of saying this is that the interval of the integral was unbounded, and 
this is the second type of Improper Integral which you could encounter.

At this point, you might like to repeat the above investigation but with the 
curve:

​∫ 
 
 ​ 

 

 ​ ​ 1 ___ ​√ 
__

 x ​ ​​ dx

This curve works the other way around – integrals approaching x = 0 can be 
evaluated, whereas those approaching infinity cannot.

Ideas for Further Work	

The students should now have a good understanding of the concepts of •	
negative area and the two types of improper integrals. This should make it 
easier for them to learn and understand the techniques involved in solv-
ing questions like this.

In terms of the two types of Improper Integrals, the students should now •	
be in a good position to grasp the concept of limits, and hopefully enjoy 
success in what is a notoriously difficult and misunderstood concept.

	Investigations into infinite series follows on nicely from this topic.•	
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T3Teacher
Demonstration

Introducing Volume of 
Revolution

Learning Objectives	

To be introduced to the concept of volume of revolution.•	

To understand through a dynamic visual demonstration why the formula •	
for finding the volume of a solid formed by rotating a function around the 
x-axis is: V = ​∫a​ 

b​ πy²​ dx

To consolidate understanding of the concept of limits, sums and the skills •	
of integration.

Required Pre-Knowledge	

To be able to integrate functions involving positive powers of •	 x.

To be able to use the answer to find the area bounded by the curve and •	
the x-axis between two given limits.

To be aware of the formula for finding the volume of a cylinder.•	

To be comfortable with Sigma •	 ∑ notation.

Pre-activity Set-up	

Open up Autograph in Advanced Mode.

Open up a New 3D Graph Page.

Select Whiteboard Mode.

Change the colour of the background to Medium.

Change the position of the key to the right-hand side of the screen.

Enter the equation: y = x² + 2
Note: To enter x², either use the little 2 button, or type “xx”, or press “alt 2” 
together.
Still on the Enter Equation screen, place a tick in the space next to Plot as 2D 
Equation.

Click OK.

Click on the little arrow next to x-y-z Orientation.

Select x-y Orientation.

Edit the axes as follows:
x:	 Minimum:	 0	 Maximum:	 4	 Numbers:	 1	 Pips:	 0.2

y:	 Minimum:	 −12	 Maximum:	 12	 Numbers:	 2	 Pips:	 1
z:	  Minimum:	 −12	 Maximum:	 12	 Numbers:	 2	 Pips:	 1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

Still on the Edit Axes screen, click on the Options tab.
Under Axes, remove the tick next to Always Outside.
Click OK.

Your screen should now look something like this:

Step-by-Step Instructions	

Activity 1: Warming Up

	 Teacher:	 Okay, on the screen I have drawn a portion of the graph of y = x² + 2. Just to 
warm you up, can you work out the area bounded by the curve and the x-axis 
between x = 1 and x = 3. 

	 Prompt:	 What does “bounded by the curve and the x-axis” mean? How do we work out 
the area underneath a curve? How could we write what the question is asking 
us using notation? Does this help:  

A = ​∫ 
1

 ​ 

3

 ​ x² + 2​ dx

	Ideal Response:	 We need to integrate: 
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A	= ​∫ 
1

 ​ 

3

 ​ x² + 2​ dx

	 = ​​[ ​ x³
 __ 3 ​ + 2x ]​​ 

1
​ 

3

​

	 = 12​ 2 __ 3 ​

	 Teacher:	 Sounds good. Let’s use Autograph to check the answer…

Left-click on the curve (it should turn black).

Enter a co-ordinate with an x value of 1 (leave z unchanged).

Enter another co-ordinate, this time with an x value of 3 (leave z unchanged).

Two points should now be marked on the curve.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on both points (they should both have little squares around them).

Right-click and select Find Area from the menu.

Select Simpsons Rule, leave the number of divisions at 5, and click OK.

In the View menu on the top toolbar, select View Status Box, and move it to a 
convenient position on the page.

Your screen should look something like this:

Activity 2: Picturing the Third Dimension

Close the Status Box by clicking on the red cross in the corner. 

	 Teacher:	 Okay, now the tricky part. Say that instead of just finding the area underneath 
the curve, we actually wanted to find the volume of the solid formed when ro-
tating this curve around the x-axis. Now, to start with, does anybody have any 
idea what that solid might look like? 

	 Prompt:	 Try to picture in your mind rotating the curve all the way around the x-axis. 
What sort of shape do we end up with?

Give the students time to discuss this and share their ideas before proceeding. 

	 Teacher:	 Let’s use Autograph to have a look…

Click on Slow Plot mode.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the area underneath the curve (it should turn white).

Right-click and select Find Volume from the menu, and click OK.

The volume of revolution should now begin to plot.

If your students wish to see this again, simply press Undo and repeat the steps 
above.

Your screen should look something like this:

Use the Drag tool to have a good look around the graph to emphasise its shape.
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Note: The following functions may also prove useful:

+ Ctrl		 Zooms in and out.

+ Shift		Moves the entire graph.

Restores the original view of the graph (x-y Orinetation).

After having a look around, your screen might look something like this:

Activity 3: Splitting Up the Shape

Select x-y Orientation to return to the original view of the graph.

Make sure you are in Select Mode.

	 Teacher:	 Okay, so having seen what the solid looks like, we now need to come up with a 
formula that allows us to work out its volume, and the way we are going to do 
this is very similar to how we came up with our method of differentiating func-
tions in the first place…

Note: At this point it is possible to encourage a discussion about how the stu-
dents might go about finding the volume, but it is unlikely they will be able to 
come up with the correct answer on their own. This does not matter too much 
as the real power of this demonstration comes from the students visualising 
and understanding this process that follows, and not necessarily coming up 
with the process themselves.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the lower half of the green volume (it should turn grey).

Right-click and select Delete from the menu, or simply press Delete on the 
keyboard.

You should now be left with the area under the curve marked on the graph.

	 Teacher:	 Okay, we are going to begin by looking at a smaller section of the curve to see if 
that helps us…

Left-click on the curve itself (it should turn grey).

Enter a co-ordinate with an x value of 1+h (leave z unchanged).

	 Teacher:	 Now, because the value of h is automatically set to 1, our new point has an x 
value of 2. Now once again we can mark the area underneath this curve be-
tween these two points…

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on both the point at x = 1, and the point at x = 2 (they should both 
have little squares around them).

Right-click and select Find Area from the menu.

Select Simpsons Rule, leave the number of divisions at 5, and click OK.

	 Teacher:	 And once again I can use to Autograph to show me the solid that is formed 
when rotating this portion of the curve around the x-axis…

Make sure Slow Plot mode is still on.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the area underneath the portion of curve (it should turn white).

Right-click and select Find Volume from the menu, and click OK.

Your screen should look something like this:
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	 Teacher:	 Now, in a moment I am going to reduce the value of h. As the value of h gets 
smaller and smaller, what shape will the yellow solid start to resemble?

	 Prompt:	 Try to picture in your mind the gap between the x co-ordinates reducing. Think 
what effect that will have on the solid. What shape will this look like when the 
gap is really, really small?

	Ideal Response:	 A cylinder!

Click on the Constant Controller.
The up-down buttons adjust the value of the constant.
The left-right buttons adjust the value of the step.

Reduce the value of h, reducing the value of the step as the point approaches x 
= 1. 

Your screen should look something like this:

Use the Drag tool to have a good look around the graph to emphasise its shape.

Your screen should look something like this:

	 Teacher:	 Now comes the all important question: What is the volume of this cylinder?

	 Prompt:	 What is the formula for working out the volume of the cylinder? On our graph, 

T3 Introducing Volume of Revolution T3 Introducing Volume of Revolution



66 67

what is the radius? What is the height?

	Ideal Response:	 The formula for working out the volume of a cylinder is: V = πr²h. On our dia-
gram, the radius of the cylinder is the distance from the x-axis to the circumfer-
ence, which is given by the y value. The height of the cylinder is the distance 
along the x-axis, which is given by h. And so the formula for working out the 
volume of the cylinder is V = πy²h.

	 Teacher:	 Now this is not a perfect cylinder. As you can see from the graph, the curve 
slopes upwards, and so the radius of the left-hand face would be smaller than 
that of the right-hand face. But as the value of h gets smaller, and smaller and 
smaller, this difference reduces, and the solid formed becomes more and more 
like a cylinder.

Further reduce the value of h to emphasise this crucial point.

+ Ctrl	 Zoom in to have a closer look!

Give the students a few moments to digest this before moving on.

	 Teacher:	 Now what is also crucially important, is that we could have placed this cylinder 
anywhere on this curve, and the formula to work out it’ volume would have 
been exactly the same…

Adjust the value of h to 1.5.

Make sure you are in Select Mode.

Left-click on the point at x = 1 (it should have a little square around it).

Use the left-right arrows on the keyboard to adjust the position of the point 
until it is at x = 2.5.

Use the Drag tool to have a good look around the graph to emphasise its shape.

Point out that the radius of the cylinder is still given by y, and the height by h.

Your screen should look something like this:

	 Teacher:	 Now, can anybody see how this helps us work out the volume of the funny-
shaped solid that we started with?

	 Prompt:	 Think about the fact that the formula for working out the volume of the cylin-
der remains the same wherever we are on the curve.

	Ideal Response:	 The volume of the funny-shaped solid was just made up of loads and loads of 
cylinders. If we can work out the volume of those and add them all together, 
then we have the volume of the funny-shaped solid!

Activity 4: Deriving the Formula

	 Teacher:	 Excellent. Now, this bit can be a little tricky to understand, so give it your full 
attention… Instead of calling the tiny distance along the x-axis h, we are going 
to call it dx. This is the same dx that we know and love from our work on differ-
entiation and integration. What does it mean?

	Ideal Response:	 A small change in x.

	 Teacher:	 Good. And remember, just like with differentiation, the change is so small you 
can hardly see it, which is exactly what we need in order to make our series of 
solids resemble cylinders. So, bearing that in mind, what is the volume of each 
cylinder?

	Ideal Response:	 V = πy² dx

	 Teacher:	 Good. And would you agree that the area of the funny-shaped solid approxi-
mately equal to the sum of the volume of all these cylinders, which can be writ-
ten as: V ≈ ​∑x = 1​ 

x = 3​ πy²​ dx?
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	 Prompt:	 You may need to explain that the equation is only an approximation (hence no 
= sign) because of the sloping nature of the curve as discussed earlier. 

	 Teacher:	 Good. Now, the smaller the size of dx, the more accurate our approximation of 
the volume. The exact size of the volume is given by the limit as dx → 0, and we 
are left with this…

V = ​  lim    
dx → 0

​ ​∑ 
x = 1

​ 
x = 3

​ πy²​ dx = ​∫ 
1

 ​ 

3

 ​ πy²​ dx

Give the students time to digest this.

	 Teacher:	 In other words, to find the volume of the solid formed when a function has 
been rotated around the x-axis, you must square the function, multiply by π, 
and then integrate as normal. Do you reckon you could use this formula to 
work out the volume of the funny-shaped solid?...

	 Prompt:	 It might be worth holding back on pointing out that the calculation is made 
easier by placing π before the integral sign. Hopefully the students will discover 
this for themselves once they have had more experience with these types of 
questions.

	Ideal Response:	 V = ​∫ 
1

 ​ 

3

 ​ πy²​ dx

	 = π​∫ 
1

 ​ 

3

 ​ x⁴ + 4x² + 4​ dx

	 = π​​[ ​ x⁵
 __ 5 ​ + ​ 4x³

 ___ 3  ​ + 4x ]​​ 
1
​ 

3

​

	 = 91​ 1 ___ 15 ​π

	 Teacher:	 Sounds good. Let’s use Autograph to check the answer…

Make sure you are in Select Mode.

Adjust the value of h to 2.

Select x-y Orientation to return to the original view of the graph.

In the View menu on the top toolbar, select View Status Box, and move it to a 
convenient position on the page.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the point at x = 2.5 (it should have a little square around it).

Use the left-right arrows on the keyboard to adjust the position of the point 
until it is back at x = 1.

The correct volume should be displayed in the Status Box, and your screen 
should look something like this:

Ideas for Further Work	

Further practice the volume of the solid formed by rotating functions •	
around the x-axis.

Introduce finding the volume of functions rotated around the •	 y-axis. 
Note: This can be clearly demonstrated in Autograph using a similar 
method as described above.

Introduce finding the volume of solids formed by rotating the area be-•	
tween two intersecting functions around either axes.

To consolidate and deepen understanding of volumes of revolution, try •	
Student Investigation 2: Volumes of Revolution.
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T4
Teacher
Demonstration

Introducing the Concept
of Differentiation

Learning Objectives	

To appreciate that the gradient of a curve is not constant like a straight •	
line.

To be able to understand the concept of approximating the gradient at a •	
point using limits, leading onto Differentiation from First Principles.

Required Pre-Knowledge	

To be able to work out the gradient of a straight line using the right-an-•	
gled triangle method (“change in y divided by change in x”).

To know the shape of the •	 y = x² graph.

To be comfortable manipulating simple algebra, such as multiplying •	
brackets and cancelling terms.

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

At the top of the screen go to Page > Edit Settings, and adjust the number of 
significant figures up to 8. This will increase the accuracy of our calculations.

Select Whiteboard Mode.

Edit the axes as follows:
x:	 Minimum:	 −6	 Maximum:	 6	 Numbers:	 1	 Pips:	 0.5
y:	 Minimum:	 −4	 Maximum:	 25	 Numbers:	 2	 Pips:	 1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

Enter the equation: y = 8

Enter another equation: y = 3x + 10

At the top of the screen go to Axes > Show Key.

This should make the key at the bottom of the screen disappear.

Note: This can also be done by right-clicking on the Key towards the bottom 
of the screen where it says “Equation 1: y = 8”, and from the menu left-click on 
Show Key.

Your screen should look like this:

Step-by-Step Instructions	

Activity 1: A Reminder about Gradient

	 Teacher:	 Just to warm you up, what is the equation of the red line on the screen? 

	 Prompt:	 Think about what every single co-ordinate on that line has in common.

	Ideal Response:	 y = 8

	 Teacher:	 And what is the gradient of the red line? 

	Ideal Response:	 0

	 Teacher:	 And is that true for every single point on that line? 

	Ideal Response:	 Yes!

	 Teacher:	 Okay, so how about the blue line? How would we work out the gradient of that?

	 Prompt:	 What does gradient actually mean? What makes one line steeper than another?

	Ideal Response:	 We need to work out the slope of the line. We need to draw a right-angled tri-
angle / Work out how much the y values change as the x values change.

	 Teacher:	 Can somebody come to the board to show us how to do that?

Encourage the students to work out the gradient of the line on the screen using 
the Scribble Tool.
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Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select all scribbles, and 
press Delete on the keyboard (or right-click on the graph itself and select De-
lete Objects from the menu).

	Ideal Response:	 The gradient of the line is 3.

	 Teacher:	 And is the gradient of the blue line always 3 no matter where you are on that 
line? In other words, is it true that the gradient is always constant? 

	Ideal Response:	 Yes!

	 Teacher:	 Let’s just use Autograph to quickly show that…

Delete all scribbles as described above.

Draw a “gradient right-angled triangle” with base 1 and height 3.
Note: You must make sure you draw this as a continuous line, so don’t take the 
pen off the screen!

Left-click to select the triangle (it should turn black)

Whilst holding down the left mouse button, you can now move the triangle 
anywhere along the line, and clearly demonstrate that the gradient is always 
constant.

Your screen should look something like this:

	 Teacher:	 And just before we move on, what is the equation of the blue line?

	 Prompt:	 Where does the line cross the y-axis?

	Ideal Response:	 y = 3x + 10

Activity 2: The Gradient Function of a Quadrat-
ic

Go to Edit in the top tool bar, then Select All, and then press Delete on the 
keyboard.

Both lines and all sets of scribbles should now have disappeared, leaving you 
with the set of axes again.

	 Teacher:	 Can somebody quickly describe what the graph of y = x² looks like?

Click on Slow Plot mode.

Enter the equation: y = x²
Note: To enter x², either use the little 2 button or press “xx”.
Click OK.

The curve should begin to appear on the screen.

Press Pause Plotting both to stop the process, or to resume it to focus on the 
key features of the graph.

Note: Pressing the spacebar on the keyboard has the same effect!

	 Teacher:	 What do you notice about the gradient of this curve, y = x²?

	 Prompt:	 Think about the slope of the line on the left-hand side of the graph, compared 
to the slope of the line on the right-hand side of the graph.

	Ideal Response:	 The gradient is always changing / As you move from the left-hand side of the 
graph to the right, the gradient goes from negative to positive / The gradient 
gets steeper from left to right from the origin.

Left-click on the curve (it should turn black).

Enter the point with an x value of 2.
This should display the point (2, 4) on the curve.

Select Text Box.
Change the word “Point” to “A” and click OK.
The point should now be labelled.

Your screen should look something like this:
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	 Teacher:	 Does anybody have any idea how we might work out, or at least get an approxi-
mation, the gradient of the curve at this particular point?

	 Prompt:	 Think about how we worked out the gradient of the straight line before.

Note: If, at this point, a student suggests drawing a tangent to the curve and 
working out the gradient of that line, explain that this is an excellent sugges-
tion, and indeed it is ultimately the correct answer, but the only problem is that 
it is hard to know exactly where to draw the tangent. You could even demon-
strate with a ruler or something else with a straight edge that you could quite 
reasonably argue several different locations for such a tangent. Explain that the 
method we are going to use actually tells us exactly where to draw that tangent 
and so takes all the guess work out of it!

	Ideal Response:	 Try drawing the right-angled triangles like before.

Make sure the curve is still selected (it should still be black).

Enter another point, this time with an x value of 3.
This should display the point (3, 9) on the curve.

Select Text Box.
Change the word “Point” to “B” and click OK.
Both points and their co-ordinates should now be labelled.

	 Teacher:	 Okay, if I was to draw a straight line between points A and B, what would be 
the gradient of the line?

	 Prompt:	 Picture the right-angled triangle in your mind / think about how much the y 
value has changed and how much the x value has changed.

	Ideal Response:	 5.

	 Teacher:	 Good, now to save us having to work out the gradient each time, I am going to 
let Autograph do it.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on points A and B to select them (they should both have squares 
around them).

Right-click and select Gradient from the menu.
This should create a right-angled triangle between the two points.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the right-angle triangle (it should turn black).
From the top menu click on View, and then Status Box.
A Status Box containing important information about the straight line con-
necting those two points should now be displayed.
Note: The Status Box only displays information about objects which are cur-
rently selected. If the information ever disappears, just left-click to select the 
object in question again.

Your screen should look something like this:

	 Teacher:	 Okay, just to explain what information this Status Box is showing: 

Δy means how much the y value has changed going from Point A to Point B.
Δx means how much the x value has changed going from Point A to Point B.
The first number is the gradient of this line, which is derived from dividing the 
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change in the y value by the change in the x value.
So, the good news is that Autograph agrees with our calculation for the gradi-
ent of the line between A and B.

	 Teacher:	 Now, whilst the line connecting A and B is a pretty good approximation of the 
gradient at the curve at Point A, it is not brilliant. As you can see, if we zoom in 
a bit closer, there is quite a big gap between the curve and the line.

Use the Drag and Zoom In functions to get a closer look at what is going on. 
Notice how the scale automatically adjusts the closer in we get.

Your screen should look something like this:

 Use the Drag and Zoom Out functions to return to the original view of the 
graph.

Note: Pressing the Undo button several times is often a quicker way of doing 
this.

	 Teacher:	 Can anybody think of a way in which we could improve our approximation of 
the gradient of the curve at Point A?

	 Prompt:	 Remember, we want the gradient at Point A. Point B is quite a long way away…

	Ideal Response:	 Move point B closer!

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click to select Point B (it should have a little square around it).

Select Animation from the top toolbar.

You can now control the position of Point B with the left-right arrows.
Set the value of the step to 0.1.
The Status Box keeps a record of the current x and y values of Point B and the 
value of the gradient.

Note: A nice shortcut is to use the arrow keys on the keyboard. The left-right 
control to position of point B, and the up-down control the size of the step

Move Point B closer and closer to Point A.
Note: You may have to adjust to position of the text boxes to stop them getting 
in the way.

Draw the students’ attention to the value of the gradient.
Stop when point B has an x value of 2.1.

	 Teacher:	 What do you think will happen to the value of the gradient if I move Point B 
right on top of Point A?

	 Prompt:	 Think about how we work out the value of the gradient. What will the change 
in y and the change in x be now? What happens when you divide by zero?

	Ideal Response:	 The gradient is undetermined / incalculable / infinite / doesn’t make sense.

	 Teacher:	 So, how can we keep improving our approximation to the gradient of the curve 
at Point A without the gradient becoming undefined?

	Ideal Response:	 Make the step size smaller.

Adjust the size of the step to 0.01.

Use the Drag and Zoom In functions to get a closer look at what is going on. 
Notice how the scale is adjusting as the numbers we are dealing with get small-
er and smaller.
Note: The text boxes containing the co-ordinates of Points A and B will disap-
pear, but the Animation Controller and the information contained in the Status 
Box will remain visible no matter how much you zoom in.

Continue adjusting the step and zooming in.
Really emphasise the scale on the axes, so the students appreciate just how 
small these distances really are.

Your screen should look something like this:
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	 Teacher:	 We are now working out the gradient between two points which are an incred-
ibly small distance apart. Point B is now incredibly close to Point A, but cru-
cially it is not quite at Point A. The closer we get, the better the approximation 
of the gradient at Point A. Of course, we could keep going closer and closer, but 
what number does the value of the gradient seem to be approaching?

	Ideal Response:	 4!

	 Teacher:	 Yes, and in fact it is possible to show, by using a technique that follows directly 
on from what we have been doing here, that the gradient of the curve y = x² 
at the point where x = 2 is exactly equal to 4. This technique is the foundation 
upon which many incredibly important areas of maths are built upon. All we 
need to do is to imagine that the distance between the x values of Point A and 
Point B is as small a number as we can imagine, and we can call that number 
h…

Ideas for Further Work	  

This demonstration naturally lends itself to be followed up by a dem-•	
onstration of Differentiation from First Principles. In fact, the necessary 
right-angled triangle is already on the screen, and so you could use the 
scribble function to label the base of the triangle “h”, Point A as (2, 2), 
Point B as (2 + h, (2 + h)2) and so on.

Another nice way of doing this demonstration on Autograph is to define •	
f(x) to be whatever you like, and then plot y = ​ 

f(x + h) − f(x)
 ___________ h  ​. Decreasing the 

value of h from here has the same effect.

Alternatively, you could skip this step and just explain that differentiation •	
is a way to reduce the distance between the points to as small as it could 
be, and then teach the students the rules of differentiation from there.

Student Investigation S5 in the sister textbook is also a nice follow-up to •	
this introductory work.
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T5
Teacher
Demonstration

Discovering the Gradient Function
of Trigonometric Functions

Learning Objectives	

To re-enforce the concept of the •	 Gradient Function.

To understand how the gradient functions of trigonometric functions can •	
be derived by inspection and by plotting the gradient of tangents.

To interactively find the gradient functions of •	 y = sin(x), y = cos(x) and y = 
tan(x), and work out their equations.

Required Pre-Knowledge	

To know the shape of the trigonometric functions: •	 y = sin(x), y = cos(x) 
and y = tan(x).

To be comfortable working in radians.•	

To understand the concept of a tangent.•	

To be comfortable with the concept of the gradient function and its role •	
in differentiation.

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

For this activity, you will need three identical 2D Graph Pages, each set up as 
follows:

Page - 1:

Select Whiteboard Mode.

Ensure you are working in Radians.

Edit the axes as follows:
x:	 Minimum:	 −4π	 Maximum:	 4π	 Numbers:	 π	 Pips:	 π/3
y:	 Minimum:	 −3	 Maximum:	 3	 Numbers:	 1	 Pips:	 0.5

Note: To enter the π symbol, press “Alt p” at the same time or type “pi”.
Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you.

Still in the Edit Axes menu:
Click on the Appearance tab.
Open the drop-down menu underneath Themes.

Select Graph Paper.
Click OK.

From the Axes menu on the very top toolbar, select Show Key.

This should make the Key disappear.

Open another two blank 2D Graph Pages (Page - 2 and Page - 3) and repeat 
the set-up instructions.

Your three pages should each look something like this:

Your three pages are now available as Tabs on the top of the screen and can be 
accessed any time by simply left-clicking on them.

Step-by-Step Instructions	

Activity 1: y = sin(x)

Open Page - 1 by clicking the Tab.

Note: If you wish to re-name this or any other page, simply click on Page > Edit 
Settings and write in a name of your choice.

	 Teacher:	 Okay, to warm you up, can anybody come to the front and do a quick sketch of 
y = sin(x).

	 Prompt:	 Notice we are working in Radians. Does the graph go through the origin? What 
is the period of the graph? What is the amplitude? Where does it cross the 
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axes?

Encourage students to come to the front to sketch their curves using the Scrib-
ble Tool.

Use the Erase tool to rub out any mistakes

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph area itself and select 
Delete Objects from the menu).

When you are ready:

Click on Slow Plot mode.

Enter the equation: y = sin(x)

The curve should begin to be drawn on the screen.

Press Pause Plotting both to stop the process and to resume it to focus on the 
key features of the graph.

Note: The Spacebar can also be used to serve this function.

	 Teacher:	 Okay, so how would we go about finding the Gradient Function of y = sin(x)? 

	 Prompt:	 What does the gradient function mean? How can drawing lots of tangents help 
us come up with the Gradient Function?  

	Ideal Response:	 The Gradient Function is just the gradient of the tangent to the curve at each 
point along the curve. So, if we could draw tangents at lots of different points 
along the curve and plot their gradients, then we could gradually build up the 
gradient function of y = sin(x).

	 Teacher:	 Good. Now, before we start, can anybody picture in their minds what kind of 
shape the gradient function of y = sin(x) will take?

Give the students a few minutes to think about this and discuss it, before mov-
ing on.

Left-click on the curve (it should turn black).

Enter a point on the curve with x co-ordinate 0.

The point (0, 0) should now appear on the curve.

Click on Text Box.
Change the word “Point” to “A” and click OK.

The co-ordinates of point A should now be displayed.

This will allow us to keep an eye on the x value of our point.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on point A (it should have a square around it).

Right-click and select Tangent from the menu.

A tangent to the curve at point A should now be displayed.

	 Teacher:	 Looking at the tangent, can anybody have a guess at its equation?

	 Prompt:	 What points does it go through? What is its gradient?  

	Ideal Response:	 y = x.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the tangent (it should turn black).

Click on Text Box.
Click OK.

The equation of the tangent should now be displayed.

Your page should look something like this:

	 Teacher:	 What is the gradient of y = sin(x) at the point (0, 0), and how can you tell from 
the equation of the tangent?

	Ideal Response:	 The gradient is 1, because the co-efficient in front of the x in the equation of the 
tangent is 1.

	 Teacher:	 Good, so when x = 0, the gradient is also equal to 1, so I can place a point on 
my curve at (0, 1).
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Use the Scribble tool to mark the point on the graph.

	 Teacher:	 Okay, so now I need two volunteers to come to the front and help us discover 
the Gradient Function of y = sin(x). One of you will be in charge of moving the 
position of point A, and the other will be in change of plotting the gradient.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on point A (it should have a square around it).

Open the Animation Controller.

	 Teacher:	 Now, just before we start, how many points shall we plot, and which ones in 
particular shall we plot?

	 Prompt:	 Which points are important to ensure we get the shape of our gradient func-
tions?  

	Ideal Response:	 Perhaps take the points at regular intervals, maybe every π/3. But we must also 
make sure we take the gradient at each turning point as this will be important 
in determining the shape of our gradient function.

	 Teacher:	 Excellent. So, off you go…

Step-by-Step Instructions	

The first student can use the left-right buttons on the Animation Controller to 
move Point A along the curve.

They can adjust the step to whatever they like, remembering that pressing “alt 
p” together, or typing “pi” will give them the π symbol.

Alternatively, the left-right buttons on the keyboard can be used to move point 
A along the curve, and the up-down buttons to adjust the size of the step.

Each time a chosen point is reached, the second student can use the Scribble 
tool to mark the gradient of the tangent (from the equation of the tangent), 
against the x value of the point (from the co-ordinates of point A).

Use the Erase tool to rub out any mistakes.

Note: It may be necessary to adjust the position of the Text Boxes if they get in 
the way.

Your screen should look something like this:

Note: If the students spot that the function repeats, encourage them to use this 
to quickly finish off their sketch and just use the tangent function to check the 
gradient at key points.

	 Teacher:	 Does anybody recognise the Gradient Function?

	 Prompt:	 Look at where it crosses the axes, look at the turning points, look at the period 
and amplitude.  

	Ideal Response:	 It’s y = cos(x)!

	 Teacher:	 Sounds good, but let’s just check that…

Make sure Slow Plot mode is still on.

Enter the equation: y = cos(x)

The curve should begin to be drawn on the screen, hopefully going through the 
students’ points.

Press Pause Plotting (or the Spacebar on the keyboard) both to stop the proc-
ess and to resume it to focus on the key features of the graph.

Your screen should look something like this:
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	 Teacher:	 So, the Gradient Function of y = sin(x) is y = cos(x). I wonder what the gradient 
function of y = cos(x) is…

Activity 2: y = cos(x)

Open Page - 2 by clicking on the Tab.

	 Teacher:	 Now, we have just seen what the graph of y = cos(x) looks like, so let me just 
quickly plot it again on this fresh page.

Make sure Slow Plot mode is still on.

Enter the equation: y = cos(x)

The curve should begin to be drawn on the screen.

	 Teacher:	 Now, just before we use the same technique as before, can anybody picture in 
their minds what the Gradient Function of y = cos(x) would look like and have 
a go at telling us the equation?

Note: Even if a student does get the equation correct, it is still worth using the 
tangent function to quickly plot a few points as before to build up the Gradient 
Function.

Repeat the instructions above, which are briefly re-capped here:

Left-click on the curve (it should turn black).

Enter a point on the curve with x co-ordinate 0, which should give the point (0, 
1).

Click on Text Box.
Change the word “Point” to “B” to label the point.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on point B (it should have a square around it).

Right-click and select Tangent from the menu.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the tangent (it should turn black).

Click on Text Box to display the equation of the tangent.

Use the Animation Controller or the left-right arrow buttons on the key-
board to adjust the position of B.

Record the gradients at each point using the Scribble tool.

Note: With the Gradient Function of y = cos(x), it is especially important that 
the students find the turning points, i.e. the points where the gradient of y = 
cos(x) is 1 and −1. 

	 Teacher:	 Does anybody recognise the Gradient Function?

	 Prompt:	 Look at where it crosses the axes, look at the turning points, look at the period 
and amplitude. Is it just y = sin(x), or is it something slightly different? 

	Ideal Response:	 It’s y = −sin(x)!

	 Teacher:	 Again, that sounds good, but let’s just check…

Make sure Slow Plot mode is still on.

Enter the equation: y = −sin(x)

The curve should begin to be drawn on the screen, hopefully going through the 
student’s points.

Press Pause Plotting (or the Spacebar on the keyboard) both to stop the proc-
ess, and to resume it to focus on the key features of the graph.

Your screen should look something like this:
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	 Teacher:	 So, the Gradient Function of y = cos(x) is y = −sin(x). This leaves one question: 
what on earth is the Gradient Function of y = tan(x)?

Activity 3: y = tan(x)

Open Page - 3 by clicking the Tab.

	 Teacher:	 Now, the graph of y = tan(x) is incredibly tricky to draw. Is anybody feeling 
brave enough to come to the board and give it a go?

	 Prompt:	 At what points does the graph cross the x-axis? At what points is the graph 
undefined / have asymptotes?

Encourage students to come to the front to sketch their curves.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph area and select De-
lete Objects from the menu).

When you are ready:

Ensure Slow Plot mode is turned on.

Enter the equation: y = tan(x)

Your page should look something like this:

	 Teacher:	 Okay, now just to warn you, the Gradient Function is not a function that you 
will be very familiar with. But, looking at the graph of y = tan(x), can anybody 
tell me anything about the gradient function?

	 Prompt:	 Think about the gradient of y = tan(x). Is it ever negative? What does this mean 
about the location of the Gradient Function? What is the gradient at the as-
ymptotes? What is the gradient of the graph when it crosses the x-axis? What is 
happening to the gradient either side of the x-axis?

	Ideal Response:	 The gradient of y = tan(x) is always positive, so the Gradient Function will al-
ways lie above the x-axis. The gradient at the asymptotes is infinite / undefined. 
The gradient of the curve when it crosses the x-axis is equal to 1, and either side 
of this the gradient is steeper. This means there must be a series of minimum 
points on the Gradient Function with a y value of 1.

Again, encourage students to come to the front to sketch their curves using 
the Scribble Tool. Encourage them to mark on the points that they know, and 
build it up from there.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph area itself and select 
Delete Objects from the menu).

	 Teacher:	 Okay, let’s try using our tangents again.

This proceeds like the method above, an is briefly re-capped here:

Left-click on the curve (it should turn black).
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Enter a point on the curve with x co-ordinate 0, which should give the point (0, 
0).

Click on Text Box.
Change the word “Point” to “C” to label the point.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on point C (it should have a square around it).

Right-click and select Tangent from the menu.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the tangent (it should turn black).

Click on Text Box to display the equation of the tangent.

Use the Animation Controller or the left-right arrow buttons on the key-
board to adjust the position of C.

Record the gradients at each point using the Scribble tool.

Note: With the graph of y = tan(x), it is worth paying special attention to the 
gradient as the curve approaches the asymptotes and as it crosses the x-axis. 
Also, many of the gradients are too large to plot on the graph, so encourage 
the students to reduce the size of the step and to concentrate on points around 
where the curve crosses the x-axis.

	 Teacher:	 Well, we can notice the pattern, but the function itself appears a very strange 
one. Let’s use a special function on Autograph to have a better look at it.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the curve (it should turn black).

Select Gradient Function from the toolbar at the top and click OK.

The Gradient Function should begin to be drawn on the screen, hopefully go-
ing through the student’s points.

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph.

Your screen should look something like this:

	 Teacher:	 And the name of the Gradient Function of y = tan(x) is… y = sec²(x).

Ideas for Further Work	

If you have covered the Quotient Rule, it might be nice to derive the •	 Gra-
dient Function for y = tan(x) by expressing tan(x) as ​ sin(x)

 _____ 
cos(x)

 ​.

Using the •	 Chain Rule for trigonometric functions also follows directly on 
from this activity. See Teacher Demonstration T6: The Chain Rule.
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T6
Teacher
Demonstration Discovering the Chain Rule

Learning Objectives	

To obtain a graphical representation of how the chain rule works using •	
the function y = sin(bx + c).

To be able to apply this representation to find the gradient functions of •	
functions in the form y = acos(bx + c), including fraction and negative 
values for the constants.

To reinforce the transformations of trigonometric functions that result •	
from adjusting the values of the constants

Required Pre-Knowledge	

To know the shape of the trigonometric functions: •	 y = sin(x) and y = 
cos(x).

To know the gradient functions of •	 y = sin(x) and y = cos(x) – See Teacher 
Demonstration T5: Discovering the Gradient Functions of Trigonometric 
Functions.

To be comfortable working in radians.•	

To understand the concepts of tangents and gradient.•	

To understand recognise transformations in the form •	 f(x – c) and af(x).

To be comfortable with the concept of the gradient function and its role •	
in differentiation.

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

For this activity, you will need to set up two pages as follows:

Page - 1:

Select Whiteboard Mode.

Ensure you are working in Radians.

Edit the axes as follows:
x:	 Minimum:	 −4π	 Maximum:	 4π	 Numbers:	 π	 Pips:	 π/3
y:	 Minimum:	 −4	 Maximum:	 4	 Numbers:	 1	 Pips:	 0.5

Note: To enter the π symbol, press “alt p” at the same time, or type “pi”. 
Remove all of the green ticks underneath Auto.

Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

Still in the Edit Axes menu:
Click on the Appearance tab.
Open the drop-down menu underneath Themes.
Select Graph Paper.
Click OK.

From the Axes menu on the very top toolbar, select Show Key.

This should make the key disappear.

Your screen should look something like this:

Page - 2:

Open another blank 2D Graph Page.

Ensure you are working in Radians.

Edit the axes as follows:
x:	 Minimum:	 −4π	 Maximum:	 4π	 Numbers:	 π	 Pips:	 π/3
y:	 Minimum:	 −8	 Maximum:	 8	 Numbers:	 1	 Pips:	 1

Remove all of the green ticks underneath Auto.

Still in the Edit Axes menu:
Click on the Appearance tab.
Open the drop-down menu underneath Themes.
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Select Graph Paper.
Click OK.

From the Axes menu on the very top toolbar, select Show Key.

This should make the Key at the bottom of the page disappear.

Enter the equation: y = acos(bx − c)
Still in the Add Equation box, click on Edit Constants.
Set the values for the constants as follows: a = 1, b = 1 and c = 0.
Click OK twice.

The graph of y = cos(x) should now appear on the screen.

Left-click on the curve to select it (it should turn black).

Click on Text Box.
Change the words “Equation 1” to “Function”.
Tick the box next to Show Detailed Object Text.
Click OK.

The equation of the function, along with the current values of a, b and c should 
now be displayed.

Your screen should look something like this:

The two pages are now available as Tabs on the top of the screen and can be ac-
cessed any time by simply clicking on them. 

We will use Page - 2 later on in this demonstration.

Step-by-Step Instructions	

Activity 1: Visualising the Chain Rule

Open Page - 1 by clicking on the Tab near the top of the screen.

	 Teacher:	 Okay, to warm you up, can anybody come to the front and mark on a few key 
points that the graph of y = sin(x) would go through.

	 Prompt:	 Notice we are working in Radians. Does the graph go through the origin? What 
is the period of the graph? What is the amplitude? Where does it cross the 
axes?

Encourage students to come to the front to mark on their points using the 
Scribble Tool.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph itself and select De-
lete Objects from the menu).

When you are ready:

Click on Slow Plot mode.

Enter the equation: y = sin(bx − c)

	 Teacher:	 If I wanted to draw the graph of y = sin(x), what would the value of constants b 
and c need to be?

	Ideal Response:	 b = 1 and c = 0.

Still in the Add Equation box, click on Edit Constants.
Set the values: b = 1, c = 0.
Click OK twice.

The curve should begin to be drawn on the screen, hopefully going through the 
students’ points.

Press Pause Plotting both to stop the process and to resume it to focus on the 
key features of the graph.

Note: The Spacebar can also be used to serve this function.

	 Teacher:	 Now I am just going to label the equation of this curve so we can keep an eye 
on it.

Left-click on the curve (it should turn black).

Click on Text Box.
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Change the words “Equation 1” to “Function”.
Tick the box next to Show Detailed Object Text.
Click OK.

The equation of the function, along with the current values of b and c should 
now be displayed.

Click on the Constant Controller.
The drop-down menu allows you to select each constant.
The up-down buttons adjust the value of the constant.
The left-right buttons adjust the value of the step.

	 Teacher:	 What would happen to the shape and position of this graph if I started increas-
ing the value of b?

	 Prompt:	 What effect does the constant b have on the graph? Think back to your work on 
Transformations. Imagine I increased the value of b to 2, what equation would I 
have then? What would the graph of that equation look like?  

	Ideal Response:	 Increasing the value of b increases the frequency of the graph, and reduces the 
period. If you increased the value of b to 2, the graph would complete a cycle 
every π radians instead of every 2π radians. The x values of all the axes crossing 
points, maximums and minimums would all be halved. The graph would be-
come more squashed from the left and right!

Use the up-down buttons to confirm the students’ answers, showing values of b 
between 0 and 1 as well as greater than 1.

Your screen should look something like this:

When ready, return the value of b back to 1.

	 Teacher:	 Good. Now, can anybody remember what the Gradient Function of y = sin(x) 
looks like?

	 Prompt:	 Remember the work we did on the Gradient Function. What does the Gra-
dient Function actually mean? What is the Gradient Function of y = sin(x)? 
When we differentiate y = sin(x), what do we get?

	Ideal Response:	 y = cos(x)

	 Teacher:	 Good. Now, let’s add the Gradient Function to our graph.

Ensure Slow Plot mode is still turned on.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the graph of y = sin(bx − c) (it should turn black). 

Select Gradient Function from the toolbar at the top.

Click OK.

The Gradient Function, y = cos(x), should now begin to be drawn on the 
graph.

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph.

Note: The plot will automatically stop at maximum and minimums as well as 
intersections with the x-axis.

Your screen should look something like this:
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	 Teacher:	 Now comes the tricky part. What will happen to the Gradient Function of y = 
sin(bx + c) when I increase the value of b?

	 Prompt:	 Think about what happened to the function itself. How is the gradient of the 
function at each x value affected as the graph becomes more “squashed”? How 
will this affect the graph of the Gradient Function? Again, thinking about the 
graph when b = 2 might help you. Think about the frequency of the Gradient 
Function. Think about the amplitude of the Gradient Function. 

	Ideal Response:	 The frequency of the Gradient Function will increase to match the function 
itself. However, because the frequency has increased, the curve itself is steeper 
at any given x value. For example, when b = 2, the graph is twice as steep, and 
so the maximum value of the gradient also doubles, meaning the amplitude of 
the graph of the gradient function increases to 2, so the entire graph now lies 
between the values of y = 2 and y = −2.

	 Teacher:	 Good. Now, let’s watch that in action…

Use the up-down buttons to confirm the students’ answers.

Pay particular attention to the case when b = 2 as this perhaps illustrates the 
concept most clearly.

Point out that as the frequency increases, the function gets stepper and steeper 
at each x value (apart from the turning points), and hence the value of the gra-
dient at each point also increases, thus increasing the amplitude of the Gradi-
ent Function.

Again, showing values of b between 0 and 1, paying particular attention to 

when b = 0.5 illustrates this concept strongly.

Your screen should look something like this:

	 Teacher:	 So, if the equation of our function is y = sin(2x), what is the equation of our 
Gradient Function?

	Ideal Response:	 y = 2cos(2x)

	 Teacher:	 And if the equation of our function is y = sin(0.5x), the equation of our Gradi-
ent Function is…

	Ideal Response:	 y = 0.5cos(0.5x)

	 Teacher:	 And how about if the equation of our function is y = sin(bx)? What is the equa-
tion of our Gradient Function now?

	Ideal Response:	 y = bcos(bx)

Give the students a few minutes to think about this and discuss it, before mov-
ing on.

Return the value of b back to 1.

	 Teacher:	 Now comes the really tricky part. I am now going to change the value of c. How 
will that affect the graph of our original function, and also the graph of our 
Gradient Function?

	 Prompt:	 Think about what effect subtracting the c would have on the function itself. 
Think back to the work we did on Transformations. f(x − c). What type of a 
transformation is that? What happens to the graph of the function? How does 
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this affect the gradient of our original function? So, how will it affect the graph 
of the Gradient Function?

	Ideal Response:	 The effect of subtracting the constant c is to translate the graph by c units. This 
will mean that the gradient at any given x value along the curve is now differ-
ent, and so the Gradient Function is also translated by c units in the same 
direction. Crucially, the upper and lower limits for the gradient do not change 
during the translation, and so the amplitude of the Gradient Function remains 
the same. 

	 Teacher:	 Good. Now, let’s watch that in action…

Select c from the drop-down menu on the Constant Controller.

Type in “pi/3” in the step box to adjust the value of c in steps of ​ π __ 
3
 ​.

Use the up-down buttons to confirm the students’ answers.

Point out that as the original function is translated, given gradients are just 
shifted along from one x value to another. This is probably most clearly ob-
served at the maximum and minimum points. As the gradients themselves are 
being shifted, so too is the Gradient Function as a whole. 

Because the upper and lower limits of the gradient remain the same, so does 
the amplitude of the Gradient Function.

Your screen should look something like this:

	 Teacher:	 So, if the equation of our function is y = sin(x − π), what is the equation of our 
Gradient Function?

	Ideal Response:	 y = cos(x − π)

	 Teacher:	 And if the equation of our function is y = sin(x + 2π), the equation of our Gra-
dient Function is…

	Ideal Response:	 y = cos(x + 2π)

	 Teacher:	 And how about if the equation of our function is y = sin(x − c)? What is the 
equation of our Gradient Function now?

	Ideal Response:	 y = cos(x – c)

Give the students a few minutes to think about this and discuss it, before mov-
ing on.

Return the value of c back to 0.

	 Teacher:	 Okay, prediction time. I am going to adjust the value of the constants so I get 
the equation: y = sin(2x – π). What will be the equation of the Gradient Func-
tion?

	 Prompt:	 Think about what specific effect the 2 has on the Gradient Function. Think 
about what effect the π has. Put this altogether!

	Ideal Response:	 The Gradient Function of y = sin(2x – π) is  y = 2cos(2x – π).

Checking the answer:
Adjust the values of the constants so that: b = 2, c = π.

To really reinforce this to the students, plot the equation:

Ensure Slow Plot mode is still on.

Enter the equation: y = 2cos(2x − π)

The equation will be plotted on top of the gradient function.

Clicking Undo is the easiest way to clear this equation, ready for another exam-
ple.

It is up to you and the needs of the class how many examples like this you try.

Continue doing examples until the students are able to generalise the rule as 
follows:

	 Teacher:	 And how about if the equation of our function is y = sin(bx − c)? What is the 
equation of our Gradient Function now?

	Ideal Response:	 y = bcos(bx – c)

	 Teacher:	 And now let’s really put you to the test…

Activity 2: Testing and Extending with acos(bx – c)
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Open Page - 2 by clicking on the Tab.

Close the Constant Controller.

	 Teacher:	 Here is the curve of y = acos(bx + c), with the values set as shown in the Text 
Box, so at the moment we simply have the graph of y = cos(x). First task, can 
somebody just remind us what the Gradient Function of y = cos(x) is?

	 Prompt:	 Is it just y = sin(x), or is it something slightly different? Think about the gradient 
at each point, and decide if it is increasing or decreasing.

	Ideal Response:	 y = −sin(x)

	 Teacher:	 Good. Let’s have a look at that…

Ensure Slow Plot mode is still on.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the graph of y = acos(bx − c) (it should turn black). 

Select Gradient Function from the toolbar at the top.

Click OK.

The Gradient Function, y = −sin(x), should now begin to be drawn on the 
graph.

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph.

Your screen should look something like this:

	 Teacher:	 So, now I am going to give you a selection of functions, and I want you to use 
the work we have just done to predict the equation of the Gradient Function 
each time. 

So, your first function is: y = cos(3x − 2π/3).

	Ideal Response:	 y = −3sin(3x − 2π/3)

Checking the answer:

Click on the Constant Controller.

Adjust the values of the constants using the left-right buttons so that: a = 1, b = 
3 and c = 2π/3.

Note: Again, you will need to alter the size of the step for c to “pi/3”

To really reinforce this to the students, plot the equation:

Ensure Slow Plot mode is still on.

Enter the equation: y = −3sin(3x − 2π/3)

The equation will be plotted on top of the gradient function.

Your page should look something like this:
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Clicking Undo is the easiest way to clear this equation ready for another exam-
ple.

Again, it is up to you how many of these examples you give the class. Here is a 
brief list, which is intended to follow a natural progression towards the most 
difficult of examples:

List of possible examples:

y = cos(−4x + π)

y = 2cos(3x − π) 

y = −8cos(0.5x − 2π)

y = −4cos(−2x + π/3)

Alternatively, the students themselves could suggest the values of the constants 
and challenge each other to work out the equation of the Gradient Function.

By the end of the demonstration, the students should be able to answer the fol-
lowing:

	 Teacher:	 If the equation of our function is y = acos(bx − c), what is the equation of our 
Gradient Function?

	Ideal Response:	 y = −absin(bx − c)

Ideas for Further Work	

Following on from this activity it might be nice to use Autograph in a •	
similar way to find the Gradient Functions of other trigonometric func-
tions such as y = asin(bx² + cx + d).

Alternatively, you could show the students the general form of the chain •	
rule.

The chain rule could then be applied to differentiate functions such as: •	 y = 
(3x – 2)³, and y = 5²⁺¹.
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T7
Teacher
Demonstration

Discovering the Reciprocal
Functions

Learning Objectives	

To interactively discover the shape and the key features of the following •	
reciprocal functions: y = sec(θ), y = cosec(θ) and y = cot(θ).

To use knowledge of transformations to illustrate the link between the •	
graphs of y = cos(θ) and y = sin(θ).

To interactively identify the key features of functions in order to deter-•	
mine their shape.

Required Pre-Knowledge	

To know the shape and key points of the trigonometric functions: •	 y = 
sin(θ), y = cos(θ) and y = tan(θ).

To understand the concept of an asymptote and undefined regions on •	
graphs, and how they relate to the shape of the function.

To be aware of transformations in the form •	 f(x – a).

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

Select Whiteboard Mode.

Ensure you are working in Degrees.

Note: This demonstration could be carried out exactly the same way but work-
ing in Radians by adjusting the axes accordingly.

Edit the axes as follows:
x:	 Minimum:	 −540	 Maximum:	 540	 Numbers:	 90	 Pips:	 30
y:	 Minimum:	 −4	 Maximum:	 4	 Numbers:	 1	 Pips:	 0.5

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

Still in the Edit Axes menu:
Click on the Labels tab.
Change the x under Variable and the x under Label to θ.
Note: To enter θ press “alt t” together and then click OK twice.

From the Axes menu on the very top toolbar, untick Show Key.

This should make the Key disappear.

Your screen should look something like this:

Step-by-Step Instructions	

Activity 1: y = sec(θ)

	 Teacher:	 Okay, to warm you up, can anybody come to the front and do a quick sketch of 
y = cos(x). 

	 Prompt:	 Notice we are working in Degrees. Does the graph go through the origin? 
What is the period of the graph? What is the amplitude? At what values of 
theta does the graph reach its maximum and minimum points? Where does it 
cross the axes?

Encourage students to come to the front to sketch their curves using the Scrib-
ble Tool, possibly marking key points on first before attempting to join them 
up.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph area itself and select 
Delete Objects from the menu).

When you are ready:

Click on Slow Plot mode.
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Enter the equation: y = cos(θ)
Note: To enter θ, again you can press “alt t” together, or just use the little theta 
button.

Note: It is not necessary to use the brackets when entering trigonometric equa-
tions in Autograph. The above equation could simply be entered as y = cosθ if 
you prefer.

The curve should begin to be drawn on the screen.

 Press Pause Plotting both to stop the process and to resume it to focus on the 
key features of the graph.

Note: The Spacebar can also be used to serve this function.

When ready, clear all scribbles from the screen as described above.

Your screen should look like this:

	 Teacher:	 Okay, what I want to do is to build up a picture of the graph y = ​  1
 _____ cos(θ) ​, and I 

want to do it by thinking of some points which we know definitely lie on the 
graph, and then trying to build up it’s shape from there. Can anybody think of a 
few nice points which would lie on the graph?

	 Prompt:	 What about at the maximum and minimum points? What would be the value 
of y = ​  1

 _____ cos(θ) ​ when, say, θ = 0, or θ = 180?

	Ideal Response:	 Whenever the value of y = cos(θ) is 1 or −1, so too is the value of y = ​  1
 _____ cos(θ) ​, so 

we can mark points on when θ = −540, −360, −180, 0, 180, 360, 540.

Encourage students to come to the front to mark on these points.

Use the Erase tool to rub out any mistakes.

	 Teacher:	 Good. And looking at the graph of y = cos(θ), are there any points on the curve 
y = ​  1

 _____ cos(θ) ​ that might cause us problems when plotting?

	 Prompt:	 Remember, we have to do one divided by the value of y = cos(θ) to get the value 
of y = ​  1

 _____ cos(θ) ​. Which y values of y = cos(θ) will give us problems? Where will 
there be any asymptotes on the graph? Where will the graph be undefined?

	Ideal Response:	 Whenever the value of y = cos(θ) is 0, the graph is undefined / has an asymp-
tote, because we cannot divide things by zero. So, there are asymptotes at  θ = 
−450, −270, −90, 90, 270, 450.

	 Teacher:	 Good. Now, just to help us visualise that, I am going to draw on those vertical 
asymptotes with dashed lines… But because there are quite a few to draw, I am 
going to use a little short cut. What is the equation of the first asymptote on 
our screen (from the left)?

	Ideal Response:	 θ = −450

	 Teacher:	 Good. Now, I am going to enter the equation θ = a, and define the constant a to 
be −450.

Turn off Slow Plot mode.

Enter the equation: θ = a
Still in the Add Equation screen, click on Edit Constants.
Change the value of constant a from 1 to −450 and click OK.
Still in the Add Equation screen, click on Draw Options.
Select a dashed line from the drop-down menu, and click OK twice.

The line θ = −450 should now be on your screen.

Click on the Constant Controller.
Click on Options, and select Family Plot.

	 Teacher:	 Now, if we want to tell Autograph to draw in all the asymptotes, what param-
eters do we need to enter here?

	 Prompt:	 What is the largest value of theta we need? What is the size of the interval be-
tween each asymptote?

	Ideal Response:	 Start:	 −450	 Finish:	 450	 Step:	 180

Enter in those values and click OK.

Close the Constant Controller.

Your screen should look something like this:
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	 Teacher:	 Okay, so we know a few points which the graph passes through, and we know 
where the asymptotes are, so now the only question is what is happening 
between the asymptotes? Does anybody have any ideas what shape the graph 
takes?

	 Prompt:	 Think about what is happening to the value of y in y = cos(θ). What does that 
mean for the value of y in y = ​  1

 _____ cos(θ) ​.

	Ideal Response:	 Between the asymptotes, the value of y is always between −1 and 1. This means 
that when we do 1 divided by this value, the value will always be bigger than 
one. So, the graph must form U shapes for the maximums of y = cos(θ), and 
upside down U shapes for the minimums.

	 Teacher:	 Good. Let’s see if we can get Autograph to help us plot some of those points to 
make things a little clearer. I’m going to plot a point with a theta value of b.

Enter a point with x co-ordinate b, but leave the y co-ordinate blank for a mo-
ment.

	 Teacher:	 Now, if θ takes a value of b, what would the y value be on the curve y = ​  1
 _____ cos(θ) ​?

	Ideal Response:	 y = ​  1
 _____ cos(b) ​

	 Teacher:	 Excellent. So, let’s plot that co-ordinate:

Enter y co-ordinate as 1/cos(b) and press OK.

Click on the Constant Controller.
The drop-down menu allows you to select each constant.
The up-down buttons adjust the value of the constant.

The left-right buttons adjust the value of the step.

Change the starting value to −540, and the step to 10.

A point should now be marked at (−540, −1), right on top of one of the earlier 
scribbles.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on this point (it should have a square around it).

Click on Text Box and click OK.

The co-ordinates of the point should now be displayed.

Make sure the point (and nothing else) is still selected.

Right-click and select Trace Point from the menu.

This will keep a record of the path of the point as it moves.

	 Teacher:	 Okay, so we are now going to see exactly what is going on between the asymp-
totes and see if it is as we predicted.

Use the left button to increase the value of θ.

The path of the point should be marked.

Draw the students’ attention to what happens to the point as cos(θ) gets smaller 
as you approach the asymptotes.

Continue right along the curve, pausing at the important points, going quicker 
as they students begin to notice the pattern.

Your screen should look something like this:
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Note: You may wish to briefly explain that the vertical lines created by the trace 
do not represent the asymptotes of the function, but are simply the computer’s 
attempts to join up points which should never really be joined up!

	 Teacher:	 And there you have it! The graph of y = ​  1
 _____ cos(θ) ​. But this graph has another 

name… y = sec(θ).

Close the Constant Controller.

Click on Slow Plot mode.

Enter the equation: y = sec(θ)

The graph should begin to plot over the top of the trace, making the curve 
much smoother.

Press Pause Plotting (or the Spacebar) both to stop the process, and to resume 
it to focus on the key features of the graph.

Your screen should look something like this:

Activity 2: y = cosec(θ)

	 Teacher:	 Now, of course, we could do exactly the same thing to find the graph of y 

= ​  1
 _____ sin(θ) ​, but I wonder if there is a quicker way… Can anybody tell me what is the 

relationship, in terms of transformations, between the graph of y = cos(θ) and y 
= sin(θ)?

	 Prompt:	 Look at the screen and try to picture where the graph of y = sin(θ) would go. 
How do you get from y = cos(θ) to y = sin(θ)? How do you describe this as a 
transformation?

	Ideal Response:	 sin(θ) = cos(θ − 90). The cos curve is translated 90 degrees to the right to give 
the sin curve.

Make sure Slow Plot mode is still on.

Enter the equation: y = sin(θ)

	 Teacher:	 So, how does this allow us to quickly figure out what the graph of y = ​  1
 _____ sin(θ) ​, 

looks like?

	 Prompt:	 Look at the shape of the sin curve and the cos curve. Think about how we built 
up the graph of y = ​  1

 _____ cos(θ) ​. Think about the asymptotes and the maximum and 
minimum points.

	Ideal Response:	 The graph of y = ​  1
 _____ sin(θ) ​ must also be translation of 90 degrees to the right from 

the graph of y = ​  1
 _____ cos(θ) ​.
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	 Teacher:	 Sounds good, but we better just check…

Click on Manage Equation List.

Left-click on the equation θ = a from the menu and click the red cross in the 
top corner and click OK.

Click on Edit > Select All Scribbles, and press delete on the keyboard (or 
Right-click on the graph area itself and select Delete Objects from the menu).

Note: Ignore the warning message. This is just to let you know that both the 
trace and the textbox are tied to the point, but we don’t need them any more 
anyway!

Your screen should now only contain the graphs of: y = cos(θ), y = sec(θ), and y 
= sin(θ).

Make sure Slow Plot mode is still on.

Enter the equation: y = 1/sin(θ)

The graph should now begin to plot.

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph.

Your screen should look something like this:

	 Teacher:	 And this function too has a special name… it is called y = cosec(θ).

Activity 3: y = cot(θ)

Click on Edit > Select All and press delete on the keyboard (or Right-click on 
the graph area itself and select Delete Objects from the menu).

This should clear the screen and leave you just with your set of axes.

	 Teacher:	 Now, of course, we are left with one question… what does the graph of y 

= ​  1
 _____ tan(θ) ​ look like? But before we do that, we need to know what the graph of y = 

tan(θ) looks like, so any ideas? Anyone brave enough to come up and sketch it?

	 Prompt:	 At what points does the graph cross the x-axis? At what points is the graph 
undefined / have asymptotes?

Encourage students to come to the front to sketch their curves.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph itself and select De-
lete Objects from the menu).

When you are ready:

Ensure Slow Plot mode is turned on.

Enter the equation: y = tan(x)

The graph should now begin to plot.

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph.

Delete all scribbles as described above

Your page should look something like this:
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	 Teacher:	 Now, thinking about how we derived the shape of the first couple of graphs, can 
anybody describe to us the shape of the graph of y = ​  1

 _____ tan(θ) ​? Can you come up 
and mark on any points?

	 Prompt:	 At what points is the graph undefined / have asymptotes? At what points do 
the two graphs intersect? Where does the graph cross the x-axis? Do the two 
graphs have a line of symmetry?

Encourage students to come to the front to sketch their curves.

Use the Erase tool to rub out any mistakes.

	Ideal Response:	 The graph of y = ​  1
 _____ tan(θ) ​ must have asymptotes when y = tan(x) is equal to 0. So, 

the asymptotes must be at θ = −540, −360, −180, 0, 180, 360, 540. The graphs 
must intersect whenever y = tan(x) is equal to 1. The graph of y = ​  1

 _____ tan(θ) ​ must 
have a value of zero when y = tan(x) is undefined, so it must cross the x-axis 
when θ = −450, −270, −90, 90, 270, 450. The two graphs have a vertical line of 
symmetry through their points of intersection at: θ = −495, −315, −135, 45, 225, 
405.

	 Teacher:	 Good. Now, let’s trace the co-ordinates of points that lie on the curve as we did 
before to build up a picture of it.

Enter a point with x co-ordinate c, and a y co-ordinate of 1/tan(c).

Click on the Constant Controller.

Change the starting value to −450, and the step to 10.

A point should now be marked at (−450, 0).

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the point (it should have a square around it)

Click on Text Box and click OK.

The co-ordinates of the point should now be displayed.

Make sure the point (and nothing else) is still selected.

Right-click and select Trace Point from the menu.

This will keep a record of the path of the point as it moves. 

Use the left button to increase the value of θ.

The path of the point should be marked, hopefully fitting the points marked on 
by the students.

Draw the students’ attention to what happens to the point as tan(θ) gets both 
bigger and smaller.

Your screen should look something like this:

	 Teacher:	 And there you have it! The graph of y = ​  1
 _____ tan(θ) ​. But this graph has another 

name… y = cot(θ).

Close the Constant Controller.
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Click on Slow Plot mode.

Enter the equation: y = cot(θ)

The graph should begin to plot over the top of the trace, making the curve 
much smoother.

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph.

Your screen should look something like this:

	 Teacher:	 And there you have it! We have managed to derive the shape of the tree trigo-
nometric reciprocal functions!

Ideas for Further Work	

Trigonometric Identities involving reciprocal functions. See Teacher •	
Demonstration T11: Trig Identities.

Solving equations involving the reciprocal functions.•	

Transformations involving the reciprocal functions.•	
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T8
Teacher
Demonstration

Investigating Trigonometric
Identities

Learning Objectives	

To get a graphical representation of the following two major trigonomet-•	
ric identities to deepen understanding of why they work:

sin(θ)/cos(θ) = tan(θ)

sin²(θ) + cos²(θ) = 1

To interactively identify the key features of the functions: •	 y = sin²(θ) and  
y = cos²(θ) in order to determine their shape.

Note: The methods shown in this demonstration can also be used to derive the 
following trigonometric identities:

tan²(θ) + 1 = sec²(θ)

cot²(θ) + 1 = cosec²(θ)

See Ideas for Further Work at the end of this demonstration for more informa-
tion.

Required Pre-Knowledge	

To know the shape of the trigonometric functions: •	 y = sin(θ), y = cos(θ) 
and y = tan(θ).

To understand the concept of an asymptote and undefined regions on •	
graphs, and how they relate to the shape.

Note: It not necessary that the students already know each of the identities 
beforehand. This demonstration could either be used as a way of reviewing and 
consolidating knowledge of the identities, or as a way of introducing them.

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

Select Whiteboard Mode.

Ensure you are working in Radians.

Note: This demonstration could be carried out exactly the same way but work-
ing in Degrees by adjusting the axes accordingly.

Edit the axes as follows:
x:	 Minimum:	 −4π	 Maximum:	 4π	 Numbers:	 π	 Pips:	 π/3
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If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph itself and select De-
lete Objects from the menu).

When you are ready:

Click on Slow Plot mode.

Enter the equation: y = sin(θ)
Note: To enter θ, again you can press “alt t” together, or just use the little theta 
button.

Note: It is not necessary to use the brackets when entering trigonometric equa-
tions in Autograph. The above equation could simply be entered as y = sinθ if 
you prefer.

The curve should begin to be drawn on the screen.

Press Pause Plotting both to stop the process and to resume it to focus on the 
key features of the graph.

Note: The Spacebar can also be used to serve this function.

	 Teacher:	 Good, and can somebody just remind us of the transformation that maps y = 
sin(θ) onto y = cos(θ)? 

	 Prompt:	 Think about the points on the graph that y = cos(θ) goes through. How does 
this relate to y = sin(θ)? What type of transformation is this? 

	Ideal Response:	 y = cos(θ) represents a translation of ​ π __ 
2
 ​ radians to the left from the graph of y = 

sin(θ). 

	 Teacher:	 Excellent. Now, let’s just add the graph of y = cos(θ) to our page…

Enter the equation: y = cos(θ)

The curve should begin to be drawn on the screen.

Delete any scribbles off the page as explained above.

When finished, your screen should look something like this:

y:	 Minimum:	 −4	 Maximum:	 4	 Numbers:	 1	 Pips:	 0.5
Note: To enter the π symbol, press “alt p” at the same time, or type “pi”. 
Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

Still in the Edit Axes menu:
Click on the Labels tab.
Change the x under Variable and the x under Label to θ and click OK twice.
Note: To enter θ press “alt t” together.

Your page should look something like this:

Step-by-Step Instructions	

Activity 1: sin(θ)/cos(θ) = tan(θ)

	 Teacher:	 Okay, to warm you up, can anybody come to the front and do a quick sketch of 
y = sin(θ). 

	 Prompt:	 Notice we are working in Radians. Does the graph go through the origin? What 
is the period of the graph? What is the amplitude? Where does it cross the 
axes?

Encourage students to come to the front to sketch their curves using the Scrib-
ble Tool.

Use the Erase tool to rub out any mistakes.
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(−4π, 0).

Click on the Constant Controller.
The up-down buttons adjust the value of the constant.
The left-right buttons adjust the value of the step.

Change the starting value to −4π, and the step to π/12.
Note: To enter the π symbol, just type “pi”. 

A point should now be marked at (−4π, 0).

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the point (it should have a square around it).

Click on Text Box and click OK.

The co-ordinates of the point should now be displayed.

Make sure the point (and nothing else) is still selected.

Right-click and select Trace Point from the menu.

This will keep a record of the path of the point as it moves. 

	 Teacher:	 Okay, now we are going to trace the path of points on the graph y = ​ 
sin(θ)

 _____ cos(θ) ​ to get 
a picture of the shape of the function.

Use the up button to increase the value of θ.

The path of the point should be marked.

Draw the students’ attention to what happens to the important points on the 
graph, particularly around the x-axis and approaching the asymptotes.

Your screen should look something like this:

	 Teacher:	 Okay, now what I want us to think about is the function that would be formed 
if we were to divide sin(θ) by cos(θ). Can anybody identify any points which 
would lie on that graph, or any special features of the graph?

	 Prompt:	 Think about when y = cos(θ) has a value of 1. What does that mean for the 
graph of y = ​ 

sin(θ)
 _____ cos(θ) ​? How about when y = cos(θ) has a value of 0? How about 

when y = sin(θ) has a value of 0?  When will the graph be negative? When will 
the graph have high positive values or high negative values?

	Ideal Response:	 The graph of y = ​ 
sin(θ)

 _____ cos(θ) ​ will have the same values as y = sin(θ) when y = cos(θ) 
has a value of 1. The graph will be undefined when y = cos(θ) has a value of 
zero, meaning there will be vertical asymptotes at θ = ± ​ π __ 2 ​, ​ 3π ___ 

2
  ​, ​ 5π ___ 

2
  ​. The func-

tion will cross the x-axis when y = sin(θ) has a value of 0.

If you like, encourage students to come to the front to mark on points / sketch 
their curves.

Use the Erase tool to rub out any mistakes.

	 Teacher:	 Okay, so let’s use Autograph to build up a picture of the function y = ​ 
sin(θ)

 _____ cos(θ) ​…

Enter a point on the curve with x co-ordinate θ, and y co-ordinate sin(θ)/cos(θ).

A point should now appear on the page.

	 Teacher:	 If I start off with a value of θ of −4π, where will the point be?

	Ideal Response:	 When θ = −4π, sin(θ) = 0, so y = ​ 
sin(θ)

 _____ cos(θ) ​ also equals 0, so the point will be at 
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	 Teacher:	 Okay, let’s look at a different identity. To begin with, can anybody come tell us 
what the graph of y = sin²(θ) would look like?

	 Prompt:	 Look at the graph of y = sin(θ). What does the squared symbol actually mean? 
What effect does squaring all the y values have? Does the amplitude change? 
Does the slope of the graph change? What happens to the negative values? 
What is the period of the graph?

	Ideal Response:	 Squaring each of the y values will mean that there will be no negative values, 
and so the graph will never go below the x-axis. The amplitude will now be be-
tween 0 and 1, and the period of the graph will be halved as there are no nega-
tive values. y values of 0 and 1 will still be the same, but y values inbetween will 
get smaller when squared, altering the slope of the graph. 

	 Teacher:	 Good. Can somebody come up to the front and do a quick sketch of the graph?

Encourage students to come to the front to sketch their curves.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph area itself and select 
Delete Objects from the menu).

When you are ready:

Ensure Slow Plot mode is turned on.

Enter the equation: y = sin²(θ)
Note: To enter the squared term, either use the little two, or press “alt 2” to-
gether.
Note: The equation can also be written as y = (sin(θ))².

The curve should begin to be drawn on the screen.

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph.

Your screen should look something like this:

Note: You may wish to briefly explain that the vertical lines created by the trace 
do not represent the asymptotes of the function, but are simply the computer’s 
attempts to join up points which should never really be joined up!

	 Teacher:	 And of course, this graph has another name… which is?

	Ideal Response:	 y = tan(θ)

Close the Constant Controller.

Ensure you are still in Slow Plot mode.

Enter the equation: y = tan(θ)

The graph should begin to plot over the top of the trace, making the curve 
much smoother.

	 Teacher:	 And so what is the identity that links together sin(θ), cos(θ) and tan(θ)?

	Ideal Response:	​  sin(θ)
 _____ 

cos(θ)
 ​ = tan(θ)

Activity 2: sin²(θ) + cos²(θ) = 1

Click on Edit > Select All and press delete on the keyboard (or Right-click on 
the graph itself and select Delete Objects from the menu).

This should clear the screen leaving you with just the set of axes.

Enter the equation: y = sin(θ)
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Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph.

Click on Manage Equation List.

Left-click on the equation y = cos(θ) from the menu and click the red cross in 
the top corner

Delete all scribbles from the screen as described above.

Your screen should look something like this:

	 Teacher:	 Now, looking at the graphs, clearly there seems to be some relationship be-
tween them, and I wonder if we could express it as an identity? Let me add on a 
couple of points to help you…

Enter the equation: x = a

Still in the Add Equation box:

Click on Edit Constants and change the value of a to −3π, and click OK.

Click on Draw Options and from the drop-down menu select a dashed line.

	 Teacher:	 What will this line look like?

	Ideal Response:	 A vertical line going through the point x = −3π.

Click OK twice, and a vertical line should be on your screen.

Left-click on an unoccupied part of the graph area to de-select everything.

Turn off Slow Plot mode.

Click on Manage Equation List.

Left-click on the equation y = sin(θ) from the menu and click the red cross in 
the top corner.

On the same screen, add the equation y = cos(θ), and click OK.

The graph of y = cos(θ) should have replaced y = sin(θ).

	 Teacher:	 Thinking about what we have just done, can somebody come up and do a quick 
sketch of the graph of y = cos²(θ).

Encourage students to come to the front to sketch their curves.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph area and select De-
lete Objects from the menu).

When you are ready:

Click on Slow Plot mode.

Enter the equation: y = cos²(θ)

The curve should begin to be drawn on the screen.
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Your page should look something like this:

	 Teacher:	 Now, keeping your eye on the co-ordinates, can anybody give me an identity 
linking sin²(θ) and cos²(θ)?

	 Prompt:	 Pay particular attention to the y values.

	Ideal Response:	 sin²(θ) + cos²(θ) = 1

Note: Another nice way to show that this always adds up to 1 is to place a point 
at x = a on the graph of y = sin²(x), then add a vector ​(  0   

cos²(a)
 )​ to the point, and 

then use the constant controller to adjust.

Ideas for Further Work	

Deriving these identities using right-angled triangles and the unit circle.•	

Solving trigonometric equations which rely on these identities.•	

Deriving the shape of the reciprocal trigonometric functions: see Teacher •	
Demonstration T7: Reciprocal Functions.

Proving further trigonometric identities.•	

Note: A really nice activity that could follow directly from this demonstration 
would be to use Autograph and its constant controller to investigate identities 
in the form: y = sinⁿ(x) + cosⁿ(x). Sure, when n = 1 and 2, life is pretty easy, but 
how about when n = 3, 4, 5…

Note: Autograph can also be used in a similar way to get a graphical represen-

Left-click on the dashed line and the graph of y = sin²(θ) (they should both turn 
black).

Right-click and select Solve Intersection from the menu. 

The point where the line crosses the curve should now be marked.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the point marking the intersection (it should turn black).

Click on Text Box, change the words “intersection solver” to “sin squared”, and 
click OK.

The co-ordinates of the point of intersection should now be displayed.

Repeat the above instructions to label the point of intersection of the line and y 
= cos²(θ).

When completed, your screen should look something like this:

Click on the Constant Controller.

Change the value of the step to π/12.

Use the up button to increase the value of a.

The vertical line should move across the screen, adjusting the co-ordinates of 
the points of intersection.
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tation of the reciprocal identities. For example:

tan²(θ) + 1 = sec²(θ)1.	

cot²(θ) + 1 = cosec²(θ)2.	
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T9
Teacher
Demonstration

Completing the Square:
A Graphical Approach

Learning Objectives	

To get a visual representation of what the “completed square” form of a •	
quadratic function actually means graphically.

To understand that the completed square form of a quadratic equation •	
enables us to:

Find the co-ordinates of the maximum or minimum point.1.	

Sketch a curve using horizontal and vertical translations from the 2.	
curve y = x².

To be able to deduce important features about the graph of a function •	
when in the completed the square form.

To be able to use the completed square form to derive the equation of •	
quadratic functions, both positive and negative, given the co-ordinates of 
the maximum or minimum points.

Note: This demonstration activity focuses solely on quadratic equations which 
can be expressed in the from y = (x + q)² + r, and what we can learn from equa-
tions in this form. It is intended to expand students’ understanding of curve 
sketching and how the equations of functions relate to their graph, and not to 
cover expressing equations in the from y =  p(x + q)² + r.

Required Pre-Knowledge	

To be able to express quadratic equations: •	 y = x² + ax + b in the “complet-
ed square” form: (x + q)² + r.

To know the shape of quadratic functions.•	

To be able to factorise quadratic functions.•	

Note: Prior knowledge of transformations in the form f(x + a), f(x) + a, and −f(x)  
would be useful for this activity, but is not essential. Indeed, it is possible to use 
this activity to introduce, or re-cap on transformation work whenever it occurs 
in the course. Student Investigation 1 – Transforming Graphs would be one 
way of introducing this topic.

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

Select Whiteboard Mode.
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Left-click on an unoccupied part of the graph area to de-select everything.

We will use Page - 1 later.

Open up a New 2D Graph Page.

Page - 2:

Edit the axes as follows:
x:	 Minimum:	 −12	 Maximum:	 12	 Numbers:	 1	 Pips:	 1
y:	 Minimum:	 −6	 Maximum:	 6	 Numbers:	 1	 Pips:	 1

Remove all of the green ticks underneath Auto. 

Still in the Edit Axes menu:
Click on the Appearance tab
Open the drop-down menu underneath Themes
Select Graph Paper

Click on Equal Aspect Mode.

From the Axes menu, select Show Key.

This should make the Key disappear.

Your screen should look like this:

For this activity, you will need to set-up two blank 2D Graph Pages.

Page - 1:

Edit the axes as follows:
x:	 Minimum:	 −20	 Maximum:	 20	 Numbers:	 2	 Pips:	 1
y:	 Minimum:	 −12	 Maximum:	 12	 Numbers:	 2	 Pips:	 1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

Still in the Edit Axes menu:
Click on the Appearance tab.
Open the drop-down menu underneath Themes.
Select Graph Paper.

Click on Equal Aspect Mode.

This alters the x scale so that the axes are square.

Enter the equation: y = x² + 20x + 92

Enter the equation: y = −x² + 8x − 10

At the top of the screen go to Axes > Show Key.

This should make the key at the bottom of the screen disappear.

Note: This can also be done by right-clicking on the Key towards the bottom 
of the screen where it says “Equation 1: y = 8”, and from the menu left-click on 
Show Key.

Your page should look something like this:
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y-axis: when x = 0, y = −2, so the y-intercept is at (0, −2).

Click on Slow Plot mode.

Enter the equation: y = x² + 3x - 2

Note: To enter x², either use the little 2 button, or press “alt 2” together, or 
press “xx”

The curve should begin to be drawn on the screen.

Your screen should look something like this:

Press Pause Plotting both the stop the process, or to resume it to focus on the 
key features of the graph.
Note: The Spacebar on the keyboard can also be used for this function.

	 Teacher:	 Okay, so now, can you express the same equation, y = x² + 3x – 2, in “completed 
square” form?

	 Prompt:	 Remember, completed square form means: (x + q)² + r.

	Ideal Response:	 y = ​( x + ​ 3 __ 2 ​ )​² − ​ 9 __ 4 ​ − 2

y = (x + 1.5)² − 4.25

	 Teacher:	 Good. Now, the question is, how could the completed the square form have 
helped us when we were asked to sketch the curve? 

	 Prompt:	 Think about what the completed square form can tell us about the curve. Think 
about the smallest possible value that y can take according to the completed 

The start of this demonstration uses Page - 2.

Note: Pages 1 and 2 are available as Tabs at the top of the screen, and each page 
can be viewed by simply clicking on the relevant tab.

Step-by-Step Instructions	

Activity 1: Finding the Minimum Point

	 Teacher:	 Okay, to warm you up, if you were asked to sketch the graph: y = x² + 3x – 2, 
can anybody tell me something about its key features? For example, its shape, 
where it crosses the axes? 

	 Prompt:	 Shape: is the x² term positive or negative? Is it a U shape or an upside down U?

x-axis: what is the value of x when y is 0? Can we factorise? Do we need to use 
the quadratic formula? Can we tell what side of the y-axis the crossing points 
are going to lie on?

y-axis: what is the value of y when x is 0? 

	Ideal Response:	 Shape: the x² term is positive, so the graph must be U shaped.

x-axis: x² + 3x − 2 doesn’t factorise, so we would have to use the quadratic 
formula (x = −3.56 and 0.56 to 2 decimal places, just in case any keen students 
worked it out). Because the final term (−2) in the expression is negative, we can 
also say, without working them out, that one solution must be positive and one 
solution must be negative, so the curve crosses the x-axis at either side of the 
y-axis.
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Activity 2: Sketching Curves using Translations

	 Teacher:	 But, believe it or not, the completed square form is even more useful than that! 
So long as we know how to complete the square, and we can remember what 
the graph of y = x² looks like, then we can draw any quadratic function really 
quickly.

	 Teacher:	 Can somebody quickly remind us what the graph of y = x² looks like?

Make sure Slow Plot is still turned on.

Enter the equation: y = x²

Click OK and the curve should begin plotting on the screen.

	 Teacher:	 Can anybody describe in terms of transformations, how to get from the graph 
of y = x² to the graph of y = x² + 3x – 2.

	 Prompt:	 Think about movements left-right, and movements up-down. What type of 
transformations are these movements?

	Ideal Response:	 The graph of y = x² has been translated 1.5 units to the left, and 4.25 units 
down. Or, in terms of a vector, it has been translated: ​( −1.5   

−4.25
 )​.

	 Teacher:	 Which is exactly what the completed square form of the equation told us would 
happen! Watch…

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the curve y = x² (it should turn black).

Right-click and select Delete from the menu, or simply press delete on the 
keyboard.

Click on the cross in the top right corner of the Status Box to close it.

Enter the equation: y = (x + q)² + r
Still on the Add Equation screen, click on Edit Constants.

	 Teacher:	 What values of q and r will we need in order to have the graph of y = x²?

	Ideal Response:	 p = 0 and r = 0.

Still in Edit Constants, change the values of both q and r to 0.

Click OK, and the graph should be exactly where y = x² used to be.

Ensure the graph of y = (x + q)² + r is selected.

Click on Text Box.
Place a tick in the box next to Show Detailed Object Text and click OK.

The equation of the curve, together with the values of q and r should now be 
labelled.

square form. Try a few x values out in your head, and see what you get for y. 
What value of x gives us this minimum value of y? Why will all other values 
of x give us a greater value of y? What important point on the curve does this 
knowledge immediately give us?

	Ideal Response:	 The completed square form shows us that the smallest value y can take is –4.25, 
and this occurs when x is equal to –1.5. Any other x value would mean that the 
bracket has a value other than zero, and hence when it is squared, this value 
will be positive, thus increasing the value of y. And so, the minimum value of y 
(–4.25) occurs when x = –1.5, which must give us the co-ordinates of our mini-
mum point of the curve: (–1.5, –4.25).

	 Teacher:	 Excellent. Right, let’s check that using a special function on Autograph which 
finds us the maximum and minimum values of any function.

Left-click on the curve (it should turn black).

Right-click and select Solve f ’(x)=0 from the menu.

The minimum point should now be marked on the curve, and co-ordinates 
displayed on the bottom of the screen.

On the top toolbar, click on View > Status Box to see this result more clearly.

Note: The Status Box will only ever display information about object currently 
selected. If the Status Box ever goes blank, or displays the wrong information, 
simply left-click on your chosen object again.

Your page should look something like this:
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	 Teacher:	 Can anybody summarise what each part of the completed square form tells us 
about the location of the curve relative to y = x²?

	 Prompt:	 What did q tell us? What did r tell us?

	Ideal Response:	 r tells us how far up or down to translate the curve. q tells us how far left or 
right, but we must remember to switch the sign. 

	 Teacher:	 That’s right. And I can now show you that this is true for every single point on 
the curve.

Activity 3: A Link to Vectors...

Adjust the values of q and r back to 0 so the curve returns to y = x².

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the curve y = x² (it should turn black).

Enter a point on the curve with x co-ordinate 0.
The point (0, 0) should now appear on the curve.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the point at (0, 0) (it should have a square around it).

Right-click and select Vector from the menu.

Enter in the values −1.5 and −4.5 and click OK.

A vector should now appear connecting the two minimum points together.

Use the left-right arrows on your keyboard to move the point around, drawing 
the students’ attention to the fact that the vector remains the same.

Your page should look something like this:

Click on the Constant Controller. 
You can now easily adjust the value of q and r.
The drop-down menu switches between the constants.
The up-down buttons adjust the value of the constant.
The left-right buttons adjust the size of the step.  

Your page should look something like this:

	 Teacher:	 Now, at the moment, the values of q and r are both set to zero, so we just have 
the graph of y = x². But now I am going to alter them in turn to match the com-
pleted square form of our equation, which was y = (x + 1.5)² – 4.25. 

	 Teacher:	 What do you think will happen as I adjust the value of q?

Select constant q, and begin adjusting it in steps of 0.1 until the value is equal 
to 1.5.

Draw the students’ attention to the fact that the curve moves in the opposite 
direction than the sign in front of the q implies.

Note: If you have covered transformations, you could link this into the f(x + a) 
transformation. If you have not covered it yet, remind students of this activity 
when the time comes.

	 Teacher:	 What do you think will happen as I adjust the value of r?

Now select constant r, and begin adjusting it in steps of 1, then 0.1, and then 
0.01 until the value is equal to −4.25.

Note: Again, link to f(x) + a if you have covered it.
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Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the point on the curve y = x².

Right-click and select Delete from the menu, or simply press delete on the 
keyboard, ignoring the warning.

You should now be left with one curve.

	 Question 1:	 Can somebody come up and sketch the graph of: y = x² – 5x + 2, and tell us the 
co-ordinates of the minimum point?

	 Prompt:	 Think about what the completed the square form tells us.

	 Answer 1:	 y	= x² – 5x + 1
	 = (x – 2.5)² - 6.25 + 1
	 = (x – 2.5)² – 5.25
So, the minimum point is at (2.5, –5.25), and the curve is a translation of y = x² 
by 2.5 units to the right and 5.25 units down.

Encourage students to come to the front to sketch their curves and use the 
Scribble Tool.

Use the Erase tool to rub out any mistakes.
If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete.

Ensure Slow Plot mode is still on.

Enter the equation: y = x² – 5x + 1 to show the students that they are correct.

Your page should look something like this:

You can then really emphasise this concept by tracing the point as follows:

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the curve y = x² + 3x – 2 (it should turn black).

Right-click and select Delete from the menu.

Left-click on the point at the end of the vector (not the point on the curve y = 
x²).

Right-click and select Trace Point from the menu.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the point on the curve y = x².

Now use the left-right arrows on the keyboard to move the point along the 
curve, and as it goes it leaves a trace of the curve y = x² + 3x – 2 behind.

	 Teacher:	 And can anybody generalise this? How far must we translate each point on the 
curve y = (x + q)² + r, if we start at y = x²?

	Ideal Response:	 We must translate this by the vector: ​( –q
   r  )​

	 Teacher:	 Good. And so not only does the completed square form of a quadratic equation 
tell us the value of the minimum point, it also tells us exactly how to sketch the 
curve starting from y = x². Now to put you to the test…

Activity 4: Putting it all Together
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Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the curve y = x² + 10x + 27 (it should turn black).

Right-click and select Delete from the menu, or simply press delete on the 
keyboard.

	 Question 3:	 Point A lies on the curve y = x² at (−1, 1). The curve is translated to become y = 
x² + 8x + 11. What are the co-ordinates of Point A following the translation?

	 Prompt:	 Think about how the complete the square form helps us sketch curves relative 
to y = x².

	 Answer:	 y = x² + 8x + 11
y = (x + 4)² − 16 + 11
y = (x + 4)² − 5
So, the minimum point is at (−4, −5), meaning the whole curve/every point has 
been translated 4 units to the left, and 5 units down.

So, the Point A must now be at (−5, −4).

Enter the equation: y = x² + 10x + 27

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the curve y = x² (it should turn black).

Enter a point on the curve with x co-ordinate −1.

The point (−1, 1) should now appear on the curve.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the curve y = x² – 5x + 1 (it should turn black).

Right-click and select Delete from the menu, or simply press delete on the 
keyboard.

	 Question 2:	 Without using the quadratic formula, show that the curve y = x² + 10x + 27 
never crosses the x-axis.

	 Prompt:	 Think about the minimum point on the curve and the shape of the curve.

	 Answer:	 y	= x² + 10x + 27
	 = (x + 5)² − 25 + 27
	 = (x + 5)² + 2
So, the minimum point is at (−5, 2), which is above the x-axis, and seeing as this 
is the minimum point, the curve will never go below this.

Ensure Slow Plot mode is still on.

Enter the equation: y = x² + 10x + 27 to show the students that they are correct.

Your page should look something like this:

T9 Completing the Square: A Graphical Approach T9 Completing the Square: A Graphical Approach



144 145

Left-click on the red curve (it should turn black).

On the top toolbar, click on View > Status Box.

The correct equation of the curve should now be displayed.

Blue Line:

	 Prompt:	 This is quite a tricky one and a good point of discussion. One way to do it is 
to treat the curve as a positive U shaped graph with a minimum point at (−10, 
−8), and work out the equation of that [y = x² + 8x + 22], and then think about 
reflecting that curve in the line y = 6. Another way is to remember to multiply 
the terms inside the square brackets by −1 (change all the signs) and proceed as 
normal to get the curve you require.

	 Answer:	 Maximum Point: (4, 6)
So, complete the square form: y = −1 [ (x − 4)² ] + 6 
Expand brackets: y = −1 [ x² − 8x + 16 ] + 6
Expand second brackets: y = −x² + 8x – 16 + 6
Simplify: y = −x² + 8x − 10

Left-click on the blue curve and the equation should appear in the Status Box.

Ideas for Further Work	

This demonstration would link nicely into any of the following topics:•	

Transformations of curves – See Student Investigation 11.	

Co-ordinate Geometry2.	

Harder completing the square3.	

Further algebraic manipulation4.	

Differentiation as an alternative way to find maximum and minimum 5.	
points

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the point at (−1, 1) (it should have a square around it).

Right-click and select Vector from the menu.

Enter in the values −4 and −5 and click OK.

The vector should show the path of the point and show the students they are 
correct.

Your page should look something like this:

Note: Again, you can also use the left-right arrows on the keyboard to move 
the point along the curve and illustrate how every single point is translated in 
the same way.

Click on the Page - 1 tab to open the page you prepared at the start of the les-
son.

	 Question 4:	 What are the equations of these two curves in the form y = x² + ax + b?

Red Line:

	 Prompt:	 You know the minimum point, so try working backwards!

	 Answer:	 Minimum Point: (−10, −8)
So, using completed the square form: y = (x + 10)² – 8
Expand brackets: y = x² + 20x + 100 – 8
Simplify: y = x² + 20x + 92
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T10
Teacher
Demonstration

Introduction to
Parametric Equations

Learning Objectives	

To be introduced to the concept of parametric equations, and to be able •	
to visualise and understand their construction.

To understand how parametric equations involving trigonometric terms •	
relate to their original normal Cartesian equations by using identities.

To understand the effect that the range of a set of parametric equations •	
may have on the graph of the resulting normal Cartesian function.

Required Pre-Knowledge	

To be comfortable working in radians.•	

To be aware of the following trigonometric identities: •	 sin²(t) + cos²(t) = 1 
and cos(2t) = 1 – 2sin²(t).

To be comfortable with the concept of a constant.•	

To understand that the equation of a circle with centre •	 (a, b) and radius r 
can be expressed as follows: (x – a)² + (y – b)² = r²

To be familiar with the graphs of •	 y = sin(ax) and y = cos(ax), where a is a 
constant.

To understand the concept of the range of a function.•	

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

Select Whiteboard Mode.

Edit the axes as follows:
x:	 Minimum:	 −6	 Maximum:	 6	 Numbers:	 1	 Pips:	 1
y:	 Minimum:	 −3	 Maximum:	 3	 Numbers:	 1	 Pips:	 1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

Select Equal Aspect Mode.

This will automatically adjust the x-axis so the axes are square.

Ensure you are working in Radians.

Your screen should now look something like this:

Step-by-Step Instructions	

Activity 1: Introducing the Concept

	 Teacher:	 Right, a tricky one to start with. Does anybody have any idea what the graph of 
this function (or even functions) would look like: x = cos(t),  y = sin(t).

	 Prompt:	 Unless students have experienced parametric equations before, it is unlikely 
that they will be able to determine the nature of the graph at this stage. Subtle 
prompts along the following lines should get their brains ticking: Will there be 
one function or two? How many variables are there? How are we going to cope 
with that on our usual x-y set of axes?

	 Teacher:	 Okay, how about we try to find a few points which lie on this function, or func-
tions. Can anybody think of any values of t which might give us some nice x and 
y co-ordinates?

	 Prompt:	 Remember, we are working in radians. How about 0? How about π? 2π? What 
about some of the special values in between?

	Ideal Response:	 By trying different values of t, we can build up a set of co-ordinates that must lie 
on the function, or functions:

When t = 0	 cos(t) = 1	 sin(t) = 0	 which gives us 	 (1, 0)
When t = π	 cos(t) = −1	 sin(t) = 1	 which gives us 	 (−1, 1)
When t = 2π	 cos(t) = 1	 sin(t) = 0	 which gives us 	 (1, 0)
When t = ​ π __ 2 ​	 cos(t) = 0	 sin(t) = 1	 which gives us 	 (0, 1)
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When t = ​ 3π
 ___ 2  ​	 cos(t) = 0	 sin(t) = −1	 which gives us 	 (0, −1)

When t = ​ π __ 3 ​	 cos(t) = 0.5	 sin(t) = ​ √3
 ___ 2 ​	 which gives us 	 (0.5, ​ √3

 ___ 2 ​)
etc…

Encourage students to come to the front to mark these points on the graph us-
ing the Scribble Tool.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select all scribbles, and 
press delete on the keyboard (or Right-Click on the graph area itself and select 
Delete Objects from the menu).

Your screen should look something like this:

	 Teacher:	 Okay, so can anybody describe the graph that seems to be forming here?

	 Prompt:	 Look at the shape of the points. Does it look like we have one or two functions? 
Be specific with your description.

	Ideal Response:	 The points seem to form a circle, with centre (0, 0), and radius 1.

	 Teacher:	 Sounds good, so let’s use Autograph to check:

Click on Slow Plot mode.

Enter the equation: x = cos(t), y = sin(t)
Note: The brackets are not necessary, and can be omitted it you prefer, but the 
comma is crucial!

Click OK.

The curve should appear on screen, hopefully going through the points plotted 
by the students.  

Press Pause Plotting both to stop the process and to resume it to focus on the 
key features of the graph.

Note: The Spacebar can also be used to serve this function.

Your screen should look something like this:

At this point it might be a good idea to clear all the scribbles off the screen.

Click on Edit > Select All Scribbles, and press delete on the keyboard (or 
Right-click on the graph area and select Delete Objects from the menu).

You should now be left with just the graph of the circle.

	 Teacher:	 Now, the big question is why on earth do the equations x = cos(t),  y = sin(t) give 
us the graph of a circle with centre (0, 0) and radius 1? Is there anyway we could 
have known that without plotting a load of points?

	 Prompts:	 Which variable does not appear on the graph? How can we eliminate t? Would 
a trigonometric identity help? Which trigonometric identities involve sin and 
cos? Can you use sin²(t) + cos²(t) = 1 to help eliminate t? What about if you start 
by squaring both sides? Then adding them together…

1.	 The variable t does not appear on the graph, so it must have been eliminat-
ed. We can use an identity to help us eliminate t.

Ideal Response:
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Square both sides of the equations, giving: 2.	 x² = cos²(t) and y² = sin²(t).
Now, add the corresponding sides of the equations together, giving: 3.	 x² + y² = 
cos²(t) + sin²(t).
Use the identity 4.	 sin²(t) + cos²(t) = 1 to simplify the right hand side, giving: x² 
+ y² = 1.

This is the equation of a circle, with centre (0, 0), and radius 1.

	 Teacher:	 Excellent! The equations x = cos(t),  y = sin(t) are called Parametric Equations. 
They contain three variables, one of which (t) is called the parameter. What 
you have just managed to do, by eliminating the parameter, is to express them 
in normal, Cartesian form.

Give the students a few moments to digest this before moving on.

Activity 2: Extending the Circle

Make sure you are in Select Mode.

Left-click on the circle (it should turn black).

Right-click and select Delete Object from the menu, or simply press Delete on 
the keyboard.

You should now be left with just a set of axes.

	 Teacher:	 Okay, let’s make life a little more difficult. I am now going to enter the equa-
tions: x = a + rcos(t), y = b + rsin(t). If I wanted to produce the exact same circle 
as before, what values of a, b and r would I need? 

	Ideal Response:	 a = 0,  b = 0,  r = 1

	 Teacher:	 Good, so here we go:

Make sure Slow Plot mode is still on.

Enter the equation: x = a + rcos(t),  y = b + rsin(t)
Still on the Enter Equation screen, click on Edit Constants, and set the values 
of the constants as follows: a = 0, b = 0, r = 1.
Click OK twice.

The circle should appear on the screen in the exact location as the previous 
one.

Left-click on the curve (it should turn black).

Click on Text Box.

Tick the box next to Show Detailed Object Text and click OK.

The equation of the circle, along with the current values of a, b and r should 
now be displayed.

Click on the Constant Controller.

The drop-down menu allows you to select each constant.
The up-down buttons adjust the value of the constant.
The left-right buttons adjust the value of the step.

Move both the Text Box and the Constant Controller to a convenient point on 
the page.

Your screen should look something like this:

	 Teacher:	 Now, the big question is, what do you think will happen to the graph of our 
function if we change the values of constants a, b and r?

	 Prompt:	 Again, more than likely this may not be immediately obvious to the students. 
Allow them a few minutes to make predictions and justify those predictions.

Manipulate one constant at time, perhaps adjusting the value of the step to 1, 
or 0.5.

Encourage the students to suggest different values for the constants.

Encourage them to predict the exact nature of the circle given certain values of 
constants.

Challenge them to give you values of constants that will result in specific cir-
cles.

After some manipulation, your screen might look something like this:
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	 Teacher:	 What effect do a, b and r have on the circle, and can anybody express the equa-
tion of the circle in terms of a, b and r?

	 Prompt:	 Think about the location and size of the circle for different values of the con-
stants. How does this relate to the equation of a circle? What is the general 
form for the equation of a circle? What do the constants represent in that equa-
tion?

	Ideal Response:	 a and b effect the location of the centre of the circle, and r effects the size of the 
radius. The resulting circle can be expressed as follows: (x – a)² + (y – b)² = r², 
giving us a circle with centre (a, b) and radius r.

	 Teacher:	 Excellent. Now, using a similar technique to what we did before, can you show 
how we could have found that out just from the original parametric equations: 
x = a + rcos(t), y = b + rsin(t)?

	 Prompt:	 Think about eliminating the parameter t again. Use the same identity as before, 
but re-arrange the equations first. Think a few steps ahead. What would you 
like to see on both sides of the equation at the end in order to use the identity 
and simplify? 

1.	 Rearrange both equations, giving: x − a = rcos(t) and y − b = rsin(t).
Square both sides of the equations, giving: 2.	 (x − a)² = r²cos²(t) and (y − b)² = 
r²sin²(t).
Now, add the corresponding sides of the equations together, giving: 3.	 (x – a)² 
+ (y – b)² = r²cos²(t) + r²sin²(t).
Factorise the right hand side, giving: 4.	 (x – a)² + (y – b)² = r²(cos²(t) + sin²(t)).
Use the identity 5.	 sin²(t) + cos²(t) = 1 to simplify the right hand side, giving: (x 
– a)² + (y – b)² = r².

Ideal Response:

This is the equation of a circle, with centre (a, b), and radius r.

Give the students a few moments to digest this before moving on.

Activity 3: Using another Identity

Close the Constant Controller by clicking the red cross in the corner.

Click on Edit > Select All and press delete on the keyboard (or Right-click on 
the graph area and select Delete Objects from the menu), ignoring the warning 
about deleting dependent objects.

You should now be left with only a set of axes.

	 Teacher:	 Okay, this time I would like to plot the following parametric equations: x = 
sin(t) and y = cos(2t). Would anybody like to make a prediction of what they 
think the resulting graph will look like?

If the students are particularly keen, invite them to the front to quickly sketch 
their predictions. 

Use the Erase tool to rub out any mistakes.

If you want to clear all scribbles, click on Edit > Select All Scribbles, and press 
delete on the keyboard (or Right-click on the graph itself and select Delete 
Objects from the menu).

	 Teacher:	 Once again, how about we try to find a few points which lie on this function? 
Can anybody think of any values of t which might give us some nice x and y co-
ordinates?

	 Prompt:	 Remember, we are working in radians. How about 0? How about π? 2π? What 
about some of the special values in between? Remember, it is cos(2t).

	Ideal Response:	 By trying different values of t, we can build up a set of co-ordinates that must lie 
on the function:

When t = 0	 sin(t) = 0	 cos(2t) = 1	 which gives us 	 (0, 1)
When t = π	 sin(t) = 0	 cos(2t) = 1	 which gives us	 (0, 1)
When t = 2π	 sin(t) = 0	 cos(2t) = 1	 which gives us 	 (0, 1)
When t = ​ π __ 2 ​	 sin(t) = 1	 cos(2t) = −1	 which gives us 	 (1, −1)

When t = ​ 3π
 ___ 2  ​	 sin(t) = −1	 cos(2t) = −1	 which gives us 	 (−1, −1)

When t = ​ π __ 4 ​	 sin(t) = ​ 1 ___ 
√2

 ​	 cos(2t) = 0	 which gives us 	 (​ 1 ___ 
√2

 ​, 0)
etc…

Encourage students to come to the front to mark these points on the graph.

Use the Erase tool to rub out any mistakes.

Your screen should look something like this:
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	 Teacher:	 Okay, so can anybody describe to us the graph that seems to be forming here?

	 Prompt:	 Look at the shape of the points. What types of functions give us graphs like 
this?

	Ideal Response:	 It seems to be an upside-down U-shape, which suggests a negative quadratic. It 
seems to have a maximum at (0, 1).

	 Teacher:	 Sounds good, so let’s use Autograph to check:

Click on Slow Plot mode.

Enter the equations: x = sin(t),  y = cos(2t) and click OK.

The curve should appear on screen, hopefully going through the points plotted 
by the students.  

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph. 

Your screen should look something like this:

	 Teacher:	 Now, I saw two strange things going on when this curve was being plotted. Did 
anybody else notice them?

Click on Re-Plot if necessary.

	Ideal Response:	 Autograph seems to go over the curve twice, and the curve doesn’t go below 
the line y = −1.

	 Teacher:	 Excellent. Let’s look at that again.

Delete all scribbles as explained above.

Click on Re-Plot to show the students the construction of the graph again.

Draw students’ attention to the values of t changing at the bottom of the screen.

Point out that Autograph is inputting t values between −2π and 2π.

	 Teacher:	 Let’s deal with the first strange thing first: why does Autograph seem to plot the 
graph twice?

	 Prompt:	 Think about the equations x = sin(t) and y = cos(2t). What are the periods of 
those graphs? But what range are we plotting over in this example? How does 
that help explain why Autograph seems to plot the curve twice?

	Ideal Response:	 The curve is plotted twice because the period of the graph as a whole is 2π, and 
we are plotting it over 4π range. 

	 Teacher:	 Excellent! Now, time to deal with the second strange feature: why does the 
graph suddenly stop at the line y = −1?…
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	 Prompt:	 Again, it is unlikely the students will come up with the correct answer at this 
stage, but encourage any suggestions.

	 Teacher:	 Well, to help us answer this one we first need to express our parametric equa-
tions in normal Cartesian form as before. Any ideas how?

	 Prompt:	 We need another trigonometric identity. This time it must link cos(2t) with 
sin(t). Can you think of an indentify which allows us to express cos(2t) in terms 
of sin(t)? What about a double angle formula? What about cos(2t) = 1 – 2sin²(t)? 
How does that help us figure out the normal Cartesian equation of our curve? 

1.	 We start with: x = sin(t), y = cos(2t).
Use the identity 2.	 cos(2t) = 1 – 2sin²(t) to change the second parametric equa-
tion: y = 1 – 2sin²(t).
We can now express 3.	 y in terms of x: y = 1 – 2x².

This gives us the normal Cartesian equation of our curve. 

	 Teacher:	 Sounds good, so let’s use Autograph to check:

Click on Slow Plot mode.

Enter the equation: y = 1 – 2x²
Note: To enter x², either use the little 2, press “alt 2” together, or type “xx”

The curve should appear on screen, going on top of the parametric curve.  

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph. 

	 Teacher:	 Let’s just make things a little clearer:

In the Key at the bottom of the screen, double left-click on Equation 1.
This should bring up the Edit Equation screen.
Click on Draw Options, and change the line thickness to 3 pt.
Click OK.

Your screen should look something like this:

Ideal Response:

	 Teacher:	 So, how come our Parametric Equations stop at y = −1, whereas when the equa-
tions are expressed in normal Cartesian form, they continue down into the 
negatives?

	 Prompt:	 Think about the graphs of sin(t) and cos(2t). Think about their range. What ef-
fect does this have on the Cartesian form of the curve on the screen?

	Ideal Response:	 The curve stops at y = −1 because the values of both x and y are restricted by 
the ranges of sin(t) and cos(t) which only exist between −1 and 1.

Ideas for Further Work	

Further practice of converting parametric form into Cartesian form using •	
trigonometric identities.

Students should find the process of converting non-trigonometric para-•	
metric equations into Cartesian by eliminating the parameter easier than 
dealing with the trigonometric ones.

Introduce parametric differentiation.•	

Exam style questions on parametric equations. •	
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T11Teacher
Demonstration

Discovering First Order 
Differential Equations

Learning Objectives	

To be introduced to the concept of differential equations, and to be able •	
to visualise and understand their construction.

To understand the concepts of a general solution of first order differential •	
equations and a family of curves.

To understand the relationship between differential equations, gradient •	
functions, and the processes or differentiation and integration.

To be able to find the particular solution to a differential equation using •	
the conditions given.

Required Pre-Knowledge	

To be aware of the concept of the gradient function, and the notation: ​ •	 dy
 ___ 

dx
 ​.

To know how to differentiate and integrate functions involving positive •	
powers of x.

To understand the role of the constant in differentiation and integration.•	

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

Select Whiteboard Mode.

Edit the axes as follows:
x:	 Minimum:	 −4	 Maximum:	 4	 Numbers:	 1	 Pips:	 0.5
y:	 Minimum:	 −4	 Maximum:	 4	 Numbers:	 1	 Pips:	 1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

On the top toolbar click on Axes, and then Show Key.

This should remove the key from the bottom of the screen.

Your screen should now look something like this:

Step-by-Step Instructions	

Activity 1: Introducing the Concept

	 Teacher:	 Okay, can anybody tell me what they think this means: ​ dy
 ___ 

dx
 ​ = x

	 Prompt:	 What does ​ dy
 ___ 

dx
 ​ mean? What does that tell us about the gradient at every x co-

ordinate on the function?  

	Ideal Response:	​  dy
 ___ 

dx
 ​ = x means that the gradient function is equal to x. In other words, the gradi-

ent at every single x co-ordinate on our function is equal to x.

	 Teacher:	 Good. So, if we were to plot ​ dy
 ___ 

dx
 ​ = x, what would it look like?

	 Prompt:	 What would be the value of the gradient when x is 1? How about when x is −1, 
2, 4, −3? What shape does this give us? Where would we draw this? Would it be 
a single, unique function?

	Ideal Response:	 The gradient of the function is just equal to the x value, so when x is 1, the 
gradient is 1, when x is −3, the gradient is −3, and so on. This suggests that the 
function will be a curve. But it will be hard to plot as we don’t know the corre-
sponding y value of each x value.

At this point it might be a good idea to invite students to the front to roughly 
mark on these gradients using the Scribble Tool. This will emphasise the dif-
ficulty in drawing the function, as the students will not know where to position 
the line.
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Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph area and select De-
lete Objects from the menu).

When you are ready (and all scribbles have been cleared):

Enter the equation: dy/dx = x
Note: If you prefer, this can be entered as y’ = x.
Click OK.

Your screen should look something like this:

	 Teacher:	 Notice that all we, or the computer, can do is to mark on a series of lines to 
represent the gradient of the function at that point. We know exactly what the 
gradient of the curve is at each x value, we just don’t know where to draw the 
curve. 

Give the students a few moments to digest this before moving on.

Activity 2: A General Solution

	 Teacher:	 Now, what I can do is draw in a few of these functions so we can get a better 
idea of what is going on.

Click on Slow Plot mode.

Your cursor should be a cross.

Left-click on various points of the graph to form the family of curves.

Press Pause Plotting both to stop the process and to resume it to focus on the 
key features of the graph.

Note: The Spacebar can also be used to serve this function.

Make sure you generate one of these curves by clicking on (0, 0). 

Note: If your cursor ever returns to being an arrow, simply click on D. E. Solu-
tion to get the cross back!

Your screen should look something like this:

Draw the students’ attention to the curve which passes through (0, 0).

	 Teacher:	 Can anybody tell me the equation of this curve?

	 Prompt:	 Think about the shape of the curve. Think about the points that lie on the 
curve. Think about the fact that this curve came from the equation: ​ dy

 ___ 
dx

 ​ = x If 
the gradient function is x, what can we say about the power of the function 
itself? The equation of which curve has a gradient function of x, and passes 
through (0, 0)? So y = ? How do we turn the ​ dy

 ___ 
dx  ​ into a y? Maybe think about 

integration. 

	Ideal Response:	 The curve must be a positive quadratic. We can tell this from the shape, and 
by the fact that if the gradient function is x, the power of the original function 
must be x-squared. If we integrate the both sides of the gradient function with 
respect to x, we get back to the function itself, which gives us y = ½ x² + c. Be-
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cause the curve passes through (0, 0), the value of c is 0, so we are just left with 
y = ½ x².

	 Teacher:	 Sounds good, but let’s just check.

Make sure Slow Plot mode is still turned on.

Enter the equation: y = ½ x² + c
Note: To enter x², either use the little 2 button, or type “xx”, or press “alt 2” 
together.  
Still on the Enter Equation screen, click on Edit Constants, and alter the value 
of c to 0.
Click OK twice.

The curve should appear on screen, going directly over the curve which passes 
through the origin.

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph.

	 Teacher:	 So, what are the equations of the other curves on the screen?

	 Prompt:	 Think about what we have just done. Think about the difference between these 
curves, and the curve which passes through the origin. What type of transfor-
mation is this? How does this help us figure out the equation of these curves? 

	Ideal Response:	 The other curves are simply translations up and down the y-axis, and so their 
equations are simply y = ½ x² + c, where c is the value of the y intercept. 

	 Teacher:	 And we can easily check that…

Click on the Constant Controller.
The up-down buttons adjust the value of the constant.
The left-right buttons adjust the value of the step.
Adjust the value of c until it matches each of the curves you have drawn.

Your screen should look something like this:

	 Teacher:	 Good. Now, before I ask you the tricky question, let’s just make our page a bit 
clearer…

Turn off Slow Plot mode.

Left-click twice on one of the red family of curves.

This should bring up the Edit Equation screen.
Click on Startup Options.
Underneath Initial Conditions, click on Point Set.
Click on Enter Start Points.
Click on y-axis, and click OK twice.

Your screen should look something like this:
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	 Teacher:	 Okay, so the question is: just what it going on here? Why do we have a “family 
of curves” from our original equation: ​ dy

 ___ 
dx

 ​ = x?

	 Prompt:	 Think about the effect that the constant c has on our curves? Does it affect their 
gradient at each x value? Why not? So how many original functions, in the form 
y = , could we get from ​ dy

 ___ 
dx

 ​ = x?

	Ideal Response:	 All the constant does is to translate the curve up and down. The gradient at 
any given x point remains the same on all of the curves. All ​ dy

 ___ 
dx

 ​ = x tells us is the 
gradient of the function at each x value. It tells us nothing about the position of 
the function, and hence we could draw an infinite number of functions having 
been told ​ dy

 ___ 
dx

 ​ = x.

	 Teacher:	 Excellent. And we can show this even more clearly using vectors…

Click on Point Mode and place a point somewhere on the red curve which 
passes through origin.

Right-click and select Vector from the menu.

Enter the vector ​( 0   
1
 )​ and click OK.

Your screen should look something like this:

Use the left-right buttons on the keyboard to move along the curve.
Use the up-down buttons to jump between curves.

Point out that since the gradient does not depend on y, lines which start a cer-
tain distance apart vertically, remain the same distance apart.

	 Teacher:	 Now, equations that contain terms like ​ dy
 ___ 

dx
 ​ are called differential equations. 

And if you are given no more information, then you end up with a family of 
curves like we have here, all of which are in the form y = ½ x² + c. So, what we 
actually say is that the general solution to our differential equation is y = ½ x² + 
c.

Give the students a few moments to digest this, before moving on.

Activity 3: Particular Solutions

	 Teacher:	 Okay, let’s make life a little more difficult. Imagine you were asked to find the 
particular solution to the differential equation ​ dy

 ___ 
dx

 ​ = x, given that when x = 1.3, y 
= −1.6. How would we do that?

	 Prompt:	 What is the general solution? How would that help us find the particular solu-
tion? Look at the family of curves if it helps you.

	Ideal Response:	 General Solution: y = ½ x² + c
When x = 1.3, y = −1.6
So: −1.6 = ½ (−1.3)² + c
c = −2.445
So, the particular solution to this differential equation is: y = ½ x² − 2.445
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	 Teacher:	 Sounds good, but let’s just check…

Enter the point (−1.5, 4.75).

Turn on Slow Plot mode.

Enter the equation: y = ½ x² – 2.445

The curve should appear on the screen passing through the point.

Your screen should look something like this:

Ideas for Further Work	

Further practice finding the general solutions and particular solutions of •	
other differential functions, both in the form: ​ dy

 ___ 
dx

 ​ = g(x) and f(y)​ 
dy

 ___ dx ​ = g(x).

Differential functions involving •	 e and natural logs.

Forming differential equations.•	

Using differential equations to help solve exponential growth and decay •	
problems.

Note: Once students’ have acquired the necessary skills to solve them, it would 
be quite nice to use Autograph to show them the family of curves for other dif-
ferential equations. The following three are particularly nice:

​ 1.	
dy

 ___ dx ​ = ​ x __ y ​ → y² = x² + c

​ 2.	
dy

 ___ dx ​ = ​ 
y
 __ x ​ → y = ax

​ 3.	
dy

 ___ dx ​ = xy → y = A​e​½x²​
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T12
Teacher
Demonstration

Understanding the Binomial
Approximation

Learning Objectives	

To obtain a graphical representation of the approximation to the Bino-•	
mial Expansion: (1 + x)ⁿ for each of the three cases where n is positive, 
fractional, and negative.

To be able to understand how and why accuracy is changed by expanding •	
to higher powers of x.

To understand why•	  lxl < 1 if n is negative or a fraction, introducing the 
concept of divergence.

To reinforce the features to look out for when attempting to visualise the •	
shape of a function, recapping work on Transformations.

To re-enforce and consolidate the skill of calculating binomial expansions •	
algebraically.

Required Pre-Knowledge	

To know how to expand expressions in the form •	 (1 + x)ⁿ up to a given 
power of x, where n can take any value, including negative and fractional.

To be comfortable working with indices.•	

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

Select Whiteboard Mode.

For this activity, you will need to set up three pages, each containing a set of 
axes, as follows:

Page - 1:

Edit the axes as follows:
x:	 Minimum:	 −3	 Maximum:	 3	 Numbers:	 1	 Pips:	 0.25
y:	 Minimum:	 −10	 Maximum:	 10	 Numbers:	 2	 Pips:	 1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

Your screen should look something like this:
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Page - 2:

Open another blank 2D Graph Page.

Edit the axes as follows:
x:	 Minimum:	 −4	 Maximum:	 4	 Numbers:	 1	 Pips:	 0.5
y:	 Minimum:	 −6	 Maximum:	 6	 Numbers:	 1	 Pips:	 1

Remove all of the green ticks underneath Auto.

Your screen should look something like this:

Page - 3:

Open another blank 2D Graph Page

Edit the axes as follows:
x:	 Minimum:	 −3	 Maximum:	 3	 Numbers:	 1	 Pips:	 0.25
y:	 Minimum:	 −10	 Maximum:	 10	 Numbers:	 2	 Pips:	 1

Remove all of the green ticks underneath Auto.
Your screen should look something like this:
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Your three pages are now available as Tabs on the top of the screen and can be 
accessed any time by simply left-clicking on them.

Step-by-Step Instructions	

Activity 1: Positive Powers of n

Open Page 1 by left-clicking on the tab.

	 Teacher:	 Okay, I am going to draw the equation y = (1 + x)ⁿ, and set the value of n to 1. 
What will the graph look like?

	Ideal Response:	 When n = 1, the equation just becomes y = x + 1, which is a straight line, with 
gradient 1, passing through the point (0, 1).

Enter the equation: y = (1 + x)ⁿ
Note: To enter n as a power, press “alt n” together, or type “^n”

The graph of y = x + 1 should now appear on the screen.

Left-click on the curve (it should turn black)

Click on the Thick Line tool, and choose a thickness of 2¼ points. This will 
help the line stand out more later on.

Click on Text Box.
Delete the words “Equation 1: ”, so you are just left with the red text.
Tick the box next to Show Detailed Object Text.
Click OK.

The equation of the function, along with the current values of n should now be 
displayed.

Click on the Constant Controller.
The up-down buttons adjust the value of the constant.
The left-right buttons adjust the value of the step.
Adjust the value of the step to 1.

	 Teacher:	 If I increase the value of n from 1 to 2, what would my graph look like then?

	 Prompt:	 No need to expand the brackets. Think what the y = (x + c)² form of an equation 
tells you. Think back to our work on Transformations.  

	Ideal Response:	 The equation of the function is y = (x + 1)², which is just the graph of y = x², 
translated 1 unit to the left.

Click the up button of the Constant Controller to show the students they are 
correct.

Your screen should look something like this:

	 Teacher:	 And now if I was to increase the value of n from 2 to 3, what would my graph 
look like then?

	 Prompt:	 Again, think about Transformations. What points do you know definitely lie on 
the line?

	Ideal Response:	 The equation of the function is y = (x + 1)³, which is just the graph of y = x³, 
translated 1 unit to the left.

Click the up button of the Constant Controller to show the students they are 
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correct.

Note: You can continue this process for the next three powers of x if you feel 
the class would benefit from it, or simply click through them quickly. When 
getting them to predict the shapes of the functions, have them think about 
what points they know lie on the curve (it is worth pointing out that every 
function passes through (0, 1) just as the non-translated functions all passed 
through the origin). Also, have the students think about whether really large 
values of x give positive or negative values of y.

Click the up button of the Constant Controller so that n = 6.

Close the Constant Controller.

Your page should look like this:

	 Teacher:	 Okay, first challenge. I would like you to completely expand the equation y = (1 
+ x)⁶.

	 Prompt:	 How do we do the Binomial Expansion?

Note: If the Binomial Expansion has been taught using Pascal’s Triangle co-effi-
cients, then it might be a good idea to quickly draw Pascal’s triangle somewhere 
on the board.

Alternative, if the Binomial Expansion has been taught by using the formula:

(1 + x)ⁿ = 1 + nx + ​ 
n(n − 1)x²

 ________ 2×1  ​ + ​ 
n(n − 1)(n − 2)x³

  _____________ 3×2×1  ​ + …

then this too could be prominently displayed to help students out. 

	Ideal Response:	 The compete expansion of y = (1 + x)⁶ is: y = 1 + 6x + 15x² + 20x³ + 15x⁴ + 6x⁵ + 
x⁶

	 Teacher:	 Good. Now, often in exam questions, they only ask you to expand the expres-
sion for the first few terms. They usually say something like “expand in ascend-
ing powers of x, up to the term in x³…”.  Because we are not using all the terms, 
these expansions are only approximate. Well, let’s see just how accurate these 
approximate expansions actually are.

	 Teacher:	 Firstly, looking at our expansion, what would be a linear approximation to y = 
(1 + x)⁶?

	 Prompt:	 What is the highest power of x in a linear transformation? So, how many terms 
do we take from our expansion?

	Ideal Response:	 A linear approximation would involve all terms with powers of x equal to one 
or less, and so it would be y = 1 + 6x.

	 Teacher:	 Good. Well, let’s see how close an approximation that is to our curve:

Click on Slow Plot mode.

Enter the equation: y = 1 + 6x

Your screen should look something like this:

	 Teacher:	 So, how good an approximation is y = 1 + 6x?

	 Prompt:	 For what values of x does it seem to be a good approximation?

Use the Drag and Zoom In functions to get a closer look at what is going on. 
Notice how the scale automatically adjusts.
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Return to the original view of the graph.

Note: Pressing the Undo button  several times is often a quicker way of doing 
this.

	Ideal Response:	 It seems like a good approximation for x values between −0.1 and 0.1, but a 
poor approximation for everything else.

	 Teacher:	 Okay, let’s try and improve things. What would be a quadratic approximation 
to y = (1 + x)⁶?

	Ideal Response:	 A quadratic approximation would involve all terms with powers of x equal to 
two or less, and so it would be y = 1 + 6x + 15x².

Make sure Slow Plot mode is still on.

Enter the equation: y = 1 + 6x + 15x²

Note: To enter the squared term, either use the little 2, press “alt 2” together, or 
type “xx”.

Press Pause Plotting both to stop the process and to resume it to focus on the 
key features of the graph.
Note: The Spacebar can also be used to serve this function.

Your screen should look something like this:

	 Teacher:	 Does this seem like a better approximation? What values of x does this seem a 
good approximation?

Again make use of the Zoom and Drag functions, always remembering to re-
turn to your original view of the graph using Undo.

Enter the cubic approximation: y = 1 + 6x + 15x² + 20x³

And then enter the quadratic approximation: y = 1 + 6x + 15x² + 20x³ + 15x⁴

Your screen should look something like this:

Use the Zoom Out y function, left-clicking close to the origin to get a better 
view of the graph. Draw the students’ attention to how the scale is automati-
cally adjusting.

Your screen should look something like this:
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Use the Drag tool to have a look at both sides of the graph. Follow the graph for 
large (positive and negative) values of x. Zoom Out even further if it helps. Ask 
the students which part of the graph they want to have a look at, or even get 
them up to the front to use the Drag tool themselves.

	 Teacher:	 Does anybody have any comments about the graphs? Why do you think the 
graph appears to give a poor approximation for large and small values of x?

	Prompts for discussion:	 Look at the graphs at different values of x. Which terms of the original 
function are omitted when using the binomial approximation? Why are these 
more significant for larger and smaller values of x? Point out that usually, when 
using the binomial we are asked to use very small values of x, and so in terms 
of an approximation, many of these graphs actually seem quite good. Introduce 
the ideas of convergence and divergence. Notice how the cubic and linear graphs 
seem to be diverging for negative values of x. Encourage the students to think 
why this might be the case. Point out that whilst the other approximations ap-
pear a long way away from the original graph of y = (1 + x)⁶, at least they are 
“heading in the right direction”. This will be very important for the next two 
examples.

Activity 2: Fractional Powers of n

Open Page 2 by clicking on the tab.

Ensure you are working in Select Mode.

	 Teacher:	 Okay, still working with the y = (1 + x)ⁿ graph, we are now going to look at 
changing the value of n, to see what effect, if any, that has on the accuracy of 

our approximations. We have seen the shapes of the graph for various positive 
values of n, so now let’s try some fractions! Does anybody have any idea what 
the graph would look like if I changed the value of n to ​ 1 __ 

3
 ​? Come up and sketch 

it if you are feeling brave!

	 Prompts:	 What does “to the power of a third” actually mean? Can anybody think of a 
couple of points which we know must lie on the line? Where does the graph 
cross the axes? What happens to the graph for really large values of x? Does the 
x exist for negative values of x?

Encourage students to come to the front to sketch the curve or mark on their 
points using the Scribble Tool.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph itself and select De-
lete Objects from the menu).

	 Teacher:	 Let’s have a look…

Click on Slow Plot mode.

Enter the equation: y = (1 + x​)​​ 
1
 __ 3 ​​

Note: To enter “to the power of one third”, type: “^ (1/3)”

Click OK, and the curve should begin to plot, hopefully resembling the curves 
drawn by the students.

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key features of the graph. Discuss the shape and the points 
where the graph crosses the axes.

When the curve has finished plotting, delete all scribbles as described above.

Left-click on the curve (it should turn black).

Click on the Thick Line tool, and choose a thickness of 2¼ points.

Your screen should look something like this:
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	 Teacher:	 Okay, your turn again. I would like you to expand the equation y = (1 + x​)​​ 
1
 __ 3 ​​ as 

far as the term in x³. And remember to simplify any fractions as much as pos-
sible.

	 Prompt:	 Again, a reminder of the formula might be handy, reminding the students to 
keep an eye on all those negative signs!

(1 + x)ⁿ = 1 + nx + ​ 
n(n − 1)x²

 ________ 2×1  ​ + ​ 
n(n − 1)(n − 2)x³

  _____________ 3×2×1  ​ + …

	Ideal Response:	 The expansion of y = (1 + x​)​​ 
1
 __ 3 ​​ as far as the term in ​x​3​ is y = 1 + ​ 1 __ 3 ​x − ​ 1 __ 9 ​x² + ​ 5 ___ 81 ​x³.

	 Teacher:	 Good. Now, we are going to do the same thing as before. I will begin by plotting 
the linear approximation, then the quadratic, and then the cubic, and see how 
good an approximation to the original line these are…

Ensure Slow Plot mode is still on.

Enter the equation: y = 1 + ​ 1 __ 3 ​x

Enter the equation: y = 1 + ​ 1 __ 3 ​x + ​ 1 __ 9 ​x²

Enter the equation: y = 1 + ​ 1 __ 3 ​x + ​ 1 __ 9 ​x² + ​ 5 ___ 81 ​x³

Note: To enter fractions, use the forward slash / key, and remember the brack-
ets. For example, to type ​ 5 ___ 

81
 ​x³, you could write “(5/81) xxx”.

Each time an equation is being plotted, press Pause Plotting (or the Spacebar) 
both to stop the process and to resume it to focus on the key features of the 
graph. Give the students time to comment and discuss.

In the end your screen should look something like this:

	 Teacher:	 Does anybody have any comments about the approximations this time.

	Prompts for discussion:	 Look at the graphs at different values of x. Again, point out that usu-
ally, when using the binomial we are asked to use very small values of x, and so 
in terms of an approximation, many of these graphs actually seem quite good. 
However, also focus on large (positive and negative) values of x…

Use Zoom Out tool centred on the origin to help the students get a good grasp 
of what is going on.

Your page should look something like this:
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	 Teacher:	 Does anybody have any further comments about the approximations?

	Prompts for discussion:	 How would you describe what is happening to the approximations for 
really big or really small values of x? Emphasis the divergence, and contrast this 
with what was happening in the previous example on Page 1. Use the tabs at 
the top of the screen to quickly flick between pages.

Use the Drag tool to have a look at both sides of the graph. Follow the graph for 
large (positive and negative) values of x. Zoom Out even further if it helps. 

Press the Undo button several times to return to the original view of the graph.

	 Teacher:	 So, looking at our graph, if n is a fraction, what values of x should we limit our 
approximations to?

	Ideal Response:	 Values of x between −1 and 1.

Activity 3: Negative Powers of n

Open Page 3 by clicking on the tab.

Ensure you are working in Select Mode.

	 Teacher:	 Okay, still working with the y = (1 + x)ⁿ graph, we are now going to try negative 
values of n. Now, the value in particular that I want us to look at is when n = −5. 
Does anybody have any idea what on earth the graph of y = (1 + x)⁻⁵ would look 
like? Come up and sketch it if you are feeling brave!

	 Prompt:	 What does “to the power minus five” actually mean? How else could we write 
it? Are there any values of x for which the curve is undefined? Can anybody 

think of a couple of points which we know must lie on the line? What happens 
to the graph for really large and really small values of x? Does the graph ever 
touch the x-axis?

Encourage students to come to the front to sketch the curve or mark on their 
points.

Use the Erase tool to rub out any mistakes.

If you want to get rid of all scribbles, click on Edit > Select All Scribbles, and 
press delete on the keyboard (or Right-click on the graph itself and select De-
lete Objects from the menu).

	 Teacher:	 Let’s have a look…

Ensure Slow Plot mode is still on.

Enter the equation: y = (1 + x)⁻⁵

Note: To enter “to the power of minus 5”, type: “^(−5)” 

Click OK, and the curve should begin to plot, hopefully resembling the curves 
drawn by the students.

Press Pause Plotting (or Spacebar) both to stop the process and to resume it 
to focus on the key features of the graph. Focus on the asymptote at x = −1, and 
the fact that the graph never crosses the x-axis.

When the curve has finished plotting, delete all scribbles as described above.

Left-click on the curve (it should turn black).

Click on the Thick Line tool, and choose a thickness of 2¼ points.

Your screen should look something like this:
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	 Teacher:	 Okay, your turn again. I would like you to expand the equation y = (1 + x)⁻⁵ as 
far as the term in x⁴. And remember to simplify any co-efficients as much as 
possible.

	 Prompt:	 Again, a reminder of the formula might be handy, reminding the students to 
keep an eye on all those negative signs!

(1 + x)ⁿ = 1 + nx + ​ n(n − 1)x²
 ________ 2×1  ​ + ​ n(n − 1)(n − 2)x³

  _____________ 3×2×1  ​ + …

	Ideal Response:	 The expansion of y = (1 + x)⁻⁵ as far as the term in x⁴ is: 

y = 1 − 5x + 15x² − 35x³ + 70x⁴

	 Teacher:	 Good. Now, we are going to do the same thing as before. I will begin by plotting 
the linear approximation, then the quadratic, then the cubic, then the quartic, 
and see how good an approximation to the original line these are…

Ensure Slow Plot mode is still on.

Enter the equation: y = 1 − 5x

Enter the equation: y = 1 − 5x + 15x²

Enter the equation: y = 1 − 5x + 15x² − 35x³

Enter the equation: y = 1 − 5x + 15x² − 35x³ + 70x⁴

Each time an equation is being plotted, press Pause Plotting (or the Spacebar) 
both to stop the process and to resume it to focus on the key features of the 
graph. Give the students time to comment and discuss.

In the end your screen should look something like this:

	 Teacher:	 Does anybody have any comments about the approximations this time?

	Prompts for discussion:	 Again, it should be clear that for small values of x, the graphs give good 
approximations. However, there is a clear problem on the negative side. Again, 
focus on large (positive and negative) values of x…

Use Zoom Out tool centred on the origin to help the students get a good grasp 
of what is going on.

Your page should look something like this:
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	 Teacher:	 Does anybody have any further comments about the approximations?

	Prompts for discussion:	 Again, ensure the discussion focuses on divergence, and the values of x 
for which the approximation is a reasonable one, and the values for which it is 
not.

Use the tabs to flick between Page 1, Page 2 and Page 3.

	 Teacher:	 Can anybody briefly summarise what the graphs of the binomial approximation 
have shown us?

	 Prompts:	 Think of the three cases in turn, when n is positive, fractional, and negative. 
What values of x make for good approximations? What values of x do not make 
for good approximations? How does this relate to the type of questions we are 
often asked to tackle using the binomial approximation?

	Ideal Response:	 The case where n is positive appears to have the widest range of values of x 
for which we get a reasonable approximation. However, even in this case it 
seems to be that the larger the value of x, the weaker the approximation. This 
is because the larger the value of x, the more significant terms involving higher 
powers of x on our expansion will be, and these terms are often omitted from 
the approximations. For the cases when n is fractional and negative, large and 
small values of x give extremely poor approximations. In fact, in many cases 
the graphs of the approximations appear to diverge quite considerably from 
the graph of the original function. Hence, it is only appropriate to use values of 
x between −1 and 1 for these values of n, and even then (especially in the case 
of negative values of n) we still may not get accurate results. However, gener-
ally we are asked to use values of x extremely close to zero, so our graphs have 
shown us that those approximations should be reasonably accurate.

Ideas for Further Work	

Examples of using the binomial expansion to find approximate answers •	
for things like √1.03 and √26 would follow on nicely from this demonstra-
tion.

If it has not already been covered, look at how the binomial can be used •	
to expand expressions such as (5 + 4x​)​½​.
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T13
Teacher
Demonstration Discovering e

Learning Objectives	

To derive the value of e.•	

To better understand the relationship between functions and their gradi-•	
ent function, including polynomials.

To understand that the gradient function of e is the same as the function •	
itself.

Required Pre-Knowledge	

To understand the concept of the gradient function and of tangents.•	

To be able to derive the gradient functions of quadratic and cubic func-•	
tions using differentiation.

To be comfortable with index notation.•	

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

At the top of the screen go to Page > Edit Settings, and adjust the number of 
significant figures up to 8. This will increase the accuracy of our calculations.

Select Whiteboard Mode.

Edit the axes as follows:
x:	 Minimum: 	-4	 Maximum: 	4	 Numbers:	 1	 Pips:	 0.5
y:	 Minimum:	 -16	 Maximum:	 16	 Numbers:	 2	 Pips:	 1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you.

Enter the equation: y = x²

Note: To enter x², either use the little 2 button, or press “alt 2” together, or 
press “xx”.

At the top of the screen go to Axes > Show Key.

This should make the key at the bottom of the screen disappear.

Note: This can also be done by right-clicking on the Key towards the bottom 
of the screen where it says “Equation 1: y = 8”, and from the menu left-click on 

Show Key.

Your screen should look something like this:

Step-by-Step Instructions	

Activity 1: Polynomials

	 Teacher:	 Just to warm you up, what is the equation of the red line on the screen? 

	 Prompt:	 Think about the various points which lie on the line.

Note: If the students are struggling, it might be a nice idea to add a point to the 
curve as follows:

Left-click on the curve (it should turn black).

Add a point onto the curve with an x value of 0.

Select Text Box from the top toolbar and click OK.

The co-ordinates of the point should now be labelled.

You can then use the left-right arrow keys on the keyboard to move the point 
along the curve and draw the students’ attention to the changing co-ordinates. 
This should help them better see the link between x and y.

When you are finished, ensure that only the point is selected, right-click and 
select Delete from the menu, or simply press delete on the keyboard to clear 
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both the point and the Text Box.

	Ideal Response:	 y = x²

	 Teacher:	 And what is the equation of the gradient function of the line? 

	 Prompt:	 What does the gradient function mean? What technique do we use to find the 
gradient function?

	Ideal Response:	 y = 2x

	 Teacher:	 Good, now let’s watch as Autograph plots the gradient function of the curve by 
calculating the gradient of the tangent at many different points on the curve.

Left-click to select the curve (it should turn black).

Click on Slow Plot mode.

Click on Gradient Function, and click OK.

This should now show how the gradient function is derived by plotting the gra-
dient of tangents to the curve.

Press Pause Plotting both to stop the process, and to resume it (the Spacebar 
on the keyboard can also be used for this).

Note: It is worth emphasising at this stage that the gradient of the curve goes 
from negative to positive, and that this is shown in the y values of the gradient 
function. This is important later.

Your screen should look something like this:

	 Teacher:	 Here’s a question for you. Will there ever be a quadratic function whose gradi-
ent function is identical to the function itself?

	 Prompt:	 Think about what all the gradient functions of quadratic functions have in com-
mon. Think about their shape.

	Ideal Response:	 No, because the gradient function of any quadratic function will always be lin-
ear.

Left-click to ensure the curve is still selected (it should still be black).

Right-click and select Delete Object from the menu, or simply press delete on 
the keyboard.
Note: Don’t worry about the warning message. This is just to inform you that 
the gradient function will also be deleted as it is defined with respect to the 
curve itself.

You should now be left with just your axes.

	 Teacher:	 Would anybody like to predict what the graph of the equation y = x³ + 4x² – 3x 
– 8 would look like? 

	 Prompt:	 Which direction will it slope? Where will it cross the y-axis?

Ensure Slow Plot mode is still turned on.

Enter the equation: y = x³ + 4x² – 3x - 8
Note: To enter x³, either use the little 3 button, or press “alt 3” together, or 
press “xxx”.
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 With the curve selected, choose Text Box from the top toolbar and click OK.
The equation of the curve should now be labelled.

	 Teacher:	 Can you work out the gradient function of this curve? And for an extra chal-
lenge, can you tell me where the gradient function would cross the x-axis? 

	 Prompt:	 Remember, we differentiate each term one at a time. Multiply the whole term 
by the power, and subtract one to get your new power. What must a function 
be equal to when it crosses the x-axis?

	Ideal Response:	 The gradient function is: 3x² + 8x – 3

Factorised this becomes: (3x – 1)(x + 3)

This crosses the x-axis when the function is equal to 0, which occurs when x 
is ​ 1 __ 

3
 ​ and –3.

Ensure the curve is selected (it should be black).

Ensure Slow Plot mode is still on.

Click on Gradient Function, and click OK.

This should now show how the gradient function is derived by plotting the gra-
dient of tangents to the curve.

Press Pause Plotting (or the Spacebar) both to stop the process, and to resume 
it.

Note: Again, emphasise how the gradient of the curve goes from positive to 
negative to positive again, and how this is shown in the gradient function. 

When the gradient function has finished plotting, your screen should look 
something like this:

	 Teacher:	 Okay, so will there ever be a cubic function whose gradient function is identical 
to the function itself?

	 Prompt:	 Think about what all the gradient functions of cubic functions have in com-
mon. Think about their shape.

	Ideal Response:	 No, because the gradient function of any cubic function will always be quad-
ratic.

	 Teacher:	 Good, and can anybody use this to explain why there can never be a polynomial 
whose gradient function is exactly the same as the function itself?

	 Prompt:	 Use your knowledge of how to differentiate polynomials. Think about the pow-
ers. 

	Ideal Response:	 The gradient function of any polynomial will always be of an order one less 
than the function itself, and so the two functions can never be the same as each 
other.

	 Teacher:	 Good, but there are a group of functions whose gradient functions are actually 
very similar to the functions themselves…

Activity 2: y = 2

Left-click to ensure the curve is still selected (it should still be black).

Right-click and select Delete from the menu, or simply press delete on the 
keyboard.

You should now be left with just a set of axes.
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	 Teacher:	 Can anybody tell me what the curve y = 2 would look like?

	 Prompt:	 Tell me some points which are definitely on the curve. Where does the curve 
cross the y-axis? Think about what happens to y as x gets bigger. How about 
when x gets smaller? How about when x is negative? Will the curve ever go 
below the x-axis?

Note: If the students do come up with points which lie on the line, you could 
have them mark those points on the board them using the Scribble Tool, or 
enter them as points using the Enter Co-ordinates tool.

	Ideal Response:	 A curve which starts just above the x-axis for negative values of x, remains rela-
tively flat/horizontal, passes through the point (0, 1), and then continues to get 
steeper and steeper as the value of x increases.

Ensure Slow Plot mode is still turned on.

Enter the equation: y = 2
Note: To enter x as a power, either use the little x button, or press “alt x” to-
gether.

The curve should now start to plot.

Press Pause Plotting (or the Spacebar) both the stop the process, or to resume 
it.

Left-click on the curve when the plotting has finished to ensure the curve is 
selected (it should be black).

Select Text Box from the top toolbar and click OK.
The equation of the curve should now be labelled.

Your screen should look something like this:

Use the Drag and Zoom In functions to emphasise that although the curve gets 
closer and closer to the x-axis for negative values of x, it never actually touches.

Use the Drag and Zoom Out functions to return to the original view of the 
graph.

Note: Pressing the Undo button  several times is often a quicker way of doing 
this.

	 Teacher:	 Can anybody describe the gradient function of this curve?

	 Prompt:	 Is the gradient ever negative? Think about the gradient when x is negative. 
What is happening to the gradient as x increases?

A good way to illustrate these points is to have a moving tangent as follows:

Add a point on the left hand side of the curve, somewhere between x = −4 and 
x = −3.
Note: The cross will turn into an arrow sign when the pointer is over the curve.

Right-click and select Tangent from the menu.

This should display the tangent to the curve at that given point.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click to select the tangent (it should turn black). 

Select Text Box from the top toolbar and click OK.

T13 Discovering e T13 Discovering e



196 197

The equation of the tangent should now be labelled.

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the point you placed on the curve (it should have a square around 
it).

You can now use the left-right arrows on the keyboard to change the position 
of the point.

Draw the students’ attention to the effect it is having on the gradient of the 
tangent.

Get them to imagine the gradient function as the point moves from left to right 
along the curve.

	Ideal Response:	 The gradient function is pretty similar to the function itself. It is a curve which 
starts just above the x-axis for negative values of x, remains relatively flat/hori-
zontal, and then continues to get steeper and steeper as the value of x increases.

	 Teacher:	 Sounds good. Let’s have a look…

Left-click on an unoccupied part of the graph area to de-select everything.

Left-click on the curve (it should turn black).

Make sure Slow Plot mode is still turned on.

Click on Gradient Function, and click OK.

This should now show how the gradient function is derived by plotting the gra-
dient of tangents to the curve.

Press Pause Plotting (or the Spacebar) both the stop the process, or to resume 
it.

Your screen should look something like this:

	 Teacher:	 Now, we can see that the gradient function is pretty similar to the function 
itself. But it is not identical. I wonder if it is possible to find a “special function” 
in the same form as y = 2, but whose gradient function is identical to the func-
tion itself…

Activity 3: In Search of that Special Function

Go to Edit in the top toolbar, then Select All, and then press delete on the key-
board.

All lines and text boxes should now have disappeared, leaving you with the set 
of axes again.

Make sure Slow Plot mode is turned off.

Enter the equation: y = a
Still on the Add Equation screen, click on Edit Constants.
Set the value of a to 2 and click OK twice.
This ensures you still have the same graph on the screen as before.

Click on Gradient Function, and click OK.

	 Teacher:	 Okay, so here we have the graph of y = a where a = 2 as before. As you can see, 
we got pretty close to finding our “special function”, so now let’s try some other 
values of a… 

Click on the Constant Controller.
You can now adjust the value of a.
The up-down buttons adjust the value of a.
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The left-right buttons adjust the size of the step.
The current value of a is recorded in the Constant Controller.

	 Teacher:	 What do you think would happen to the graph of the function and the graph of 
the gradient function if I decreased the value of a?

	 Prompt:	 Try some different values of x and a in your head. What happens to the func-
tion?

	Ideal Response:	 The function itself would become flatter/less steep as the y values decrease, and 
so the gradient function would also become flatter.

Keeping the value of the step at 0.1, slowly decrease the value of a, focussing on 
the slope of the curve. Stop when a = 1.5.

	 Teacher:	 What do you notice about the function and the gradient function?

	Ideal Response:	 They are getting further away from each other.

	 Teacher:	 Incidentally, can anybody tell me what happens to the curve when a = 1, and 
what the gradient function would look like?

	 Prompt:	 We get the graph of y = 1. Try some different values of x. What do you notice? 
What does this mean for the shape of the graph? How about for the shape of 
the gradient function?

	Ideal Response:	 We end up with a horizontal line, passing through the point (0, 1) or a line with 
the equation y = 1, because 1 to the power of anything is always 1. The gradient 
of this line would always be 0, so that gradient function would have the equa-
tion y = 0, which is the equation of the x-axis!

Use the Constant Controller to reduce the value of a to 1 to confirm this to the 
students.

	 Teacher:	 Okay, so it looks like we need to increase the value of a to find our special func-
tion…

Keeping the value of the step at 0.1, slowly increase the value of a, drawing the 
students’ attention to the slope of the two curves.

Your screen should look something like this:

	 Teacher:	 Here’s a question for you. Why do all these curves seem to be passing through 
the same point on the y-axis?

	 Prompt:	 What is the value of x at this point?

	Ideal Response:	 x is equal to zero, and anything to the power of zero is equal to 1, so a will 
always be 1 at this point.

Draw the students’ attention to the fact that the curve and the gradient func-
tion are getting closer together as the value of a increases.

Keep increasing the value of a by the same step (0.1) until you get to 2.7.

	 Teacher:	 Well, this looks pretty close, but let’s zoom in and take a closer look.

Use the hand and zoom functions to look closer at a portion of the curve, 
somewhere between the values of x = 2 and x = 2.5.

	 Teacher:	 The curves are certainly close, but as we can see, they are not touching.

Adjust the size of the step to 0.01 and increase the value of a some more.

Each time the curves appear to be touching, zoom in some more and adjust the 
step.

Draw students attention to the scale on the axes, emphasising just how small 
the numbers are getting.

Use Undo if you ever lose the graph!

Your screen should look something like this:
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Keep zooming in and adjusting the step as much as you feel necessary.

	 Teacher:	 Now, we could keep going and going trying to find the exact value of a which 
would make the function and the gradient function perfectly coincide, but 
we would be going forever. In fact, if we did keep zooming in, eventually the 
computer would fail as no amount of decimal places would ever describe the 
number perfectly. That is because the “magic number” itself is actually irration-
al. We have found a pretty good approximation to it here, and thankfully the 
number itself has a special, and far easier to remember, name than 2.71828… 
That number is called e.

In the Constant Controller, change the current value of a to “e”.

The two curves should now lie perfectly on top of each other.

Use the hand and the Zoom Out tools to return to the original view of the 
graph.

	 Teacher:	 Yes, the gradient function of y = e is exactly the same as the function itself, 
making functions involving e incredibly important in mathematics. 

	 Teacher:	 So, can anybody differentiate y =e with respect to x… 

Ideas for Further Work	

The students should now be in a strong position to start differentiating •	
functions involving e.

This activity could also be linked into work on exponential growth, and is •	

also a good introduction to the logarithmic function - see Teacher Dem-
onstration 14: The Natural Log Function.
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T14
Teacher
Demonstration

Discovering the Natural Log
Function

Learning Objectives	

To understand the importance of the natural log function.•	

To build up a picture of the natural log function using the graph of •	 y = ​ 1 __ x ​, 
and hence deduce its role in integrating y = ​ 1 __ x ​.

To reinforce the importance of constants when integrating functions.•	

To appreciate the important link between •	 e and the natural log function.

To look at the functions •	 y = ln(−x) and y = ln(lxl).

To begin to look at integrating functions using natural logs. •	

Required Pre-Knowledge	

To know how to integrate functions involving both positive and negative •	
powers of x.

To understand the role of the constant in integration.•	

To be able to use integration to find the area underneath a curve.•	

To have encountered the value •	 e before – see Teacher Demonstration 13: 
Discovering e.

Pre-activity Set-up	

Open up Autograph in Advanced Mode and ensure you have a blank 2D 
Graph Page.

Select Whiteboard Mode.

On the top toolbar click on Page > Edit Settings.
Change the number of significant figures to 8 to improve accuracy.

Edit the axes as follows:
x:	 Minimum:	 −6	 Maximum:	 6	 Numbers:	 1	 Pips:	 0.5
y:	 Minimum:	 −12	 Maximum:	 12	 Numbers:	 2	 Pips:	 1

Remove all of the green ticks underneath Auto.
Note: You must ensure all the ticks under Auto are removed or Autograph will 
attempt to re-scale your axes for you. 

Enter the equation: y = x³
Note: To enter the cubed either use little 3 button, press “alt 3” together, or 
type “xxx”. 

On the top toolbar click on Axes, and then Show Key.

This should remove the key from the bottom of the screen.

Your screen should now look something like this:

In a prominent place at the front of the room (possibly on another whiteboard, 
or on a large piece of paper) make a copy of the following table:

Gradient Function Function

Step-by-Step Instructions	

Activity 1: Finding the Functions

	 Teacher:	 Okay, let’s start with something nice and easy. What is the name of the function 
drawn on the board?
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	 Prompt:	 Think about the shape. Think about which points it passes through.  

Note: If the students are struggling, it might be a nice idea to add a point to the 
curve as follows:

Left-click on the curve (it should turn black).

Add a point onto the curve with an x value of 0.

Select Text Box from the top toolbar and click OK.

The co-ordinates of the point should now be labelled.

You can then use the left-right arrow keys on the keyboard to move the point 
along the curve and draw the students’ attention to the changing co-ordinates. 
This should help them better see the link between x and y.

When you are finished, ensure that only the point is selected, right-click and 
select Delete from the menu, or simply press delete on the keyboard to clear 
both the point and the Text Box.

	Ideal Response:	 y = x³

	 Teacher:	 Good. Right, something a little more difficult. If y = x³ was the gradient func-
tion of a certain function, what might that function be?

	 Prompt:	 What does gradient function mean? How do we work out gradient functions? 
So, if we already know what the gradient function is, how might we work out 
the original function? Might integration help?

Possible Response: y = ¼x⁴

	 Teacher:	 And is that the only possibility? Are there any other functions which might give 
us a gradient function of y = x³? Think about what we must also include when 
integrating?

	Ideal Response:	 y = ¼x⁴ + c

	 Teacher:	 Good. Now, let’s just take a look at that, and in particular let’s make sure we are 
happy with the role that the constant plays…

Click on Slow Plot mode.

Click on the Integral Function tool, and click OK.

Nothing should appear on the screen, as Autograph is waiting for you to select 
the initial values of x and y for each solution.

Left-click on the point (0, 0).

This should give you the graph of y = ¼x⁴.

	 Teacher:	 Thinking about what we have just said, what is the equation of this function?

	 Prompt:	 Think about what points the graph goes through. What is the significance of 
the fact that it passes through the origin? 

	Ideal Response:	 y = ¼x⁴

	 Teacher:	 Good. Now, how about this one?

Left-click on the point (0, 2).

This should give you the graph of y = ¼x⁴ + 2.

	Ideal Response:	 y = ¼x⁴ + 2

	 Teacher:	 And this one?

Left-click on the point (0, −6).

This should give you the graph of y = ¼x⁴ − 6.

Your screen should look something like this:

	 Teacher:	 Now, think about the equations of those three functions. Do you agree that if 
you differentiated each of them, you would always arrive at the same gradient 
function, namely: y = x³?

	Ideal Response:	 Yes!

	 Teacher:	 And can somebody just remind us why that is the case, graphically?

	 Prompt:	 Look at the family of graphs. Think about the gradient of the curves for any 
given x value. 
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	Ideal Response:	 The effect of the constant is simply to translate the curves up and down. The 
gradient at any given x value remains the same, and so the gradient function 
remains the same.

	 Teacher:	 Good. Now, the other thing I want to draw your attention to is the fact that we 
could have predicted the shape of the original function even if we didn’t know 
how to integrate. Thinking about the gradient function (y = x³) can anybody tell 
us how?

	 Prompt:	 What does the shape of the gradient function (y = x³) tell us about the shape 
of the original function? Think about some of the points on the gradient func-
tion, in particular the y values, and what they mean for the graph of the original 
function.

	Ideal Response:	 The gradient function (y = x³) starts off negative between x = −2 and x = 0. This 
tells us that the function itself must start by sloping downwards, which it does. 
Similarly, the gradient function has a y value close to zero around the origin, 
which tells us that when x is close to zero, the function itself must have a gradi-
ent of zero, and hence be relatively flat. Finally, when x is positive, the gradi-
ent function is also positive, which tells us that the function itself must slope 
upwards.

	 Teacher:	 Good. Now, let’s just make a quick note of our findings in this table:

Gradient Function Function
y = x³ y = ¼x⁴ + c

Ensure you are in Select Mode.

Go to Edit on the top toolbar, then Select All, and then press delete on the 
keyboard (or alternatively right-click on any point on the graph area and select 
delete from the menu).

This should leave your screen clear apart from the set of axes.

Enter the equation: y = x²

Note: To enter the squared either use little 2 button, press “alt 2” together, or 
type “xx”. 

	 Teacher:	 Right, no prizes for telling me that this is the graph of y = x² . What I want to 
know is that if this was in fact the graph of a gradient function of a certain 
function, what might that function be?

	Ideal Response:	 y = ⅓x³ + c

Proceed in a similar manner as described above:

Make sure Slow Plot mode is on.

Click on the Integral Function tool, and click on points on the y-axis to plot a 
family of functions which all share the same gradient function.

Draw the students’ attention to the relationship between the functions them-
selves and the gradient function (y = x²), namely how it is possible to determine 
the shape of the function by looking carefully at the gradient function. This will 
be important later on.

When complete, your page should look something like this:

Fill in the table:

Gradient Function Function
y = x³ y = ¼x⁴ + c

y = x² y = ⅓x³ + c
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	 Teacher:	 Okay, so now all I want you to do is to try to fill in the rest of the table yourself 
using the following gradient functions on the left:

Gradient Function Function
y = x³ y = ¼x⁴ + c

y = x² y = ⅓x³ + c

y = x

y = x⁰

y = x

y = x⁻²

y = x⁻³

Allow the students sufficient time to complete this task. 

If any functions are proving particularly difficult (apart from y = x of course!), 
then it might be useful to repeat the above method using Autograph to illus-
trate the original functions and their relation to the gradient function to the 
students.

Spending a couple of minutes discussing the case of y = x⁰ might also prove 
useful.

The completed table should look like this:

Gradient Function Function
y = x³ y = ¼x⁴ + c

y = x² y = ⅓x³ + c

y = x y = ½x² + c

y = x⁰ y = x + c

y = x ?
y = x⁻² y = −x + c

y = x⁻³ y = −½x⁻² + c

Activity 2: The Mystery Function

	 Teacher:	 Okay, so we seem to have a problem with y = x. Can somebody just quickly 
explain what the problem seems to be?

	Ideal Response:	 When we integrate, we usually add one on to the power, and then divide by the 
new power. But that would mean we were dividing by zero!

	 Teacher:	 Okay, let’s have a look at this function more closely to see if we can figure out 
what is going on. Can anybody describe what the graph of y = x looks like?

	 Prompt:	 Think about how else we could write the function. Are there any values of x for 

which the function is undefined? What happens to the function for really big 
(both positive and negative) values of x? What happens when x is close to zero?

	Ideal Response:	 The graph is undefined when x = 0, meaning x = 0 is an asymptote. When x is 
really big (both positive and negative), y is really small, and when x is close to 
zero, y is really big.

	 Teacher:	 Good. So let’s look at the graph…

Ensure you are in Select Mode.

Go to Edit on the top toolbar, then Select All, and then press delete on the 
keyboard (or alternatively right-click on any point on the graph area and select 
Delete from the menu).

This should leave your screen clear apart from the set of axes.

Make sure Slow Plot mode is still turned on.

Enter the equation: y = x.
Note: To enter the minus one either use little −1 button, or type “^(−1)”

Press Pause Plotting both to stop the process and to resume it (the Spacebar 
on the keyboard can also be used for this).

Your screen should look like this:

	 Teacher:	 Okay, so it seems we cannot use our normal method of integration to work out 
what function y = x is the gradient function for. But can we at least use the 
graph of y = x to describe what our actual function will look like? And to make 
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matters easier, let’s focus on just the positive values of x.

	 Prompt:	 Think about the y values of the gradient function for given x values. What do 
they tell you about the shape of our function? Think about the asymptote of the 
gradient function? What does that tell you about the function itself?

	Ideal Response:	 For positive values of x, the gradient function is always positive, and so the 
function itself must always slope upwards. However, the y values of our gradi-
ent function are falling as x increases, which suggests that the function itself 
will start off very steep around x = 0, and then gradually begin to flatten out. 
Also, because our gradient function is not defined for x = 0, the function itself 
must not be defined for x = 0 either.

	 Teacher:	 Excellent. Well, let’s use Autograph to take a look at the family of functions…

Click on the Integral Function tool, and click OK.

Again, select three or four initial values of x and y along the x-axis.

As the functions begin to appear, discuss their shape and relate this back to the 
shape of the gradient function.

Your screen should look something like this:

	 Teacher:	 Now, this family of functions are incredibly important in mathematics, and 
they have a special name. They are called the natural logarithms, and they are 
all in the form of y = ln(x) + c. Let’s clear away the family of curves, and look at 
y = ln(x) in particular.

Activity 3: y = ln(x)

Turn off Slow Plot mode.

Click on Manage Equation List.

Select Integral Function from the list and click the red cross in the corner.

The equation should be removed form the list and when you click okay, you 
should just be left with y = x.

Turn Slow Plot mode back on.

Enter the equation: y = ln(x)

The curve should begin to plot.

Press Pause Plotting (or the Spacebar) both to stop the process and to resume 
it to focus on the key properties of the graph.

Your screen should now look like this:

	 Teacher:	 Now, this function has some very important features. Firstly, what is the value 
of ln(x) when x is 1?

	Ideal Response:	 0

	 Teacher:	 And for what values is y = ln(x) negative?

	Ideal Response:	 When x is between 0 and 1.

	 Teacher:	 And how about when x = 0?

T14 Discovering the Natural Log Function T14 Discovering the Natural Log Function



212 213

	Ideal Response:	 The curve is undefined.

	 Teacher:	 And last but not least, what value of x makes ln(x) equal 1? 

	Ideal Response:	 Somewhere between 2.5 and 3.

	 Teacher:	 Well, let’s just take a closer look at that point as it is very important.

Enter the equation: y = 1

Use the Zoom In Box tool to focus on the point of intersection of y = 1 and y = 
ln(x).

Do this several times, getting closer and closer, pointing out to the students 
how the scale is automatically adjusting.

Your screen should look something like this:

	 Teacher:	 Does anybody recognise the value we are honing in on?

	Ideal Response:	 e.

	 Teacher:	 Let’s have a look…

Ensure you are in Select Mode.

Left-click on the curve y = ln(x) (it should turn black).

Enter the point with x co-ordinate: e

A point should appear at the intersection.

Use the Zoom In tool to zoom in even further to convince the students that 
this is the point of intersection.

	 Teacher:	 So, what does ln(e) equal?

	Ideal Response:	 1

	 Teacher:	 So, to summarise: ​∫ 
 
 ​ 

 

 ​ ​ 1 __ x ​​ dx = ?

	Ideal Response:	 ln(x) + c

	 Teacher:	 And: ​ d __ 
dx

 ​(ln(x)) = ? 

	Ideal Response:	​  1 __ x ​

	 Teacher:	 Brilliant. But that just leaves on question: what about the left hand part of y = 
x?

Activity 4: y = ln(−x) and y = ln(|x|)

Turn Slow Plot off.

Hit Undo as much as needed to return to the original view of the axes, and just 
the functions y = x and y = ln(x).

	 Teacher:	 If the left hand portion of this graph is the gradient function, can anybody 
guess what the function itself might be?

	 Prompt:	 It has something to do with natural logs.

Possible Response: y = −ln(x)

	 Teacher:	 Think back to our work on Transformations. What effect does the transforma-
tion −f(x) have on the graph?

	Ideal Response:	 y = ln(−x)

	 Teacher:	 Well, let’s check…

Turn Slow Plot mode on.

Enter the equation: y = ln(−x)

	 Teacher:	 Now, if we are correct, then the gradient function of this graph should be the 
left hand side of the y = x graph…

Click on Gradient Function and press OK.

The gradient function will now be plotted exactly over the left hand portion of 
the graph of y = x.

Your page should look something like this:
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	 Teacher:	 And last but not least, can anybody think of a single function, which when we 
plot the gradient function will give us the entire graph of y = x?

	 Prompt:	 Think about how to counter the positive/negative problem.

	Ideal Response:	 y = ln(lxl)

	 Teacher:	 Well, let’s check…

Enter the equation: y = ln(lxl)

Note: To enter the modulus signs, just click the button with the vertical lines.

When then function has finished plotting…

Click on Gradient Function and press OK.

The gradient function will now be plotted exactly over both portions of the 
graph of y = x.

Your page should look something like this:

Ideas for Further Work	

Looking at integrating functions like ​•	 ∫1​ 
3​ ​ 1 __ x ​​ dx, ​∫2​ 

6​ ​ 5 __ x ​​ dx, ​∫−5​ 
−2​ ​ 1 __ x ​​ dx, ​∫0​ 

5​ ​  1
 ____ x − 4 ​​ dx, ​

∫2​ 
3​ ​  2

 _____ 4 − 3x ​​ dx.

Differentiating functions involving natural logs.•	

Looking at log functions with different bases.•	

Inverse functions.•	

Laws of logs.•	

Solving equations by taking logs.•	
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T15
Teacher
Demonstration

Laws of Logs : A Graphical 
Approach

Learning Objectives	

To introduce the log function•	

To use an interactive method to derive the following Laws of Logs:•	

lo​g​1.	 c​(ab) = lo​g​c​(a) + lo​g​c​(b)

lo​g​2.	 c​(​ 
a
 __ b ​) = lo​g​c​(a) − lo​g​c​(b)

lo​g​3.	 c​(aⁿ) = nlo​g​c​(a)

Required Pre-Knowledge	

It may help if students have been introduced to the concept of a loga-•	
rithm, and understand the following definition:

​a​b​ = c ⇔ lo​g​a​(c) = b

However, this demonstration could serve as an introduction to the concept of 
logs, and work on definitions and bases could follow.

Pre-activity Set-up	

Ensure you have access to the Autograph File named “Laws of Logs”.

Ensure the following table is displayed prominently at the front of the class-
room:

x log(x) x log(x)

1 0 11

2 0.30102… 12

3 13

4 14

5 15

6 16

7 17

8 18

9 19

10 20

Step-by-Step Instructions	

Activity 1: Introducing the Concept

	 Teacher:	 Today we are going to look at a new function on your calculator – the log func-
tion. To start off with, can you make a quick copy of the following table, use 
you calculator to confirm you agree with the first two values, and then fill in the 
rest!

	 Prompt:	 Again, the usual problem of students having several different models of calcu-
lators could become apparent here, so just be on hand to steer students in the 
right direction.

	Ideal Response:	
x log(x) x log(x)

1 0 11 1.04139…

2 0.30102… 12 1.07918…

3 0.47712… 13 1.11394…

4 0.60205… 14 1.14612…

5 0.69897… 15 1.17609…

6 0.77815… 16 1.20411…

7 0.84509… 17 1.23044…

8 0.90308… 18 1.25527…

9 0.95424… 19 1.27875…

10 1 20 1.30102…

	 Teacher:	 Excellent. Now, what I want you to imagine is a number line, stretching be-
tween 0 and 1.5, with all the values from log(1) to log(20) marked on it. If we 
were to mark each of the values in our table on the number line, what would 
the marks look like?

	 Prompt:	 Look carefully at the numbers in the table. Look at the gaps between them. 
Would the marks be evenly spaced? Would they all be clumped together at one 
end?

	Ideal Response:	 The interval between each value is decreasing, so the gaps between each mark 
would get smaller and smaller, meaning the marks would be clustered together 
at the right hand side of the number line.

	 Teacher:	 Good. Now, it just so happens that I have such a number line here…

Open up the Autograph file named “Law of Logs”.

Your screen should look like this:

T15 Laws of Logs: A Graphical Approach T15 Laws of Logs: A Graphical Approach



218 219

Give the students a few moments to relate the values in the table to the number 
line before moving on.

Activity 2: log(a) + log(b)

	 Teacher:	 Now, you will see that on this number line I have also marked on the values of 
log(a) and log(b), with the values of a and b set to 1 and 2 respectively, as shown 
in the textbox. Now, the question is, where do you think the line of log(a) + 
log(b) would go?

	 Prompt:	 It might be an idea to not give too much away at this stage, as the element of 
surprise is quite powerful!

Expected Response: log(3)

	 Teacher:	 Well, that sounds logical enough. Let’s just check…

Ensure Slow Plot mode is turned off.

Enter the equation: x = log(a) + log(b)
Note: The brackets are not necessary, and can be excluded if you like.
Still on the Enter Equation screen, click on Draw Options, change the colour 
to green, and the line thickness to 3 pts.
Note: A dotted line can also look quite nice, but that is entirely up to you!
Click OK twice.

Your screen should look something like this:

	 Teacher:	 Well, what on earth has happened there? How can log(1) + log(2) = log(2)?

	 Prompt:	 For any two numbers, p and q, if p + q = q, what must be true about p? Have a 
look at the values in your table to see if they help?

	Ideal Response:	 log(1) = 0.

	 Teacher:	 That makes sense. Zeros are always causing us trouble in mathematics. Let’s try 
another one. Say I change the value of a to 3. What do you think log(3) + log(2) 
would equal?

Expected Response: log(5)

	 Teacher:	 Sounds good, but we had better just check…

Click on the Constant Controller.
The drop-down menu allows you to select each constant.
The up-down buttons adjust the value of the constant.
The left-right buttons adjust the value of the step.

Move the Constant Controller to a convenient position on the page.

Select constant a.

Change the value of the step to 1.

Use the right button to increase the value to of a to 3.

The line representing log(a) + log(b) should move at the same time.

Your screen should look something like this:
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	 Teacher:	 Okay, again something funny is going on. It looks like log(3) + log(2) = log(6)! 
How can that be? Is that supported by our table of values?

	Ideal Response:	 According to the table, log(3) = 0.47712, log(2) = 0.30102, and log(6) = 0.77815, 
so yes it seems to be the case that log(3) + log(2) = log(6).

	 Teacher:	 Okay, let’s see if we can get to the bottom of this. Use your table to predict what 
answer we will get to: log(3) + log(5).

	 Prompt:	 Add the two values in the tables together and see if it matches any other value.

	Ideal Response:	 According to the table, log(3) + log(5) = log(15).

	 Teacher:	 Let’s check that:

Select constant b.
Change the value of the step to 1.
Use the right button to increase the value to of b to 5.

Your screen should look like this:

	 Teacher:	 Okay, so what is going on here? What is the rule for adding two logarithms 
together?

	 Prompt:	 Can you express it in words? Can you generalise? log(a) + log(b) = ?

	Ideal Response:	 When adding logarithms, you must multiply the two numbers together. So, 
log(a) + log(b) = log(ab).

	 Teacher:	 Sounds good. Let’s check that with a few examples.

Encourage the students to make predictions and then use the values in the ta-
ble, and finally the Constant Controller, to check their answers. Ask questions 
like:

“What is log(4) + log(5)?”

“The sum of which two logarithms would give us log(7.5)… are there any other 
logarithms that would give us this answer?”

When you are ready…

Activity 3: log(a) - log(b)

Click on Manage List.

Click on x = log(a) + log(b) and delete it using the cross in the corner.

Click OK.

Your should now once again be left with just the lines representing log(a) and 
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log(b).

	 Teacher:	 Now, the question that follows on naturally from this, is what happens when 
we subtract logarithms? For example, what do you think we would get if we did 
log(8) – log(2)?

	 Prompt:	 What would make sense following what we have just done? Use your table of 
values to help you.

	Ideal Response:	 Well, when adding logarithms, we had to multiply, so it would make sense that 
if we were subtracting logarithms, we would have to divide. This is supported 
by the numbers in our table. So, I predict that log(8) – log(2) = log(4).

	 Teacher:	 Sounds good, but let’s check…

Set the value of a to 8, and the value of b to 2.

Enter the equation: x = log(a) – log(b)
Still on the Enter Equation screen, click on Draw Options, change the colour 
to purple, and the line thickness to 3 pts.
Click OK twice.

Your screen should look something like this:

	 Teacher:	 So what is the rule for subtracting two logarithms? Can you generalise this?

	Ideal Response:	 When subtracting logarithms, you must divide the two numbers together. So, 
log(a) – log(b) = log(a/b).

	 Teacher:	 Sounds good. Let’s check that with a few examples.

Again, encourage the students to make predictions and then use the values in 
the table, and finally the constant controller, to check their answers. Ask ques-
tions like:

“What is log(20) – log(5)”

“When two logarithms are subtracted, the answer is log(1.5). Give me three 
subtractions that could have given us this answer”

When you are ready…

Activity 4: nlog(a)

Click on Manage List.

Click on x = log(a) − log(b) and delete it using the cross in the corner.
Click on x = log(b) and delete it using the cross in the corner.
Click OK.

You should now be left with just the line representing log(a).

Set the value of a to 2.

	 Teacher:	 Okay, now there is just one more thing we need to look at, and it’s all to do with 
the functions in the from nlog(a). What value of n would mean that our line 
stays in the same place?

	Ideal Response:	 n = 1

Click on Manage List.

Double-click on x = log(a) so the Edit Equation box comes up.

Enter the equation x = nlog(a).
Click on Edit Constants and just make sure the value of n is set to 1.
Click OK twice.

Your screen should look something like this:
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	 Teacher:	 Now, the question is: what is going to happen when we increase the value of 
n? Where do you predict the line will go when we increase n to 2, giving us 2 
log(2)?

Expected Response: log(4)

	 Teacher:	 Well, that sounds logical enough. Let’s just check…

Select constant n.
Change the value of the step to 1.
Use the right button to increase the value to of n to 2.

Your screen should look something like this:

	 Teacher:	 Finally, something that seems to go as expected. So, if we increase n to 3, giving 
us 3log(2), what do you predict we would get?

Expected Response: log(6)

	 Teacher:	 Let’s check…

Use the right button to increase the value to of n to 3.

Your screen should look something like this:
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	 Teacher:	 Okay, again something funny is going on again! It looks like 3log(2) = log(8)! 
How can that be? Is that supported by our table of values?

	Ideal Response:	 According to the table, log(2) = 0.30102, so 3 × log(2) = 0.90308, which is equal 
to log(8).

	 Teacher:	 Okay, let’s see if we can get to the bottom of this. Use your table to predict what 
answer we will get to: 4log(2)

	 Prompt:	 Work out what 4 × log(2) is and see if it matches any of the values in your table. 

	Ideal Response:	 According to the table, 4log(2) = log(16).

	 Teacher:	 Let’s check that:

Use the right button to increase the value to of b to 4.

Your screen should look something like this:

	 Teacher:	 Okay, so what is going on here? What is the rule for multiplying a logarithm by 
a constant? 

	 Prompt:	 Can you express it in words? Can you generalise? nlog(a) = ?

	Ideal Response:	 When multiplying a logarithm by a constant, you get the same answer as if you 
took the original logarithm and raised the number to the power of that con-
stant. So, nlog(a) = log(aⁿ).

	 Teacher:	 Sounds good. Let’s check that with a few examples.

Encourage the students to make predictions and use the Constant Controller 
to check. Ask questions like:

“What is 2log(3)?”

“How about 0.5log(16)?”

“What about −2log (4)?”

“−0.5log(9)?”

Ideas for Further Work	

If it has not been covered already, students could be taught about the •	
bases of logarithms, and introduced to the definition: ​a​b​ = c ⇔ lo​g​a​(c) = b.

Using the laws of logs to combine and simplify expressions involving logs.•	

The relationship between exponentials and logarithms.•	
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Graphs of log functions.•	

The natural log function – see •	 Teacher Demonstration 14: The Natural 
Log Function.

T15 Laws of Logs: A Graphical Approach
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